Copyright © 1995-2004 Euro Plus d.o.o.
All rights reserved.

This software is based in part on the work of the Independent JPEG Group.
## Contents

1. Introduction  
   1.1 About NiceLabel ...................................................... 1-1  
   1.2 About this manual .................................................. 1-2  
       1.2.1 Conventions used in this Manual ..................... 1-3  

2. Overview  
   2.1 Start 2-1  
       2.1.1 Working Environment ..................................... 2-2  
   2.2 Label Parameters .................................................. 2-3  
   2.3 Working Environment .......................................... 2-9  
   2.4 Test Label ............................................................ 2-10  
       2.4.1 Text ............................................................... 2-12  
       2.4.2 Graphic ........................................................... 2-14  
       2.4.3 Barcode .......................................................... 2-15  
       2.4.4 Box ................................................................. 2-17  
       2.4.5 Line ............................................................... 2-18  
       2.4.6 Save the Label ................................................ 2-19  
       2.4.7 Print preview ................................................... 2-20  
       2.4.8 Print ............................................................... 2-21  
       2.4.9 Zoom ............................................................... 2-22  
       2.4.10 Undo ............................................................. 2-22  

3. Reference  
   3.1 Main Window ........................................................ 3-1  
   3.2 Login ................................................................. 3-1  
   3.3 Shortcuts ............................................................. 3-2  
   3.4 File 3-4  
       3.4.1 New Label ...................................................... 3-5  
       3.4.2 Open .............................................................. 3-5  
       3.4.3 Close ............................................................. 3-6  
       3.4.4 Save .............................................................. 3-6  
       3.4.5 Save as .......................................................... 3-6  
       3.4.6 Import label design ......................................... 3-7  
       3.4.7 Import ............................................................ 3-7  
       3.4.8 Batch Import .................................................. 3-8
3.6.11 Database tool .......................................................... 3-54
3.6.12 Label Inspector tool ............................................... 3-55
3.6.13 Margins ............................................................... 3-56
3.6.14 Object properties ................................................ 3-57

3.7 Object.............................................................................. 3-57
3.7.1 Select ...................................................................... 3-58
3.7.2 Text ........................................................................ 3-59
3.7.3 Paragraph ............................................................... 3-65
3.7.4 RTF (Rich Text Format) ........................................... 3-67
3.7.5 Bar code ................................................................. 3-69
3.7.6 Edit barcode dialog box ......................................... 3-74
3.7.7 EAN.UCC 128 Wizard .......................................... 3-81
3.7.8 Graphics ................................................................. 3-87
3.7.9 Rectangle ................................................................ 3-92
3.7.10 Line ....................................................................... 3-95
3.7.11 Ellipse .................................................................... 3-97
3.7.12 Inverse .................................................................... 3-99

3.8 Data 3-100
3.8.1 Dynamic data overview ........................................... 3-100
3.8.2 Contents Providers ................................................ 3-102
3.8.3 Variables .............................................................. 3-107
3.8.4 Variable wizard .................................................... 3-120
3.8.5 Functions .............................................................. 3-128
3.8.6 Database Access .................................................. 3-145
3.8.7 Database wizard ................................................... 3-147
3.8.8 Text File Wizard .................................................. 3-151
3.8.9 Database access dialog box ..................................... 3-155
3.8.10 Database dialog box ........................................... 3-165
3.8.11 Check digit algorithms ......................................... 3-168
3.8.12 RF Tag ................................................................. 3-170
3.8.13 Variable Trace Setup ........................................... 3-173
3.8.14 Unlock global variables ....................................... 3-174
3.8.15 Lookup Tables ..................................................... 3-174

3.9 Transformations ............................................................ 3-175
3.9.1 Rotate ..................................................................... 3-175
3.9.2 Align ....................................................................... 3-176
3.9.3 Embed all pictures into label ................................... 3-176
3.9.4 One to front ......................................................... 3-177
3.9.5 One to back .......................................................... 3-177
3.9.6 To front ................................................................. 3-177
3.9.7 To back ................................................................... 3-177

3.10 Options.......................................................................... 3-177
3.10.1 Snap to grid.......................................................... 3-177
Contents

3.10.2 Grid visible ........................................................... 3-178
3.10.3 Preferences ........................................................... 3-178
3.10.4 Language .............................................................. 3-181
3.11 Tools ............................................................................. 3-181
  3.11.1 Configure log file ................................................. 3-182
  3.11.2 View Log file ....................................................... 3-183
  3.11.3 Configure Users ................................................... 3-185
  3.11.4 Design form .......................................................... 3-188
  3.11.5 Edit Memory Card ............................................... 3-189
  3.11.6 Nice Applications ................................................. 3-189
3.12 Window ......................................................................... 3-190
  3.12.1 Cascade ............................................................... 3-190
  3.12.2 Title ................................................................. 3-190
  3.12.3 Arrange Icons ....................................................... 3-190
  3.12.4 Close All .............................................................. 3-190
3.13 Help 3-190
  3.13.1 Contents ............................................................... 3-190
  3.13.2 Using help ............................................................ 3-190
  3.13.3 Internet support .................................................... 3-190
  3.13.4 NiceLabel on the web .......................................... 3-192
  3.13.5 Register ............................................................. 3-192
  3.13.6 About ................................................................ 3-192

4. Miscellaneous 4-193
  4.1 Label Inspector ............................................................ 4-193
  4.2 Command line options .................................................. 4-195
  4.3 Demo limitations .......................................................... 4-196
  4.4 Expression Builder ........................................................ 4-197
  4.5 Multicolor printing ........................................................ 4-198
  4.6 Double-side Printing ..................................................... 4-199
  4.7 Special Characters ...................................................... 4-200
  4.7.1 Pre-defined character shortcuts ................................ 4-200
  4.7.2 Entering characters with Alt+<ASCII_code> ......... 4-202
  4.7.3 Entering characters with <#hex_code> syntax ....... 4-202
  4.8 System Folder ............................................................... 4-203
  4.9 Global variable .............................................................. 4-203
  4.10 Font files .................................................................... 4-204
  4.11 ClipArt Galleries ........................................................... 4-206
  4.12 NiceAdministrator ........................................................ 4-206

5. Integration and Connectivity 5-209
  5.1 Overview .................................................................... 5-209
  5.2 DDE Communication ................................................... 5-209
5.3 NiceCommands ............................................................. 5-210
5.3.1 LABEL ................................................................. 5-210
5.3.2 LABELCLOSE .................................................... 5-211
5.3.3 SET ...................................................................... 5-211
5.3.4 SETPRINTPARAM ............................................. 5-211
5.3.5 COMMENT ......................................................... 5-212
5.3.6 PRINT ............................................................... 5-212
5.3.7 PORT ................................................................. 5-213
5.3.8 PRINTER ............................................................. 5-213
5.3.9 PRINTJOBNAME ............................................... 5-214
5.3.10 LOGIN ................................................................. 5-214
5.3.11 RETURN ............................................................. 5-214
5.3.12 QUIT ................................................................. 5-215
5.3.13 MESSAGEBOX .................................................. 5-215
5.3.14 CREATEFILE ..................................................... 5-215
5.3.15 DELETEFILE ...................................................... 5-215
5.3.16 SESSIONSTART .................................................. 5-216
5.3.17 SESSIONPRINT .................................................. 5-216
5.3.18 SESSIONEND ..................................................... 5-216
5.3.19 OEMTOANSI ...................................................... 5-216
5.3.20 SETDATABASE ................................................. 5-217
5.3.21 SETTABLE ......................................................... 5-217
5.4 Automatic Print ............................................................. 5-218
5.5 Programming interface: Automation (ActiveX) ........... 5-218
5.6 Programming samples .................................................. 5-219
5.7 Label Export ................................................................. 5-220
5.8 Integration to SAP/R3 .................................................. 5-221

6. How to… 6-1
6.1 Optimize the printing speed .............................................. 6-1
6.2 Use the keyboard and mouse effectively .......................... 6-2
6.3 Create a serial number, counter ..................................... 6-3
6.4 Use printer internal increment counter .............................. 6-4
6.5 Create a prompted variable ........................................... 6-5
6.6 Read data from database ............................................... 6-6
6.7 Use ODBC databases ................................................... 6-6
6.8 Use Variable Quantity .................................................. 6-7
6.9 Make a counter which preserves last-used value ............. 6-8
6.10 Use Text toolbar ....................................................... 6-8
6.11 Use Variable toolbar .................................................. 6-9
6.12 Quickly align objects to each other ............................... 6-10
6.13 Use variable graphics .................................................. 6-11
6.14 Quickly edit database ................................................ 6-11

NiceLabel Pro User's Manual
6.15 Use custom edit forms ....................................................6-11
6.16 Automate label production.............................................6-12
6.17 Use printer memory card ...............................................6-12
6.18 Change the order of entering prompted variables ........6-16

8. NiceLabel Product Range ...............................................8-1

8.1 NiceLabel Overview .....................................................8-1
8.2 NiceLabel Suite ...........................................................8-2
8.3 NiceLabel Pro .............................................................8-2
8.4 NiceLabel Express .......................................................8-2
8.5 NiceLabel Print Only ....................................................8-3
8.6 NiceLabel Engine .......................................................8-3
8.7 NiceLabel Pocket PC Designer ......................................8-4
8.8 Pocket NiceLabel .......................................................8-4
  8.8.1 Synchronization Manager ......................................8-5
8.9 NiceLabel for Linux ....................................................8-5
Chapter 1: Introduction

1. Introduction

1.1 About NiceLabel

NiceLabel is a software package written for Microsoft Windows operating system, which lets you create and print labels and fully supports WYSIWYG (What You See Is What You Get). Using NiceLabel, you can easily design any label to include bar codes, text, lines, boxes and graphics.

You can also use your existing databases to automatically print labels, with content based on data. (Text or graphics)

The OLE 2.0 function allows you to use other Windows applications to create different objects on your labels (i.e. Word for Windows for text objects or Corel Draw for graphics).

DDE (Dynamic Data Exchange) lets other application control NiceLabel. You can write your own front-end applications in any of the program languages (Borland Delphi, Microsoft Visual Basic...), which takes care of the data preparation or processing and then sends the commands for printing to NiceLabel.

From version 2.0, NiceLabel is also an OLE Automation server. This further enhances the possibility of label production from other applications.

When creating labels, standard available label stock sizes are pre-defined and already available for usage. But you can also define your stock formats and save them for a later use.
Chapter 1: Introduction

The label design method is very user-friendly and flexible. Multiple label elements are available so you can truly design the label layout the way you want it. Usage of phantom objects allows you to simulate a pre-printed label that already contains lines, logotypes etc. These objects will not be printed but will help you to align other label elements to pre-printed design.

Data can be entered in the process of designing the label or later, using variable data from various sources (keyboard, file, database) and incorporate the data into the labels.

Before starting the production of the labels, you can preview them on the monitor. This functionality helps you to verify the correctness of the variable data and saves time and the label material. When you are satisfied with the result on the screen, go ahead and print the labels for real.

NiceLabel software supports all Windows printers that have provided a Windows printer driver, including color printers (HP LJ, HP DeskJet, Epson Stylus, Epson Stylus Color...). However, the best printing results in NiceLabel software are achieved when printing to thermal transfer printers using specially developed NiceDrivers.

NiceDrivers are available for all major thermal transfer printer families and they really boost printing performance to the maximum.

1.2 About this manual

The User's Manual contains following sections:

**Introduction**: This chapter will lead you through the process of designing the sample label and printing it.

**Reference**: This chapter describes details and explains all the commands used in the labeling software. You should refer to this chapter regularly while designing labels, until you have completely familiarized yourself with the commands. By using the information contained in this chapter, you will be very quickly able to use labeling software efficiently.
**Miscellaneous:** Additional useful information about features and advanced setting is described in this chapter.

**Integration and Connectivity:** This chapter describes how labeling software can be used for seamless integration of label printing to your custom applications and which connectivity methods are available for including labelling to information systems without any modifications to existing applications.

**How to...** Few most commonly used actions are described in this section of the manual in details. By reading this section you will be able to produce very complex labels in a matter of minutes.

**NiceLabel Product Range.** There is more to NiceLabel than just NiceLabel Pro. Meet the whole range of NiceLabel products, from Express to Suite, from Windows to Linux platform.

### 1.2.1 Conventions used in this Manual

Text that appears in bold letters refers to the names of the menus, buttons and other 'clickable' elements like **OK** button.

Text that appears in italic refers to the options and confirming actions - like *Read only*.

Text enclosed in brackets refers to keys from the PC keyboard like <Enter>.

Variables are enclosed in square brackets like [variable].
2. Overview

2.1 Start

Following the examples in this chapter, you will learn how to design and print labels in the most efficient way, using the intuitive tools in the program.

By the end of this chapter, you will be able to create and print fairly complex labels on your own.

If you need more detailed information, refer to chapter Reference, following this tutorial.

Start the labeling software by double clicking the program icon on the desktop. First the splash screen will be displayed, showing the application name and version number, then window with working area will appear:

![Working window](image)
2.1.1 Working Environment

The header line on the screen shows the version of labeling software you are using and the file name of the opened label.

The second line - menu bar - shows the command options available when designing and printing labels.

Below this line there are icons to help you speed-up designing and printing labels:

- Design new label.
- Open existing label.
- Save the label.
- Cut the selected object(s).
- Copy the selected object(s).
- Paste the selected object(s).
- Undo the last command.
- Redo the last command.
- Printer settings.
- Print the label.
- Simulate printing the label on the screen. (Print Preview)
- Zoom to page.
- Zoom to label.
- Zoom to elements.
- Set the margins on-screen.
- Switch between two pages of label.
- Selects Normal view of variable elements.
- Selects Data view of variable elements.
- Show variable names.
- Move the object to the top.
- Move the object to the back.
- Move the object to front for one degree.
Chapter 2: Overview

- Move the object to back for one degree.
- Toolbox.
- Text tool.
- Variable tool.
- Color palette.
- Align tool.
- Database tool.
- Label Inspector.
- Help.

When designing a label, the borders of the working area are bounded with ruler bars at the left and upper side and with scroll bars at the right and bottom of the working area. At the very bottom of the screen the status bar shows the position of the cursor and the name of the selected printer.

In the upper left corner of the working area, is the Toolbox with the icons representing the main tools. When you select the Toolbox by clicking it and holding down the mouse button, you can drag the Toolbox around and move it to any position within the Application Workspace.

You can switch the Toolbox on and off by selecting the View menu from the menu bar and clicking Toolbox option.

To speed-up designing labels use the right mouse button. Clicking the empty space on the label in the workspace opens the menu with options that are most commonly used. For example, you can change zoom factor, select or deselect elements, set-up label parameters, etc. Right-clicking the elements will display different context-sensitive drop-down menu.

### 2.2 Label Parameters

Select **New label** under **File**, or click the icon ⌃.
Working environment for the new label will appear.

The dimensions of the label are set as default values. Every time a new label is created, it is set up with default printer. Information about the paper size is read from Control Panel's settings. Usually the dimensions, and other label parameters, such as label title, description, author and type of the printer are not set correctly for your specific label. That is why by default a special Label Setup Wizard appears and allows you to set these parameters. This Wizard can of course be disabled if you would like to set label parameters manually.

In Label Setup Wizard you first have to select the printer, on which you want to print labels. Select the printer from the list of installed printers on your system. If your printer is not available in the list, you will have to install it first. NiceDrivers for thermal-transfer printers are available on your CD-ROM in folder Drivers, start the program PRNINST.EXE to start the Printer Installation Wizard. You can also set the printer advanced settings by clicking the **Printer Setup** button.
Click **Next**, when you have selected the correct printer and advance to the next step of the Label Setup Wizard. Please note, you can leave the Wizard at any time and accept the default settings for the printer by clicking the **Finish** button.
Here you can select what kind of standard label format do you want to use. You can select labels from many different label manufacturers like Avery and Zweckform. This is usually applicable to laser and inkjet printers only. Select one stock by clicking the **Select label stock** button, or click **Next** to advance to the next step.

![Label Setup Wizard - Selecting the paper size](image)

If you have selected sheets of paper above (or your printer doesn't support rolls), then have to select the paper size of your label. Click **Next** to go to the last page of the Wizard.

Here you can enter (or modify) the actual label and page dimensions.
Before entering the label data, you must be aware of differences between "label" and "page". The page and its dimensions are the physical size of the paper. The label is the part of the page. The page can have one or more labels. The labels are arranged on the page in columns and rows. On thermal printers the label size is usually the same as page size.

Note, that this dialog is different for thermal-transfer and office printers.

**Label width and height** represent the dimensions of one label.

**Horizontal offset** defines the distance of the left edge of the label in the first column from the left edge of the page (it would be "0", when both edges are in the same position).

**Vertical offset** defines the distance of the bottom edge of the labels in the last row from the bottom edge of the page. This dimension will be "0", when edges are die-cut.

**Vertical gap** represents the vertical distance between two columns of labels.
**Horizontal gap** represents the distance between each row of the labels.

**Labels across**, horizontal and vertical, represent the number of rows and columns of labels on the page.

Entering the right values for the dimensions of the label, you can define virtually any shape of the label.

Note, if you selected rolls of labels, vertical offset and number of labels are omitted.

When you have entered all label parameters, click **Finish** button and they will be updated to reflect the desired label format. The working window in labeling software will always show the true presentation of labels as they will be printed.

![Example of multiple labels per page](image)

All label parameters can also be set in the working area. By clicking the icon, the screen is set to a label dimensions mode, where all the dimensions and the shape of the label (horizontal and vertical radius) can be set in the working area. In this mode you can setup the dimensions with your mouse by moving the lines. The black line changes the size of the label and the blue line changes the distance between the labels.
At the left side of the screen all label parameters are displayed, letting you know the changes in real time as you drag the handles.

Once you are satisfied with the settings of the label, click the icon once again to return to the label-designing mode.

### 2.3 Working Environment

Now you have entered the working environment. You have a lot of possibilities to set up the environment to your own taste. In **Option-Preferences** menu you can change user-related settings. Among others you can:

- select your own set of colors for the background, label, media, ...
- set grid size and other grid options
- set default measurement units
- set default directories for labels, graphics, …
Chapter 2: Overview

The grid is the resource, which helps you place objects on the label much easily if more technical design is required. You can set the size and offset of the grid, make the Grid visible or hidden and select the Snap to grid.

The button Default unit helps you to select the measurement unit for designing.

Under Colors, clicking the Select button and selecting the appropriate color you can set different colors.

Under Directories you can set the default folder for labels, graphics, variables, databases, stocks and import files where software will first look for desired files.

Use the button Browse for searching thru folders.

### 2.4 Test Label

The following sections will show you how to design and print the test label below. It will contain text, bar code, picture, box, and line objects.
First, you will have to define the dimensions and the shape of the label. Go to the **Label Setup** under the **File** menu, select Dimensions and enter the values as follows or use the Label setup Wizard to set the same label dimensions.

![Label setup dialog box](image)

When designing multiple labels on the page, only one label is active. What this means is, that all objects have to be placed on this active label during design time, but in
the process of printing the software takes care that all labels across the page are printed in the same layout as the active one.

2.4.1 Text

First you will add text to the label. It will be a simple static non-changeable fixed text. The program can also work with variable text, which uses variables, functions and databases.

Click the button in the Toolbox. Text cursor will appear on the screen. Move the cursor across the screen to locate the position for the text on the label. Click the mouse button there and you will be able to enter the text directly on-screen.

There are two modes of operation, which can be set by setting program preferences. The first (default) is On screen edit. This means, you can enter text directly on the label, similar to a word processor program. When you have typed the contents, you can cancel typing by pressing <Esc> key, or confirm it by pressing <Ctrl>+<Enter>.

The second mode works without on screen edit. It immediately opens the dialog box for the text, where you can enter the contents and set all other properties of the text. This dialog box can be opened any time by double clicking the text.
Under **Contents** enter the text ('Sample').

If you want to change the font used with the text element, go to **Style** tab and click **Select**. You will be able to select any installed font on the system and also define size and style.

Once you are satisfied with the settings, confirm the selection by clicking the **OK** button.
The position and the size of the text object can also be easily changed on the screen. Select the object and drag it anywhere around the label to position it accurately. The text can be stretched to required size by dragging handles. The screen will show the following.

First step of creating the test label – Inserting text

2.4.2 Graphic

The picture file you will use to put the graphics on the label is stored in the graphics directory. The labeling software can work with BMP, PCX, GIF, WMF, JPEG and other graphic formats.

To place the picture, click the button in the Toolbox, move the cursor to the desired position on the label, and click the mouse button.
In the Open dialog box you select the file name of the desired picture and click OK. The original size of the graphics is very small.

The drag handles allow you to increase or decrease the size of the element by clicking the element and dragging it to the required size.

Holding down the mouse button will allow you to drag the element around the label area, and to place it accurately.

The screen will now look like this:

**2.4.3 Barcode**

Now you will add an EAN-13 bar code to the label. Select the icon from the Toolbox and move the cursor
to the required position on your label, and press the mouse button.

The **Barcode** dialog box will appear on the screen.

Go to **Barcode** tab and click the **Define** button. From the list of available barcodes select EAN-13, then set some additional parameters of the bar code:

- Type of the bar code
- Height of the bar code
- Expansion factor
- Narrow-to-wide bar ratio

After you have entered the parameters as shown in the screenshot, confirm them by clicking the **OK** button.

In the Contents window enter the characters which will be encoded in the barcode, i.e. 383498489498. The EAN-13 barcode requires 13 numeric digits, but we have entered only twelve. The last one -check digit- will be automatically calculated and added to the barcode.
Chapter 2: Overview

Bar code dialog box – General tab

Click **OK** to return to the label editing.

Note that you can easily change the position and the dimension of the bar code by dragging the handles and moving the object across the label.

The screen should look like this:

![Test label after inserting the bar code](image)

### 2.4.4 Box

Now create a box around the graphics. Click the [ ] icon in the **Toolbox** and position the left upper corner of the
box. Click and hold the mouse button while you stretch the box to the required size.

Should you want to change the thickness of the vertical and horizontal line, double-click the box object to enter the **Rectangle** dialog box.

![Rectangle dialog box](image)

### 2.4.5 Line

Now add a line to the label.

Select the icon from **Toolbox** or **Line** command in **Object** menu and move the cursor to the required starting point of the line. Press and hold down the mouse button while moving the cursor to the point for the end of line, then release the mouse button.

If you want to edit line object, double-click the line to open the **Line** dialog box.

The test label should look like this:
2.4.6 Save the Label

Selecting the save shortcut or Save command in the File menu saves the label to the hard disk. When you want to save the label for the first time, the program will ask you for a name of the label. You do not have to supply the .LBL extension, the software will add it itself.

In the Save As dialog box, enter the name of the new label.

Labels can also be copied to a new label name by selecting the Save as command.

The next time you start the labeling software you can load a label by selecting Open from the File menu. In the File Open dialog box, point to the desired label file name, and then click OK. There is also an easier way. Most recently used labels are always placed at the end of
the **File** menu. Just select one from the menu and it will be immediately opened.

Do not forget to save the label regularly during the design process. Also save the label after you have finished with your work! If you will forget to do so, the program will remind you that the label still has to be saved.

### 2.4.7 Print preview

You will simulate production of 10 labels on the screen to check the definition of variables and correct label layout.

After you have selected **Print preview** from the **File** menu or pressing icon on the **Toolbox**, the **Preview print** dialog box will appear.

![Print preview dialog box](image)

In the dialog box enter '10' for **Quantity** and click the **OK** button. The order will simulate production for 10 labels on the screen.

You can select between the quantity of the labels and the quantity of the page. The page and its dimensions are the physical size of the paper. The label is the part of the page. The page can have one or more labels and labels are arranged on the page in columns and rows.

If you have eight labels on the page, the quantity ten pages will print 80 labels.

There are other options you can use to print the labels, but have little or no meaning with this test label:

- Option **Unlimited quantity** means, that the "unlimited numbers" of labels will be printed.
Usually the greatest number of copies that printer is capable of will be printed, but with some printers label printing could go on endlessly and you will have to interrupt the process manually. This option is generally applicable when using databases, this way the all records from the database will be printed.

- **Variable**: This option is used when some field in the database specifies the label quantity. It will set the number of equal labels to be printed.

### 2.4.8 Print

Now you will print the label to check the progress of your label design. Under **File** menu, select the **Print** command and the **Print** dialog box will appear. It is very similar to the **Preview** dialog box.

![Print dialog box](image)

Enter '15' for the **Quantity** and click **OK**. Your printer will now print 15 labels.

Note, if the printer does not print, you should check the settings of the printer and its connectivity to the computer.
2.4.9 Zoom

The labeling software has many features that make it easier to create and view the label.

One of them is zoom, which helps you to enlarge the label view and position the objects more precise.

To enlarge the label, select View from the menu bar and click Zoom In or click <+>.

When you want to shrink the label, select VIEW menu again and click Zoom Out or click <->.

For zoom you can use different icons:
- Zoom to page
- Zoom to label
- Zoom to elements
- Zoom in
- Zoom out

Zoom in and zoom out let you specify your own zoom factor. Just drag the selection rectangle around certain area, and that area will be shown on the whole screen. If you just click once the zoom factor will be changed in pre-defined step.

The selected part will then be enlarged.

2.4.10 Undo

If you find out that you are not happy with the last action you have made when designing the label, you can return to the previous stage using Undo command. This can restore up to 20 previously made actions.

You can retrieve the old position on different ways:

- by selecting Edit menu and Undo command
- by pressing the <Alt> and <Backspace> keys at the same time (this way you can go up to 10 steps backward)
- by clicking the icon

If the last action wasn’t correct, use the icon to Redo the last Undo command.
3. Reference

3.1 Main Window

The main window has many parts and functions. You can open the help file, select the Window topic and click specific parts of the image to see the description.

3.2 Login

Login dialog box is shown when you start the main program, if your administrator has enabled login in the settings.
In order to use the labeling software the proper username and password must be entered. Different users can have different privileges for usage of the program (print only, design only, view only or full access). For detailed information about user management please refer to topic chapter Configure Users on page 3-185.

### 3.3 Shortcuts

You can quickly accomplish tasks you perform frequently by using shortcut keys - one or more keys you press on the keyboard to complete a task. Note that this is just a faster and more convenient way of choosing commands. Command itself is executed just as if it was selected from the menu or toolbar.

- **Delete** Deletes selected element.
- **Shift + Delete** Cut.
- **Ctrl + Insert** Copy.
- **Shift + Insert** Paste.
- **Alt + Backspace** Undo.
- + (numeric pad) Zoom In.
- - (numeric pad) Zoom Out.
- **Alt + Shift + Backspace** Redo.
- **Ctrl + T** Rotate 90°.
- **Ctrl + A** Align.
Ctrl + X  Cut.
Ctrl + C  Copy.
Ctrl + V  Paste.
Ctrl + Z  Undo.
Ctrl + Y  Redo.
Ctrl + N  New.
Ctrl + O  Open.
Ctrl + S  Save.
Ctrl + P  Print.
Ctrl + R  Print Preview.
Ctrl + G  Snap to grid.
Alt + F4  Exit.

Ctrl + move object with mouse  Parallel moving of the object by main axes only.
Alt + move object with mouse  Object snaps to grid even if it is off.
Ctrl + move object with cursor keys  Fine tuning the position of the object.
Shift + cursor keys  Fine tuning the dimensions of the object, resize width and height in very small steps.

Click Text icon in ToolBox, then press Ctrl + click on the label  Dialog box for Text pops up.
Click Graphics icon in ToolBox, then press Ctrl + click on the label  Dialog box for Graphics pops up.
Select variable from the list in toolbar, click  Variable Quantity is automatically connected with text object and placed on the label.
Text icon A in ToolBox, then click on the label

Select variable from the list in toolbar, click Graphics icon in ToolBox, then click on the label

Variable Picture is automatically connected with graphics object and placed on the label. This is a great shortcut for using variable graphics, where filenames for pictures are received from database.

Right-clicking the object

Opens pop-up menu with shortcuts to commands. The content of the pop-up menu greatly depends on where you clicked your mouse button and what was selected at that time.

Enter (or F2)

Dialog box with element's properties will open.

F2

On-screen edit is enabled for text elements.

Space + left-click and dragging

Freely move the label within NiceLabel window. If you want to change the view on the label, you do not need to separately scroll the label in up/down and left/right direction, but just grab it and move it to proper position.

3.4 File

After selecting the File menu on the menu bar the following list of commands appears.
3.4.1 New Label

Selecting **New Label** command creates a new label and clears the application work area. Clicking the `>Create New Label` icon has the same effect.

Note that if the **Use Wizard for Label Setup** is checked in the preferences, then a special Label setup wizard is starts automatically, allowing you to specify the label parameters.

The software supports opening multiple documents and they are named with the increasing numbers: Document1, Document2... unless you name them.

3.4.2 Open

The **Open** command opens an existing label. You can also use the `>Open` icon.
The default label directory, which appears in the dialog box, is defined in Options menu with the Preferences command. When you need to open a label file, which has been saved to a different directory or drive, just browse to that directory and find the label.

If Preview option is selected the preview picture of the selected label is shown. Author, title, and description of the label are also shown.

Every label you have designed and saved remembers the printer it was designed for (unless you have selected it should be opened using the default system printer). If such printer is missing from the system, you will be prompted to select some other one. The most appropriate and most compatible existing printer will be automatically selected.

The selected label will be loaded into the work area when you click OK.

3.4.3 Close

This command closes the active document. When you have made changes in the document and have not saved them, the program will prompt you to save the label.

If the document has not been named yet, the software will also prompt you for the name (Save As command will be executed).

3.4.4 Save

Save command saves the label in the current label file. You can also use the icon. If no file name has been defined when creating a new label, you will be prompted to enter the name (Save As command will be executed).

3.4.5 Save as

Select this command when you want to give a different name to a new label or when you want to copy an existing label.
3.4.6 Import label design

This option allows you to import the label design from some other existing label. When importing the label design only the label elements are used from the old label. Label dimensions are always kept from the existing label.

If there are already some elements on the existing label, you can choose to remove them prior import or you can merge the data on the current label with the data from the imported one.

This command will only work with labels created in this labeling software. If you need to import the labels from other labeling software, refer to the similar command Import.

3.4.7 Import

With the Import command, you can import labels from other labeling software. These import filters are add-ons and can be installed later, after the installation.

Currently supported filters are Segsoft DYNAMIC, Label Wizard, Labellist, and EPC. If you want to import labels from one of these programs, it has to be installed on the same computer as this labeling software is.

When import command is issued, it opens a File Open dialog. The default directory is set in Preferences. Choose the proper label. If import is successful, a new label without name is opened in working area.
3.4.8 Batch Import

This option is similar to the command Import, but it enables you to convert labels from Segsoft DYNAMIC, Label Wizard, LabelList or EPC format to new label format. If you want to import labels from one of these programs, it has to be installed on the same computer as this labeling software is.

Use Batch import with large quantities of old labels that need to be converted to new format. It will enable you to quickly perform the conversion process.

When you select this command a separate Label Converter application will start.

- **Convert Label Type:** Select the source labeling application that was used for old label design. The selection must match your application.
- **Convert labels list:** In this part of the application all labels for converting will be listed. Add labels to the list with the **Add** button, remove them from the list with the **Delete** button.
- **Export directory:** The folder specified here will be used as location for converted labels. It is recommended that this folder differs from the location of original label files. This way you do not lose the original labels.
- **Picture embedding:** Tick this option to let application embed all images into converted labels. Links to images will be lost, and the whole image will be saved inside the label file.

**Convert:** When all options are set, click this button to start the conversion process.

3.4.9 General Export

This command saves the label in a general export format, that you could further process from your application. Before you can execute this command, label must already be saved in a file.

Two files will be generated:
• .LVR file, containing information about variable fields on the label.
• .PNL file, containing the exported label layout with the elements.

They will be saved to the same folder, where the original label file is stored.

3.4.10 Export to Pocket PC

This command saves the label in format that can be read by pocket version of the labeling application on Pocket PCs running Windows CE operating system. Before running this command, label must already be saved to a file. This command then updates the file format and makes it compatible with pocket version.

Two files will be generated:
• .LVR file, containing information about variable fields on the label.
• .PNL file, containing the exported label layout with the elements.

They will be saved to the same folder, where the original label file is stored.

To simplify transferring of the files from PC computer to Pocket PC device, use the provided application Synchronization Manager that will do the job automatically. You do not have to synchronize the files manually yourself.

3.4.11 Export to Linux

This command saves the label in format that can be used by a Linux version of labeling software. Before executing this command, label must already be saved in a file. This command then updates the file format to be compatible with Linux version.

Two files will be generated:
• .LVR file, containing information about variable fields on the label.
• .PNL file, containing the exported label layout with the elements.
They will be saved to the same folder, where the original label file is stored.

### 3.4.12 Export to Form

If your printer supports it, you can download the whole label to the printer and then print that label directly from printer without interaction with the computer. If label contains prompted variables, you can enter the value for variable before printing with printer buttons.

Note that variable elements (text and barcode) must be supported internally by printer - that is why you have to use internal fonts and barcodes. Fixed elements can be of any type.

This command is applicable also when your printer does not support a download of label layouts, but you have a smart keyboard that can do it instead. Labels are downloaded to the keyboard, which is then used to control label printing.

You can select the type of export for some printers. In this case a separate dialog box will open, where you can select the mode of export. Please refer to the printer documentation for more information regarding different modes.

### 3.4.13 Export to SAP

This command saves whole label to a file that is compatible with SAP R3 software - ITF file (Intelligent Text File). This file can then be uploaded to SAP system and labels are printed directly from SAP on demand.

In order to use certain printer for Export to SAP functionality, one mayor condition has to be fulfilled. Printer has to be able to receive non-binary escape codes. All printers are capable of this.

SAP system has a strict data format for SAPscript-ITF text file. So all printer-specific commands (escape codes) have to be sent as non-binary data, that means escape codes cannot include characters below ASCII code 32. Only for printers that allow this have the functionality "Export to SAP" is enabled.
3.4.14 Export to EPS

This command saves the label in EPS (Encapsulated Postscript) graphic format file. EPS format is generally used by designers in graphic studios. Note, that the resulting .EPS file contains graphic representation of variables and barcodes. Label elements (variables, barcodes, boxes...) are converted to vector images. EPS file contains a label layout with fixed values for the variables.

3.4.15 Label Setup

Before you start to design a label, the complete document parameters must be defined. Use the Label Setup command from File menu to define the label parameters, such as label title, label dimensions and printer setup.

You can come back to this dialog box any time and change the label properties.

**General tab**

The fields *Title, Description* and *Author* are optional, but we recommend that you define them. The information entered in these fields appears in dialog boxes (Open, Print), and is useful in identifying the label later.
The **File Creation information** section provides data about the last save command. Program version and Label file version from the last save command are stored. The part with Additional information will provide data about the status of the label you have to be aware of. This section will contain information that some label elements are not recognized and cannot be used. It can happen if you open a label file created in newer version of the software and it includes some elements that are not available in your version. If you will continue to edit the label and then save it, all these newer elements will be discarded and lost. If you do not want this to happen, edit the label in the version of the software that was used to design it.

**Printer tab**

On the **Printer** tab you can choose the printer you want to use for label printing. Each label is designed for a particular printer and it stores printer settings. Whenever you load a label at a later time, the printer settings of the printer will be restored to the ones saved in the label.
In this dialog box you also define the paper format. Roll of labels option is preferred when using thermal transfer printers, sheets of paper options is available when using office printers. The information about supported paper format is acquired from the printer driver.

If the option *Always use default printer* is selected, then printer settings will not be saved into the label file, but instead the default windows printer with its settings will be used, when opening the label.

Detailed printer settings are defined by clicking the Properties button.

*Use custom printer settings saved in label*: Use this option, when you want to be able to modify printer driver settings specifically for this label. Whatever properties you will select in the printer driver, they are saved with the label. The next time this label is opened, all printer settings are automatically restored.

*Use default printer settings from driver*: Use this option, when you do not want to use custom printer settings for this label. Even if you make changes in the properties of
the printer driver, they are discarded as soon as you close the label. When label is opened the next time, the default printer settings from the driver are restored to the label. The default printer settings are changed directly in properties of printer driver (accessible from Control Panel.Printers).

For **Paper format** you can select either **Rolls of labels** or **Sheets of paper**. The first option is used with thermal-transfer printers, the second with office printers. You can choose the current page size for the selected printer (A4, A5...). If the printer supports custom paper size, you can define custom dimensions of the page (width, height). Thermo/transfer printers normally support only custom paper sizes. The actual label dimension are set in the Dimensions tab.

You can choose the current page size for the selected printer (A4, A5...). If the printer supports custom paper size, you can define custom dimensions of the page (width, height). Thermo/transfer printers normally support only custom paper sizes.

Label orientation can be also selected on this tab. Default is Portrait and can be changed to Landscape.

Note that most laser and other non thermo/transfer printers cannot print on entire page. There is usually a nonprinting area of about 5mm from the border of a page. In the application this area is marked by red line. Any object on or beyond the red line will not be printed entirely.

Special care should be taken to pages that have multiple labels on it, because the editing is normally performed only on the top left label on a page, with only top and left red lines visible. When this label is printed as bottom right one, object that are on the bottom right area of a label could fall outside the printable area.

So it is advisable to check the whole page of labels for any objects that are outside the printed area. You can do that by using the **Zoom** command so that entire page is visible.

**Duplex print / Double side printing** option makes it possible to print double-sided labels for office or thermal
printers (if your printer supports it). You can later switch between pages by clicking icon in toolbar. If you later de-select this option, elements form both sides are merged into one label. Double side printing has affect also when using Head/Tail labels.

### Printing tab

![Label Setup dialog box - Printing tab](image)

In **Default Quantity** you can define the quantity for printing that will be base quantity for labels or pages. This quantity will be taken as default quantity before printing - the program will always propose this quantity to you, but it can be changed at print time if you would want that.

In **Processing order** area you can define a direction in which labels are printed. You can set a starting corner where printing starts and the horizontal and vertical direction of label positioning. The picture on the right shows the current setting.

**Optimize identical labels** is used when printing on normal Windows printers, it is not available for thermal/transfer printers. Some printers support
optimized printing of equal pages. If, during printing, the application finds out, that few pages are the same then it sends only one page to the printer and issues a command to print several copies of this one label. If the option is not set, the application will send page by page to the printer. This option speeds up printing a lot. But the printing result might not be optimal with all printers. In such event disable this option.

**Dimensions tab**

Under **Dimensions** you can define all the label and document parameters. The dialog box will look out differently if you use thermal/transfer printer driver on the label or some other printer driver (laser, inkjet, matrix...).

For a new label dimension, the following parameters must be entered in the text boxes:

- **Height** and **width** of the label
- **Horizontal offset** of the label, which is the distance from the left edge of the backing paper to the edge of the face paper - labels.
- **Vertical offset**, which is the distance from the top edge of the backing paper to the top edge of the face paper - labels.
- **Vertical gap** between the rows of labels.
- **Horizontal gap** between the columns of labels.
- **Labels across Horizontal** sets the number of columns of labels on one page.
- **Labels across Vertical** sets the number of rows of labels on one page.
- **Horizontal and vertical radiuses** define the shape of the corners of the label. Using these parameters, elliptical and round labels can be defined.
The dialog box looks differently if you have selected thermal/transfer printer on the label and selected Roll of labels for Paper format in Printer tab.

You can define similar parameters as before, but there are additional options for margins (offsets) on all four sides of the label. If you have troubles positioning elements on the label, use margins to solve the problem.

There is also an option of Multiband printing. When you enable it, the options in the dialog box will change and you will be able to select number of bands to print and the overlapping setting. Multiband printing option allows you to print larger labels than the maximum width supported on your printer. These banners of labels can be then joined together to form one large label.

There are two method to set up the multiband printing. First one can be used, when the whole width of bands is known. You select the Label width (meaning the width of the label with joined bands) and the number of bands. The second method is used, when you know the width of bands. In this case you set the Band Width and number of bands. Label Width will be set automatically.
Overlapping option specifies the amount of space on the label which has the same contents as the previous/next label. Label bands can be then easier joined together.

Dimensions of the label are entered in millimeters "mm", centimeters "cm", inches "inch" or dots "dot" - according to your previous selection. You can change the unit that dimensions are displayed in by clicking the **Unit** button (cm, inch, dot, and mm)

**Stocks tab**

You can create your label file from scratch and define all label parameters manually. The other option is that you inherit all label parameters from stock template file. Labeling software is installed with number of pre-defined stock formats. You can also create your own stocks. Stocks are arranged into Stock Types.

First you have to select the appropriate Stock type and then the desired stock from this library. The general data of this stock and its preview are shown in the bottom part of the dialog box.

If you enable the option **Label linked to stock**, the label is tightly connected to the stock parameters. Options in several tabs of Label Setup dialog box therefore become unavailable. You cannot change them. This option is also the requirement if you want to enable tracking the number of labels on stock. When the number of labels drop below pre-defined value, the application will warn the operator that new labels should be ordered.

The button **Reload Stock** becomes available where you have manually changed some setting in the Label Setup dialog box. Click it to reload the stock information from the stock library.

The button Stock Management opens the Stock Management dialog box that is also available from the File menu.

**Background picture tab**

Every label can have defined a background picture. It is a graphical element on a lowest layer on the label and usually contains the outlook of the pre-printed label. The background picture helps the user to properly position
label elements so they are aligned to the existing elements on the pre-printed label.

The background picture can be also applied to the label stocks. This functionality is helpful when you need to create a label stock of a non-square or non-elliptical label in irregular shape. The background picture can be stored within the label, which makes it transportable to other computers or can be acquired from an external file.

You can create label file more portable by clicking the button **Embed into label**. Link to the original image will be discarded and copy of the image stored within label.

The background picture can be positioned on the center of the label in 1:1 size (**Center**), can be stretched to fill the whole label (**Fit to label**), or can fill the label proportionally, where width/height ratio is kept (**Fit to label proportionally**).

If the imported image overlaps the label edges, you can crop it to fit the label dimensions by enabling the **Clipping** option.
By default the background image is not printed. If you want it to print with the rest of the label data, enable the **Print background picture** option.

The image can be rotated in 90° degrees steps if the original image does not have the proper orientation.

The background picture can be also applied to the label stocks. This functionality is helpful when you need to create a label stock of a non-square or non-elliptical label in irregular shape. The background picture can be stored within the label, which makes it transportable to other computers or can be acquired from an external file.

**Batch printing tab**

This tab is used to define the batch printing options in the software. The term "batch of labels" stands for the series of labels that should be grouped together for some reason (to be later applied together, to separate the labels with the same data from other labels, etc.). A batch is a set of labels printed within the whole print job. Each print job can consist out of one or more batches.

The purpose of batch printing is that you have a possibility to perform some action after the batch and to be able to print header and tail labels with each batch.

You can specify different batch options in **Label Batch Definition** section.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole print job</td>
<td>All labels printed in this job are the same batch.</td>
</tr>
<tr>
<td>Fixed number of labels</td>
<td>Each batch consists out of a fixed number of labels.</td>
</tr>
<tr>
<td>Based on variable value change</td>
<td>When the selected variable changes value it is a signal to start a new batch.</td>
</tr>
<tr>
<td>Based on variable quantity</td>
<td>When the variable that has a variable quantity flag set changes its value, it is a signal to start a new batch.</td>
</tr>
</tbody>
</table>

Each batch definition can have additionally set one **Condition** involving a variable. Only when the selected label batch type is triggered and the supplemental
condition is true, the batch will be enabled. This option gives you more control over the start of a new batch.

**Action on last label in batch:** This option can be used to define the action you want to perform after the last label in batch has been printed. The list of available action is acquired from the printer driver. If the printer driver does not know about possible actions, the list will be empty. The action is most likely to be: cutter command, batch mark, batch separator... If you have defined web of labels (label template with labels next to each other) the applicable action is also eject page. These printer commands can be applied dynamically in the printing process.

Each label can have defined its own header label and tail label. Their purpose is to act as kind of a separator labels between the label batches. You can choose to print only header label, only tail label, or both. When header or tail label is printed, some special action can be performed. These actions are the same as for the last label in the batch. The header and tail labels are not counted in the user specified label quantity.

Header and tail labels are stored in the same .LBL file as the main label and have the same dimensions as main label. The variables from the main label can be shared on the header and tail label. To edit and modify header and tail labels, use the appropriate option in the View menu. To know which label is currently active (header, main or tail) in the software, look for this information in the bottom status line.
Revision History tab

Label revision history is required in pharmaceutical industry due to FDA standard. It allows you to easily track the activity with the labels and their modifications.

Every label created has some extra information stored in the label format file. If revision history is enabled, you have the option to provide the comment information for every time the label is saved. With every revision of the file you can enter your remark that will be useful later, if you will have to track down what was changed with some version of the label.

For every label revision there is information about which user made modifications (these are users defined in the labeling software, not Windows users), the date and time of modification and revision comment as entered by the user.

Revision history can be enabled in the program properties.
Advanced tab

When Label locked option is selected the label can't be changed (edited). This is useful if you want to protect the label from accidental changes. The label can be password protected. Only the user who is familiar with the password can unlock the label and edit it. For all others the label is available only in print-only mode and they cannot make any modifications to it.

If Use form when printing option is selected, then form will be used to enter the variable data on the label before printing. This is useful, if you have to enter a lot of variable text, because the user-friendly interface allows you to do this much faster and error free. The filename for the form must be specified in the edit box below. See Design form command in Tools menu for more information.
Label setup wizard

If the **Use Wizard for Label Setup** is checked in the **preferences**, then a special Label setup wizard is used for setting up the label. It provides a simple step by step procedure for setting up the label. All options are the same as in ordinary label setup command; they are just organized in a logical sequence, for easier understanding.

Note that this wizard also starts automatically, when a new label is created using **New Label** command.
3.4.16 Stock Management

Stock Management is the external application that allows you to manage your stock files. The stock (label template) can hold all information about label dimensions, offsets, background image, and optionally also the information about printer type and its settings. If you use the same label layout over and over again it makes sense to define it as stock. The next time you design the same label, you can apply its properties from the stock and save time. You can refer to stock in the same way as to document templates in MS Word.

When you create a new label, you can just connect it to a prepared stock and the label will automatically obtain all the properties, which are defined in stock.

Stocks can be sorted and distributed among different types. Each Stock Type contains the stocks with some similar parameters. The stocks supplied with NiceLabel software are sorted in individual types by manufacturer. If you will create your own stock types, you can store the stocks into them by some other criteria.

**Stock Type:** Select the type of stock you want to use. Only stocks that are available for the selected stock type will be displayed in the table below. Use this option to limit which stocks are displayed. Click the browse button with three dots to manage Stock Types.
Stock Number: Use this option to quickly locate the stock by its number. The option is usable when a vast number of stocks is displayed in the table. It allows you to select the appropriate stock instantly, all you need to know is its ID stock number. Partial search is supported so you do not need to provide the whole number. As soon as you will confirm the number with Enter key (or click the Find button), the first stock complying to the number is selected in the table.

Import from CSV: The definition of stock files can be imported from the external text CSV file (comma separated values).

Export to CSV: If you need to, you can export the definition of the stock to CSV file. This is a plain ASCII text file with comma separated values. Note, only the stocks that are displayed in the table are exported.

Import from *.STK: If you have stock files (*.STK) used in older versions of labeling software, you can import them into the stock library using this option. STK file was used in previous versions of the software. One STK file stores the information for one label file. If you want such information to be available in Stock Management, you need to import it into the database. Also refer to the topic Import from STK files.

New: Create new stock.

Edit: Edit the properties of the selected stock in the database.

Copy: Copy the properties of the selected stock in the different name.

Delete: Remove the selected stock from the library.

Stock Types

The dialog box lists all Stock Types that are available in the stock library. Some types are pre-defined and are available as soon as you install labeling software. You can also create new types and populate them with the stock entries.

Add: Add new stock type. You are then able to store the stocks into it.
**Rename:** Assign some other name to the selected stock type.

**Delete:** Removes the stock type and all its stock from the library. Use with caution!

**Stock Properties**

Each stock contains different settings that can be applied to the label. The stock parameters can be defined in the tabs of the dialog box.

**General**
Set the general properties for the stock. These include Stock Name, Stock Type and Stock Number, that make stock manipulation easier in Stock Management application.

Properties Title, Description and Author make label manipulation easier. They are later saved in the label file.

The list of Stock Types contains only pre-defined types. To define your own stock type, open Stock Types dialog box from Stock Management main window.

More:
General tab from Label Setup dialog box.

**Printer**
The dialog box has the same functionality as Printer tab from Label Setup dialog box.

**Printing**
The dialog box has the same functionality as Printing tab from Label Setup dialog box.

**Dimensions**
The dialog box has the same functionality as Dimensions tab from Label Setup dialog box.

**Background Picture**
The dialog box has the same functionality as Background Picture tab from Label Setup dialog box.
Quantity on Stock This tab gives you the ability to track consumptions of labels. When label is linked to such stock, the number of labels on stock will be updated with every print process. If you print 5 labels based on this stock, the number of labels in stock will be reduced by 5. The idea is to track the label stock and display a warning to the user when minimum acceptable number has been reached. The user can the re-order labels just in time so they do not run out.

The General, Dimensions and Printer tab are the only that need to be set for the stock. All other are optional.

Import From STK Files

Use this dialog box to import definitions of stocks from STK format (used in previous versions of labeling software) to stock library.

Stock Type: Select the area in the library, where the stocks should be imported to. If the stock type does not exist yet, you can enter its name and it will be created.

Stock folder: Select the location of the folder, where the .STK files are stored. All stocks from the folder will be imported.

3.4.17 Print Setup

Use the Print Setup command to specify which printer will be connected to the label. This printer will be used for printing and label will be optimized for it. There is a shortcut for accessing this dialog box: press and hold down Ctrl key then double click the printer name in a status bar in the bottom of the working window.

This command brings up the standard Windows Print Setup dialog box in which you can select the printer and its options. To do that select button Properties.
For more information about how to set printer properties see Windows help.

### 3.4.18 Printer Settings

Specific printer settings are set here. Shortcut to this dialog is to click the button on the toolbar or to double click the printer name in a status bar in the bottom of the working window.

Note, that all printer settings are saved with the label and are restored every time, the label is opened. Each label will store its own custom printer settings. In case you want to print the label with a different printer, this other printer will have to be setup again to suit your needs. When changing the printer used on the label, every custom settings are lost and have to be re-configured.

When you change the printer on the label or when you create a new label the default printer settings are used. These default settings can be set for each printer in Control Panel (Printers icon).

### 3.4.19 Print Preview

Use **Print Preview** command from **File** menu to simulate the production of the labels on the computer screen. You can also do that by clicking icon.
This allows you to check that all objects are set correctly, without spending time and wasting labels.

First the **Print Preview** dialog box is shown allowing you to select the quantity of labels that you want to print.

If the label has some variables, which have to be defined before printing, the **Variable initialization** dialog box will appear allowing you to define those variables. When the variables are defined, click **OK** and printing will continue. Note that this dialog box appears only if **Easy production** is switched off and there is no barcode with prompted content. Otherwise you enter the data directly on the label. You can set easy production in **Preferences** dialog box on the **Settings** tab.

You can also use a form to enter the variable data before printing. In this case a specified form is displayed instead of **Variable initialization** dialog box.

After the definition of the variables the simulation on the screen will start. At the bottom right-hand side of the screen **Print pause** dialog box will appear.

In this dialog box you can control the printing process. The simulation continues by clicking the **Next** button. The next variable value will appear if needed.

**Delay** causes the labels to be simulated without confirming the next label with the **Next** button. The button **Cancel** will stop the simulation.

**Initialize** button causes all variables to reinitialize. This means that all counters will be reset, all prompted
variables will need to be entered again, database variables start again from the beginning of database etc.

Clicking the **Print** button prints the currently displayed label on printer.

The outlook of graphics on the label depends on the dithering option set in the printer driver. All color images (except WMF and EMF files) are converted to monochrome images and previewed in the same way as they will be printed accordingly to the dithering setting. More accurate print preview is guaranteed this way. If you want to print the images using different dithering, change the dithering setting in the printer driver.

**Production dialog box**

Production (*Print / Preview Print*) dialog box is shown when you want to print the labels. In this dialog, you enter the number of the labels you want to simulate the printing of. Note, the bottom section Printer is visible only if you are printing the labels, not previewing them.

![Production dialog box](image)

Label Quantity can be specified using different methods.

You can choose between the quantity of the **Labels** and quantity of the **Pages**. If you have 8 labels on one page, the quantity of 10 page will print 80 labels. This is usually used with laserjet printers.

Use the **Unlimited quantity** if you don't know the exact quantity of the labels, you need to print. The most reasonable use of **Unlimited quantity** is when your label gets variable values from database and you want to print label using the entire database.
If you want some variable to define the quantity of printing, use the **Variable quantity** option. The value for such variable can be set in Variable initialization dialog box or can be read from a database. This is a great functionality if you want to generate an automatic label printing, where label data along with label quantity is supplied in a database. Before printing can start label has to be set-up to utilize variable quantity functionality.

If you need to set additional parameters prior label printing, click the **Advanced** button to reveal more options below in this dialog box.

**Identical label copies** can be used to set different number of the same labels you want to print. The number set here will be used to multiply the normal label quantity.

You can **Skip** some labels on the page (i.e. from 1 to 7 labels if using 8 labels on the page). This can be useful if your sheet of labels if partly already used and you would like to shift the start position of the first label to fully utilize labels on the sheet.

**Number of label sets:** Printing sets enable possibility to repeat printing process without any need to enter additional information. The specified number of label sets determine how many times the whole printing process should be repeated.

In the **Printer** section of Advanced part printer-specific settings can be adjusted prior printing. In the **Name** field you can select some entirely different printer to which data stream will be sent. Properties of currently active printer on the label will be discarded and default settings of the new printer will be applied. You can also set printer **Speed** and **Darkness** on-the-fly.

**Print to file:** tick this option to divert printer data from the port the printer currently occupies (normally LPT or COM) to some file on the disk. You will be able to specify the file name and location.

**Variable initialization dialog box**

If the label has some variables, which have to be defined before printing, the **Variable initialization** dialog box will appear.
The first input box (Variable) shows variable name. In the input box Current value is the previous value of a variable. Here you can enter desired new value for the variable. In the list at the bottom of the page are listed all the variables which have to be defined. Press <Enter> or click Next to confirm the defined value and move to the next variable.

Click OK when you are finished inserting variable values. If you want to stop printing, click the Finished button. Only the labels with the entered data will be printing. If you click Cancel the printing will be cancelled.

Record selection dialog box

This dialog box is available only if you have a database connected to your label and have set the Record retrieving option in Database access dialog box to Select. The same property is set from Database wizard, if you have specified that you want to select which record to print.

The purpose of Record Selection dialog box is to be able to instruct the application not to print all records from the
database but only the record(s) that you will point out (select).

If you do not know the exact location of record(s) in the database you want to print, you can use the search functionality. Enter the phrase you would like to find, select the field name where the text should be searched for, and click the **Find** button.

If you have ticked the **Exact search** option, only the records that exactly match the entered condition, will be displayed. The record has to contain only the data entered and it has to be in the proper case.

**Select All:** This button will select all records in the database.

**Unselect:** This button will deselect all marked records in the database.

Command buttons First record, Prior record, Next record, Last record can be used to navigate thru database records. You can also use vertical and horizontal scroller to do the same task.
You can select the multiple records using standard Windows shortcut with Ctrl button. Press and hold Ctrl key, the use the mouse to select records one after another. Or you can simply tick each selected in the beginning of the line. Put a cross in the white square. Only the records that have tick mark in the square will be printed. Use Space key to toggle the selection/deselection of marked records.

If you have set up your database connection to enter the quantity of labels you need to print for each record, additional field will be inserted in front of the first field. It is marked with hash symbol (#). Use this field to define the quantity for each record you need to print.

**Optimize for fast windows load**: enable this option to speed up the display of table data when you enter the dialog box the next time. The checkboxes for selection of record will not be displayes, which speeds up working with larger databases. Record selection in this mode can be performed using standard Windows shortcuts with Shift and Control keys.

If you want to easier navigate thru larger databases, there is an option for you to group the records by some database field. You can nest fields one below the other and create a tree structure for more complex field grouping. Just click and drag the field name to the spot above the table.

Besides grouping you can also benefit from filtering functionality. Filter can be very useful in situations where you are dealing with larger tables and would like to limit the view of the table data. You can set a user-defined conditions to the table and only record that comply to them are displayed.

To enable filter on some field, click the arrow button next to the field's name. There are multiple options you can select:

- **All**: Select this to disable filter on this field.
- **Custom**: Create a custom filter for this field. You can select standard qualifiers as: equals, does not equal, is less than, is
less than or equal to, is greater than, is greater than or equal, like, not like, is blank, is not blank.

You can nest two conditions for the filter and thus build a more complex condition for the field. They can be joined together using AND (all conditions must be true in order to display the record) or OR (only one condition must be true in order to display the record) logical qualifiers.

A separate dialog box is used for defining the custom filter.

Blanks Only the records with blank values for this field are shown.

Non Blanks Only the records with non blank values for this field are shown.

<data values> Only the records that have the selected data value in this field will be shown.

Filters can be combined on more than just one field.

If the field has a filter defined, the arrow next to field name in the caption will be displayed in blue color. If the filter is not defined, the arrow is displayed in black color.

The list of defined filters is also visible below the table. You can remove the filter(s) by clicking the button or temporary disable the filter by ticking the button next to the filter definition.

If you want to make further modification to the filter(s) used on the table, click the Customize button to open a separate dialog box with detailed control over filters. If you prefer to have more structural overview on the filters, you will like this option. This way you can quickly define more conditions and groups using one dialog box.

You can save the filter for the future use, and you can load a filter you have created previously.
3.4.20 Print...

The Print command from File menu controls the production of the labels. Clicking the icon is equivalent.

The number of printed labels must be specified in the Production dialog box.

In Printer section you can choose to print to some other printer, not the one that the label was created for, and use different speed/darkness settings.

You can also select Print to file option and redirect the printer commands to the separate file on the disk. Normally printers are connected to the parallel, serial, network or USB printers and use such connectivity method to send data to the printer. If you require the output that is normally sent to the printer to be saved to some file, use this command. You can that take this file to another computer that does not have this labeling application installed, and send it to the printer to produce the same labels.

All other data has the same meaning as in the Print Preview command. The procedures are also the same except that label will not only be shown on screen, but also sent to printer.
3.4.21 JOB File Explorer

This command will start an external application JOB File Explorer that is used for easier constructing of batch command .JOB files. You can use any plain text editor to write your .JOB files to control automated label printing from the labeling application, but JOB File Explorer will further simplify the process. Built-in Expression Builder displays all available NiceCommands that can be used in the .JOB files and you can simply point&click to easily construct the batch file.

3.4.22 Automatic Print Preview

Printing can be started and controlled automatically - without any user intervention.

This can be done using outside command files (JOB files) that have to include suitable NiceCommands. The file format must be plain ASCII text.

This command opens the Open dialog box in which you select the name and directory of the command file.

In the command file you must determine which label should be printed, the values of the variables and the print quantity of the labels. You will find more information about how to use this commands in the chapter NiceCommands. Automatic Print
This command opens the dialog box **Open**. Select the name of the command file, which must carry out printing. The program will get all the instructions for printing in this file.

In this file you can define the label which should be printed, the values of the variables and the print quantity for the labels.

The form of the command file is the same as for the **Automatic Print Preview**, except that label will also be sent to the printer. You will find more information about how to use the appropriate commands in the chapter **NiceCommands**.

### 3.4.24 Send

The **Send** command sends the active label to the system default email client. You can use this command to quickly email the label to chosen recipient. Note that only the label will be attached to the email. Any connected graphics or database files will not be sent.

### 3.4.25 List of Files

At the end of the file menu there is the list of most recently used labels. Clicking the name opens the appropriate file as if you would select this file with **File-Open** command.

### 3.4.26 Exit

Use this command to leave the labeling application. When using the keyboard, the shortcut to this command can be invoked by pressing the `<ALT>` and `<F4>` keys simultaneously. If the opened labels haven't been saved yet, you will be prompted to do so.

### 3.5 Edit

After clicking the **Edit** menu on the menu bar, the command list in that menu appears.
In this menu all commands related to label editing are located. You can Copy, Cut, Paste, and Delete selections, Undo and Redo last actions, and manage OLE object and Links.

3.5.1 Undo

*Undo* command cancels up to 10 of the most recently carried out commands or actions. If you do not like the results of a command, or accidentally delete some elements, choose the *Undo* command as the next action to restore the previous mistake.

The *Undo* command can be also activated by clicking the icon on the toolbar or by pressing the *<ALT>* and *<Backspace>* key simultaneously.

3.5.2 Redo

*Redo* command is used when you need to restore the last *Undo* action. It also has the capability to store (and restore) up to 10 previously made steps.

The *Redo* command can be also activated by clicking the icon on the toolbar or pressing *<Shift>*, *<Alt>* and *<Backspace>* keys simultaneously.

3.5.3 Cut

This command is used when you want to remove selected element(s) from the label. Note that the first element is
selected by clicking it. When you want to select additional elements, you must press, and hold down, the <Shift> key while clicking each additional element.

The cut elements are stored in the internal clipboard and can be re-inserted on the label with the **Paste** command. The combination of **Cut** and **Paste** commands can be used to speed-up label editing and designing.

The **Cut** command can be also activated by clicking the icon on the toolbar, or by pressing the <Shift> and <Del> keys or <Ctrl> and <X> keys simultaneously.

### 3.5.4 Copy

This command copies the selected elements to the Windows clipboard.

Clicking the icon or by pressing the <Ctrl> and <Ins> keys or <Ctrl> and <C> keys simultaneously can also activate the Copy command.

### 3.5.5 Paste

The **Paste** command is used to paste the contents of the clipboard to a label. This command can be used to paste the same information more than once. It is very useful when you need to have multiple copies of the same element on the label.

Once the element has been designed satisfactorily, it can be copied to the clipboard, and pasted on to the label, in different places and several times.

You can also design objects in other Windows applications, copy them to the clipboard and place the on the label with the **Paste** command.

Clicking the icon or by pressing the <Shift> and <Ins> keys or <Ctrl> and <V> keys simultaneously can also activate the Paste command.

### 3.5.6 Paste Special

With this command different way of pasting the contents of the clipboard is defined.
The **Result** box explains the appearance of the clipboard contents on the label.

![Paste Special dialog box](image)

For example, you can paste the text from the clipboard, produced by Microsoft Word, as a *Word document* or as a *Metafile Picture*. When pasted as a *Word document*, the object can be edited by double clicking it. Instead of icons and menus of a labeling application you will see Word working space. You can use familiar Word user interface to make a changes. When finished, labeling interface will be restored.

When pasted as a *Metafile Picture*, the object is treated as a graphics.

In the dialog box you can choose between two different types of paste. The first one (*Paste*) makes the copy of the original, the second one (*Paste Link*) links the original document with the label.

### 3.5.7 Paste Link

Using *Paste link* command establishes a link between labeling application and the source application for the contents of the clipboard.

The link information is saved in the source file; only the location of the information in the source file is saved. The link data shows in the graphic form.

Double clicking a Paste-link object will place you into the original source Windows application for that object. The object is then edited in the application.
3.5.8 Delete

The command is used to delete selected elements. Deleted elements are not stored in the clipboard. To restore deleted elements, the **Undo** command must be used before any further actions. **Delete** command can also be activated using the <Del> key.

3.5.9 Select All

This command selects all elements on the label.

3.5.10 Insert Object

This command inserts an OLE object on the label. Two subcommands exist.

Note that resizing an OLE object may not work as you expected. It is advisable to resize the object only when in OLE edit mode (after double clicking the object).

**Create New**

With this command you can insert in a label objects from any Windows application on your computer, that supports OLE 2 interface.

After selecting the appropriate application (for example: Word for Windows to create text paragraphs, Lotus 1-2-3 to create tables and graphs...) the application icons will be set on the upper part of the screen.

You can design the object as you wish and with the application tools, which are provided by the server.
application. After you are satisfied with your work, place the object on a label with the Exit and return, or Close and return command, or by clicking somewhere on the label (depending on the application).

**Create from File**

With this command you can insert to labels already defined objects. If the object is in a Word file, you just select the directory and the name of the file.

![Insert Object dialog box – Create from File option](image)

3.5.11 Links

This command shows on the screen a list of all links between the active label and other applications in your working environment. When you insert an object with the command Paste Link on the label, you will see this link in the list.

The links can be interrupted. This means, that the any changes made in the source document will not be made on the label.

3.5.12 Objects

Selected object can be opened, edited or converted.
When you want to open or edit the object, you will enter the source application, where the object was created. When you have finished editing, return to labeling application using either **Exit and Return** or **Close and Return** commands.

The **Convert** command is used to convert the object to an icon representing the object.

### 3.5.13 Show Objects

The command shows all inserted objects:

- if the object is linked, the object is marked with a dotted line
• if the object is inserted, the object is marked with a solid line

The purpose of this command is to separate objects created on the label from those linked to other application.

3.6 View

In View menu you define the zoom factor and view type of the label. You can also select which parts of the working environment (toolbars) are visible and which not.

The following commands are available in View menu.

3.6.1 Normal View

Selects normal label view. Clicking in icon in toolbar has the same effect.

In this view type, variables are shown on screen as a series of question marks (?). Number of question marks corresponds to the variable length. Use this view to precisely position the elements on the label as you know their maximal possible length.
3.6.2 Data View

Selects data label view. Clicking in 🗂️ icon in toolbar has the same effect.

Variable elements are in this case shown, as they will appear when printed. This means, that counters will show numbers, database variables will show data that is obtained from database, and so on.

When using data view printing starts at the record currently shown on screen and not at the beginning of the database, as usual. Be extra careful when printing records from database with unlimited quantity.

**NOTE!** Databases are locked if you are using data view and variables from these databases. Already opened database cannot be simultaneously used in another program; you cannot change structure of database and alter its records.

3.6.3 Zoom In

**Zoom in** command shows a smaller section of the label. The <+> key of the numeric keypad can also be used. Each time **Zoom in** is selected and you click once on the label, the displayed picture becomes 10% bigger.

This command shows the magnifying glass on the screen. By clicking and dragging the mouse, you can surround the part on the label that should be magnified. The selected part will be zoomed to fit the screen.

3.6.4 Zoom out

**Zoom out** command shows a wider view of the label. The <+> key of the numeric keypad can also be used. Each time **Zoom out** is selected, the displayed picture becomes 10% smaller.
3.6.5 **Zoom**

In the **Zoom** dialog box you can select the different ways of zoom:

- **100%**: the size of the document on screen will be the same as the size of the document on the label.
- **to page**: You will see the entire page on the screen. Clicking ![icon] has the same effect.
- **to label**: You will see the entire label on the screen. Clicking ![icon] has the same effect.
- **to elements**: You will see all the objects on the screen. Clicking ![icon] has the same effect.
- **factor**: you can define your own factor of zoom (in %)

**Mouse Wheel support**

If you have mouse, that has a wheel in place of the middle button, you can use it to speed-up zooming and scrolling a lot:

- Turning the wheel, scrolls the label up or down.
- Holding <SHIFT> and turning the wheel scrolls the label left or right.
- Holding <CTRL> and turning the wheel, zooms the label in or out.

3.6.6 **Toolbox**

You can switch the **Toolbox** on and off with by selecting or deselecting **Toolbox** option in **View** menu or clicking the ![icon] icon.
Toolbox contains all frequently used tools to speed-up the design and printing of labels. Using the icons from Toolbox you can select elements, add text, picture, box, barcode, inverted image and line to the label, rotate and increased or decreased the selected element(s).

All commands listed in the Toolbox are also in the menus. The commands are executed identically.

The individual tool is activated by clicking it directly, it becomes darker to indicate it has been selected.

Text, Paragraph, Barcode and Graphics elements have additional shortcut on the right side of the icon. Using this shortcut you can quickly create a new element with static contents, create a new variable field and connect it to the selected element or connect it to one already defined variable field.

Select

When you need to select an element for moving, rotating, etc., the Select tool must be used. After selecting this command click the element to select it. If you want to select more elements hold down the <Shift> key while clicking the other elements.

This tool can also be used to cancel the selection of elements (i.e. to de-select all previously selected elements).

Clicking this button is the same as selecting Select command (Alt+0) from Object menu.

Text

Select this tool when you want to enter text strings, paragraphs or single characters onto the label.

Clicking this button is the same as selecting Text command (Alt+1) from Object menu.

Paragraph text

Select this tool, when you want to paragraph text into label.

Clicking this button is the same as selecting Paragraph Text command (Alt+2) from the Object menu.
**RTF**

Select this tool to add Rich Text Format element to the label.

Clicking this button is the same as selecting **RTF (Rich Text Format)** command (Alt+3) from the **Object** menu.

**Bar code**

By selecting this tool, you can add bar codes to the label.

Clicking this button is the same as selecting **Barcode** command (Alt+4) from **Object** menu.

**Graphics**

This enables graphics to be included in the labels. It can be used to add pictures of products, company logos, etc.

Clicking this button is the same as selecting **Graphics** command (Alt+5) from **Object** menu.

**Rectangle**

This tool is used to design and position a rectangle or square. The upper left corner of the box is set by clicking the desired position, and the size of the box is set by dragging the box to the required size, while still holding down the mouse button.

Clicking this button is the same as selecting **Rectangle** command (Alt+6) from **Object** menu.

**Line**

Adds a horizontal or vertical line to a label. You can draw a line by clicking at the desired starting point and dragging the line to its ending point, and releasing the mouse button.

Clicking this button is the same as selecting **Line** command (Alt+7) from **Object** menu.

**Ellipse**

This tool is used to design and position an ellipse or circle. The upper left corner of the ellipse is set by clicking the desired position, and the size of the ellipse is
set by dragging the element to the required size, while still holding down the mouse button.

Clicking this button is the same as selecting **Ellipse** command (Alt+6) from **Object** menu.

**Inverse**

Using this tool, you can produce an inverted image of any element on the label.

Clicking this button is the same as selecting **Inverse** command (Alt+9) from **Object** menu.

**Rotate**

This tool rotates selected element(s) in steps of 90° clockwise. The co-ordinates of the upper left corner of the selected element(s) always stay the same when an object is rotated. The shortcut to this command is (Ctrl+T).

**Zoom In**

This command increases the selected element or part of the element.

Clicking this button is the same as selecting **Zoom in** command from **View** menu.

**Zoom Out**

This command decreases the selected element or part of the element.

Clicking this button is the same as selecting **Zoom out** command from **View** menu.

### 3.6.7 Text tool

Selecting **Text tool** command from **View** menu switches the Text toolbox on or off. You can also use icon.

Tools in this toolbox enable you to change the font and the form of the text.

If you want to change the text object on the label, you must first select it by clicking it.
In first list box you can see the type of the text. If you want to change it, click drop down menu and select the new type.

The next list box shows the size of the text. If you want to change the size, click the drop down menu and select new size.

Beside this windows there are three buttons:
- \( B \) formats the selected text in bold style
- \( I \) formats the selected text in italic style
- \( U \) formats the selected text in underline style

Further to the right there are are three text alignment buttons. They are available with multi-line text elements.
- \( L \) align text to the left edge
- \( C \) align text to the horizontal center
- \( R \) align text to the right edge

### 3.6.8 Color palette

Selecting **Color palette** from **View** menu switches Color palette toolbox on or off. You can also use \( \equiv \) icon. Color palette toolbox contains the list of different colors. The first part of the toolbox represents the elementary colors; the second part your custom colors.

If the object is selected you can change the color by clicking new color in the color palette.

If you want to define your custom color, select the first icon **Setup your custom color** (the leftmost icon) in the color palette. The **Colors** dialog box opens and here you can define your custom color. If you want to add this color in the color palette, click **Add to Custom Colors** button. When you want to use this color next time you can just click it in the color palette.

When you use multicolor thermal printer on the label, the palette adapts to the selected printed and displays only the colors supported by the printer. In the printer driver you can define the colors for each printer head and these colors are available in the palette. The elements on the
label can then be formatted with one of the available colors.

### 3.6.9 Variable tool

Selecting **Variable tool** from **View** menu switches the toolbox with tools for editing variables on or off. Clicking the icon has the same effect.

First list box represents the name of the variable that is connected to the currently selected object. If you want to change the variable, click the drop-down menu to select a new variable. If no object is selected, selecting a variable in the combo box puts a new text object on the label that is linked to this variable.

The object that contains the variable (for example a text object connected to the variable) can be fixed with the click of the **Make element fixed** button. This means that the current variable will be disconnected from the element, which will become fixed, but will preserve all special formatting (text style and size, position, etc.). The number of the letters will be equal to the length of the variable. This might come in handy when you are changing the database on the label and want to conserve current label layout and elements' format. When the other database is re-connected, you can simply assign new variables to these elements on the label.

Button **New variable** creates a new variable and opens **Variable** dialog box. Read more about variables in chapter Variables on page 3-107. After you have selected variable properties and confirmed them by clicking the **OK** button, you can put the text object by clicking the label; it will be connected to the current variable.

The button creates a new variable using **Variable wizard**. Click the button to start the Wizard from the beginning or select an arrow next to the button and choose the appropriate variable field type to speed-up the process.

The existing variable can be edited with **Edit variable** button. It opens **Variable** dialog box. Object containing
variable must be selected, or the button will not be accessible.

Button **Delete variable** is used to delete the selected variable.

The last button in this toolbox - **Functions** opens **Functions** dialog box. More about functions can be found in chapter Functions on page 3-128.

### 3.6.10 Align tool

To switch Align toolbox on and of use the **Align tool** option in View menu, or click the icon.

This toolbox contains icons, which let you align objects horizontally and vertically. The vertical alignment can be top, bottom or center. The horizontal alignment can be left, right or center.

Bottom two icons align selected objects in a manner, that the horizontal or vertical spacing between the objects is equal.

If you click buttons with <Ctrl> key pressed, you can align objects horizontally and vertically in relatively to the label instead to each other.

The object are always aligned to the first selected object.

### 3.6.11 Database tool

Selecting **Database tool** from View menu or clicking the icon, switches the Database toolbar on or off. In this toolbar are several icons that enable you to quickly select commands regarding database connectivity functions.
First field shows the list of currently active databases. It allows you to browse thru the attached databases.

With **New Database function** button you create new database function. You can also use **Wizard for new database function** button and simplify the creation of the new database function. The friendly Database Wizard will guide you thru the steps of database connectivity.

Next buttons allow you to **Edit database function**, **Edit table fields** and **Delete database function**.

**Edit database** button calls database manager where you can edit currently selected database.

**Database navigator** buttons are used to move through different record in database when data view is active. Note that with this you only select which record is shown on screen in database variables. This way you can effectively see how the label will look with different records from database.

### 3.6.12 Label Inspector tool

Label Inspector is a tool for advanced element and data manipulation on the label. It is used for overview of label's structure and modifying label components.

It is composed out of three segments:

- **Shortcuts**: Click the buttons to select the appropriate view of the Label Components. It can be either: view by objects, by variables, functions, databases or as list. The rightmost button is used to set the default Inspector's behavior; should the components be shown with all their structure or should they be shown only with their name.

- **Label Components**: They are presented in alphabetical order by their name. Selected element has its attributes displayed in the properties segment below. Right-click the element for additional options.
• **Properties:** Properties of selected elements are shown here. You can interactively change the values and they will be instantly updated on the label.

The default position of the Label Inspector is a docked position beside Toolbox on the left side of the working window. This position can be changed at any time, just drag Label Inspector to some other location. You can use it in a floating state, when it is not docked in the application, but positioned above or next to it. When it is in this form, you can freely change its size, simply grab it by the edge or the corner and resize it in appropriate direction.

For more information refer to chapter Label Inspector on page 4-193.

### 3.6.13 Margins

Selecting **Margins** command from **View** menu will show you the settings of the label parameters - dimensions, offsets, and radius. To return back to the editing mode this command must be chosen again.

Clicking the Margins icon on the toolbar can activate the same action.

---

*On-Screen definition of label settings*
When command is active, the screen is set to a mode, where all the dimensions and the shape of the label (horizontal and vertical radius) can be set on screen. In this mode you can set the dimensions with the mouse by moving lines. The black line changes the size of the label and the blue line changes the distance and gap between the labels. You can change between these two modes by clicking the line handle.

At the left side of the screen all the parameters are shown, showing you the changes of the values, as you drag the handles.

### 3.6.14 Object properties

Here you can select which object properties you want to display on screen. Note that these properties are only for your information and are not printed. They are just displayed next to elements on screen.

- **Paragraph size**: Shows border around paragraph text.
- **Locked position**: Shows a lock symbol beside locked objects.
- **Printer elements**: Show a printer symbol beside every printer's internal objects.
- **Printer counters**: Show a counter symbol beside every printer's internal counter.
- **Variable names**: Shows variable names on top of variable objects. You can also use icon in the toolbar.

### 3.7 Object

Objects are the basic elements on a label; i.e. text, bar code, line, box and picture.

Object's content can be fixed, or variable (counters, values from database, keyboard input…)

Each of these objects can also be represented as an inverted image.
There is no upper limit to the number of elements that can be placed on a label, subject, of course to the available label space!

Objects can be added to a label by selecting appropriate commands from the **Object** menu, or by clicking the corresponding icon on the **Toolbox**.

When you select the **Object** menu from the menu bar, the following options are displayed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Rich Text</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Barcode</td>
<td>Alt+4</td>
</tr>
<tr>
<td>Graphics</td>
<td>Alt+5</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Alt+6</td>
</tr>
<tr>
<td>Line</td>
<td>Alt+7</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Alt+8</td>
</tr>
<tr>
<td>Inverse</td>
<td>Alt+9</td>
</tr>
</tbody>
</table>

**3.7.1 Select**

**Select** command from **Object** menu allows you to select one or more objects on the label. After you choose this command, use the mouse cursor for pointing on the appropriate object then click the left mouse button to select it. You can also select this command from **Toolbox**.

To select two or more objects, you should press the <Shift> key, and hold down, while clicking the object with a mouse.

The objects can be selected, cut, copied, pasted and edited with the right mouse button. If you click the right mouse button on the object, the menu shows all the available commands. Note that these commands are equivalent to correspondent menu commands.

You can also change the anchoring point of a selected object by holding <CTRL> while clicking the placeholders (corners of the bounding box) of the object.
3.7.2 Text

With **Text** command, you can put a new text object to the label. It is used mainly for one-line text elements, elements, although you can use it for multi-line text as well. Click on the label, where you want the text to be placed.

There are two modes of operation, which can be set by setting program preferences. The first (default) is "On screen edit". This means, you can enter text directly on the label, similar to a word processor program. When you have typed the contents, you can cancel typing by pressing <Esc> key, or confirm it by pressing <Ctrl+Enter>. The text object is created.

The second mode immediately opens the dialog box for the text, where you can enter the contents and set all other properties of the text. This dialog box can also be opened any time by double clicking the text object or by right clicking the object and selecting **Edit** from menu.

The **Text** dialog box has several pages (tabs):

**Contents tab**

![Text dialog box - Contents tab](image)

On this tab you can set what will be the source of the data for the selected element. Many Contents Providers can be
used to acquire necessary data for the element. For more information about Contents Providers please go to chapter Contents Providers on page Error! Bookmark not defined..

When one of the available Contents providers is selected, the main part of the tab will change, reflecting the properties of that provider. Each provider has its own parameters that need to be set.

Note: If you have selected Variable contents provider, the variable is a counter and can be used as internal printer counter, the Use printer internal counter option will become available. Select it to enable printer internal serialization functionality. The printer itself will take care of the counter incrementing/decrementing, NiceLabel Pro application will only set the starting value and increment/decrement step. For more information please refer to the How to chapter Use printer internal increment counter on page 6-4.

When you are done with the value type settings and want to confirm the editing, click OK button.

**Mask tab**

In some cases you have a task to print the value of the element in some totally unstructured data format that even can not be defined in variable's format properties. Here you can define the contents mask for the element's value. The mask character will be replaced by the actual element's data (output of one of the Contents Providers) and any other used character will be used as-is. For example, if the current element's value is "12345" and the contents mask is "** - AB - * (**)", the resulting output will be "12 - AB - 3 (45)". If your element data contains the asteriks "*" character, then you will have to change the mask character to something else. It should be a unique value, not appearing anywhere in the element's contents.

**Style tab**

Under Style tab the appearance of the text element can be set.
Any of Windows TrueType or internal printer fonts can be selected by clicking the Select button. If the currently selected printer for the label is thermal/transfer printer, there will be some additional fonts available in the list. They are printer internal built-in fonts and if they are used, the printing on the thermal/transfer will be much faster.

**Inverse**: If selected, text is printed in reverse. This option is available mainly for truetype fonts. Only a few thermal/transfer printers support this option with internal fonts.

**Mirror**: If selected, text is printed mirrored. Most thermal/transfer printers do not support this option, so you will have to use truetype fonts to print mirror text.

**RTL printing**: If selected, the internal printer text will be printed in right-to-left order. It is useful if you operating system does not have native RTL support but you still need to print text in this manner. For this to work, you printer has to have an internal Hebrew printer font built-in. This option only works with internal printer fonts and not Truetype fonts.

**Stacked text**: If selected, the character will not be aligned in left-right order next to each other, but in top-bottom
order one on top of the next one. The text orientation is remains the same, just the alignment within the element changes.

**Font scaling** is a factor, which shows, how much the font is stretched from its original proportions. If the factor is 100%, the font has a normal look. If factor is 200%, it means that font is twice as wide as normal. If it is 50%, the font is stretched.

**Line spacing** is the optional distance factor between the lines, shown in selected units. You can enter an optional value to adjust the space between the lines. Note that line option is available only if you have entered more than one line of text.

**Character spacing** is the distance between the characters. You can enter an optional value to adjust the space between the characters.

**Justification:** The text can be aligned to the left or right side or centered. This is more useful when you have multiple line text or when text is an output of the variable.

Example: Lets have the following content of the variable on different labels: "A", "ABC" and "ABCDE". When you design the label the content on the screen looks like "??????". The first label has the value "A". If the alignment is "left" the value "A" will be on the left edge of the first question mark. If the alignment is right, the value "A" will be aligned to the right edge of the last question mark (on the second label the value "C" and on the third label the value "E" will be aligned to the last question mark).

If the alignment is **center**, the value will be in the middle of the reserved space.

Alignment of the variable text is performed on the actual data.

If you would like to change the color of the current element, click **Color** button. After you set the required color, confirm it by clicking the **OK** button.

Note: Text will be printed in color only on printers that support color printing. These are mostly inkjet and color laser printers (i.e. Epson Stylus Color, HP DeskJet...).
**Note:** Text will be printed in colors only on printers that support color printing. These are mostly inkjet and color laser printers. If you are using thermal printer with color support and have appropriate printer driver installed, the color supported in the printer will be available here. You can format each label element in particular color in thus specify which printer head will print it.

**Appearance tab**

On the *Appearance* tab, the position of the text objects (x and y coordinates of the upper-left corner of the object) is set. You can use this option to precisely set the object position. It can also be changed directly on the label by selecting and moving the text object across the label.

**Aspect Ratio** option will lock the ratio of the element. When you change the height, width is automatically adjusted so that the element is not distorted and vice-versa.

It is possible to set the *rotation* of the text objects in steps of 1 degree anti-clockwise to fit the appropriate position.

![Text dialog box – Appearance tab](image)

Note that printer's internal fonts usually only have rotations in steps of 90°, while truetype fonts can be freely rotated. If you are not able to rotate truetype fonts
when using standard office printer (laser, inkjet, matrix...) make sure to disable printer optimization in the printer driver. When the optimization is selected, all truetype fonts are handled as internal fonts, and internal fonts cannot be freely rotated, but only in steps of 90°.

**Object anchoring point:** Here you can set which corner of object bounding box is used for positioning the object on the label. This is the corner where the element is pinned on the label. For example, if you select the upper left button here, then upper left corner of the object will be placed to position that is set above.

**Status tab**

Status defines the printout of the object. **Normal** means that the object will be printed normally as seen on-screen. **Phantom** means that the object will not be printed and will only be shown on the screen.

The **Phantom** is useful when you use pre-printed labels. You can insert the label elements, representing the preprinted and define them as phantoms. The label layout on the screen will look exactly like the pre-printed label, but only the elements marked as non-phantom will be printed.
Invalid elements are elements that are placed out of the label boundaries. These elements are normally not printed, but there is an advanced option in preferences, if you wish to override the default setting and want to print invalid elements. However, the printing results are not predictable. The label may or may not get printed correctly. Test this option before starting a real print production.

If Position locked option is checked, then selected object can not be accidentally moved or deleted until you uncheck this option at a later time.

Set default
The Set default button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

3.7.3 Paragraph
With Paragraph command, you can put a new paragraph text object to the label. Click on the label, where you want the upper-left corner of the text to be placed, then drag to create a box.

A paragraph text is much like a normal text except, that the text will fit to a specified box size. This is specially useful, when using variable data, because no matter how long the text value is, it always stays on a predefined part of a label.

You can set additional options in a Paragraph dialog box that is opened when you insert new or edit an existing paragraph text.

Paragraph dialog box has several pages (tabs):

Contents tab
This tab is exactly the same as the Contents tab of the Text dialog box. Please see Text command on page 3-59 for tab description.

Detailed tab
In Detailed tab, advanced properties can be set for paragraph element.
Paragraph dialog box – Detailed tab

**Line spacing** is the distance factor between the lines, shown in selected units. You can enter a value to adjust the space between the lines.

**Character spacing** is the distance between the characters. You can enter an optional value to adjust the space between the characters.

**Justification**: The text can be aligned to the left, right side of the bounding box, centered or justified. This is more useful when you have multiple line text or when text is a result of the variable.

**Center** justification means that text will be centered horizontally in the paragraph text box so every line will have an equal distance to the left and right border.

**Full** justification means that each line of text will occupy the full width of the bounding box. Spacing between words in the line will be adjusted so that every line will always span through the whole width of the paragraph text box.

If **Best-fit** option is selected, then the size of the font used with this paragraph element will be automatically adjusted in a way, that the paragraph text will occupy the whole text box. This is useful in cases where text of different sizes should be positioned on the same place on
the label, but each of them varies in size. You can limit the smallest and largest font sizes that should be used with paragraph element.

The **Use same size for all 'Best fit' paragraphs** is useful, when you have multiple paragraph elements on the same label and they all have enabled Best fit. This way they all will have set the same font size and will look identical.

**Font scaling** is a factor, which sets, how much the font is stretched from its original proportions. If the factor is 100%, the font has a normal outlook. If the factor is 200%, the font is twice as wide as normal.

**Style, Appearance and Status tabs**

Style, Appearance and Status tabs are all similar to those used with text dialog box. Please refer to the **Text** command for further information about Style, Appearance and Status tabs.

**Set default**

The **Set default** button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

### 3.7.4 RTF (Rich Text Format)

With **RTF** command, you can put a new text object to the label. RTF stands for Rich Text Format. Unlike **Text** and **Paragraph** commands you are no longer limited to using only one font typography in one style with the same element. Within RTF element several different fonts can be used in different font sizes, appearances and formattings at the same time. It will help you create your label look more professional with less effort.

Click the label, where you want the upper-left corner of the text to be placed, then drag to create a box. If you just clicked the label without dragging the element, then RTF element of default size will be created. You can resize or move the element at any later time.

A RTF element is much like a normal Paragraph element except. It has similar properties and dialog box with options.
RTF element can have a fixed contents or can be used to acquire data from variables. To insert variable fields to the element see the toolbar in the RTF editor.

RTF element will always be displayed in a WYSIWYG mode on the label. It will be printed the way it is displayed on-screen. But when you edit the RTF element, it might be resized and layout of text might be changed. Characters can be reformatted and layout of the text can be changed. This behavior is quite normal and occurs because in the difference between printer and screen resolutions. When you will finish editing the element its display will be changed back to the accurate mode.

**Contents Tab**

In this tab the contents provider for the element can be selected. It provides the element with the data. For RTF element the best choice is Rich Text Editor, which is also set as default.

This tab is exactly the same as the Contents tab of the Text dialog box. Please see Text command on page 3-59 for tab description.

When Rich Text Editor contents provider is selected, you will see the preview of the data in the bottom memo box. To change the contents for the element, click Edit button to open RTF editor.

**View RTF Code:** Enable this option to view at the RTF code directly. Note, this option takes effect only on this tab, not in the RTF editor.

**Detailed tab**

On this tab the best fit status of the RTF element can be reviewed.

This tab is similar to the Detailed tab of the Paragraph dialog box. Please see Paragraph command on page Error! Bookmark not defined. for tab description.

**Appearance tab**

On this tab position, size, rotation and anchoring point of the RTF element can be reviewed.
This tab is exactly the same as the Appearance tab of the Text dialog box. Please see Text command on page 3-59 for tab description.

**Status tab**

On this tab printing and locking status of the RTF element can be reviewed.

This tab is exactly the same as the Status tab of the Text dialog box. Please see Text command on page 3-59 for tab description.

**RTF editor**

The RTF editor is provided for the user to edit the contents of RTF element more easily. Use it to enter the text and then format is to your requirements. Toolbars with commonly used commands are available at the top of the dialog box. You should be instantly comfortable using the toolbars as they offer the same commands as any typical text editor.

You can change text style, formatting, text alignment, you can use bullets and further manipulate the data. The ruler positioned just under the toolbars can be used to change the left and right indentation of the text and to modify the indentation of the first line (indented more to the right or hanging).

If there are variables defined on the label, the Variable toolbar will be displayed allowing you to insert variables into the RTF element. The variable names are enclosed in the square brackets.

The toolbar in RTF editor is much similar to the Text toolbar.

### 3.7.5 Bar code

To include a bar code on the label, select the barcode icon in the Toolbox, or the Barcode command in the Object menu. Then click the mouse button on the label where you want the barcode to be placed, and the Barcode dialog box will appear. You can later access this dialog box by double clicking the barcode element. Many additional properties for the barcode can be set here.
Once the barcode properties are defined, close the **Barcode** dialog by clicking the **OK** button and selected barcode element will appear on the label.

**Barcode dialog box – Contents tab**

Barcode dialog box has several pages - tabs:

**Contents tab**

Here you can define a value that is later encoded in the barcode symbology. Source of a barcode contents can be one of many Contents Providers.

This tab is exactly the same as the **Contents** tab of the **Text** dialog box. Please see **Text** command on page 3-59 for tab description.

Note, if you have selected EAN.UCC 128 for barcode type, then this tab's appearance will be changed to enable you define your EAN.UCC 128 barcode contents. The following text applies only when EAN.UCC 128 barcode type is selected.

Contents tab then looks like this:
The upper part of the dialog box where you would normally select Contents Provider for the barcode is unavailable, but lower part enables you to build the necessary EAN.UCC 128 data structure.

You can select any existing EAN.UCC 128 function which will provide value for the barcode. If no EAN.UCC 128 functions are defined, you can use Add button to define new EAN.UCC 128 function. Edit button is used to change the already defined EAN128 function. Dialog box for editing functions and functions in general are described in chapter Functions on page Error! Bookmark not defined. of this manual.

When Wizard option is checked, then EAN.UCC 128 Wizard will help you to create a new barcode function. See chapter EAN.UCC 128 Wizard on page 3-81 for details.

When Create/update text for interpretation is checked, the human interpretation text of the barcode data is automatically added below the barcode or updated, if it already exists. Otherwise you have to add or update the human interpretation text yourself.

Note, when some of the RSS bar codes is selected, the Structural RSS Bar code Contents Provider is
automatically selected in this tab. It simplifies providing the data for RSS bar codes. They can be contracted either out of one one-dimensional part or composed from one-dimensional bar code and two-dimensional supplement (composite component). The data for linear and composite parts can be entered in the edit boxes. You can also acquire data from some variable.

**Barcode interpretation font selection**

There are two ways for selecting font of barcode interpretation:

**Printing barcode as internal element**

In Human readable tab you have to select no interpretation and add another text element to your label, which is using the same variable as barcode. To this element you can select any font that is installed on your system or you can select printer internal font for faster printing. If the contents of barcode include check digit then you have to include it to your text element. To do this you have to calculate it manually and combine it with the variable with function Concatenate.

**Printing barcode as graphics**

If you are printing barcode as graphics then you can change your font by selecting Font button in Human readable tab. This way may cause that the size off your fonts is too big in combination with barcode. The solution for this is that you check Auto font scaling.

**Barcode tab**

This tab is used for choosing barcode symbology type, optional Contents mask and color for barcode symbol.
When you click Define button, the **Edit barcode dialog box** is displayed. Here you can select the required barcode symbology and all optional or advanced parameters needed to properly define the structure of the barcode.

**Contents Mask** is very useful in cases when you have a requirement to use differently formatted human interpretation text below barcode. Usually no special formatting is available for the value below barcode and is presented in a sequence of digits and/or letters as encoded in the barcode symbol. Here the special formatting can be set. The mask character will be replaced by the actual element's data (output of one of the Contents Providers) and any other used character will be used as-is. For example, if the current barcode value is "AD951" and the contents mask is "**C - ** /*/", the resulting output will be "ADC - 95 /1/". Powerful formatting structures can be defined using Contents mask, but it is only available with barcodes that allow custom formatting of the human interpretation. You should also make sure to print barcodes as graphics, otherwise printer internal barcode processing will override this custom setting. If your element data contains the asterisks "*" character, then you will have to change the mask character to something else.
It should be a unique value, not appearing anywhere in the element's contents.

If you would like to change the color of the current element, click **Color** button. After you set the required color, confirm it by clicking the **OK** button.

Note: Text will be printed in color only on printers that support color printing. These are mostly inkjet and color laser printers (i.e. Epson Stylus Color, HP DeskJet...).

**Appearance tab**

On this tab position, size, rotation and anchoring point of the barcode element can be reviewed.

This tab is exactly the same as the **Appearance** tab of the **Text** dialog box. Please see **Text** command on page 3-59 for tab description.

**Status tab**

On this tab printing and locking status of the barcode element can be reviewed.

This tab is exactly the same as the **Status** tab of the **Text** dialog box. Please see **Text** command on page 3-59 for tab description.

**Set default**

The **Set default** button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

**3.7.6 Edit barcode dialog box**

This dialog box is displayed when you click the **Define** button on the **Barcode** dialog box. On this dialog box you specify the type of barcode you want to use on the label and all additional advanced setting: how the barcode should be generated, if check digit should be automatically calculated or not, and various other options. The preview of a resulting barcode is displayed on the right side of the dialog box, if **Enable preview** check box is checked.

When you are satisfied with barcode's properties, confirm the changes you made by clicking the **OK** button or reject
them and keep previous settings by clicking **Cancel** button.

**Edit barcode** dialog box has several pages (tabs):

**General tab**

On this tab you can select basic options for the barcode. For each barcode type you can choose some or all of the following options:

![Edit Barcode dialog box – General tab](image)

**Type of barcode**

The required barcode symbology is selected from the tree list of *Available barcodes*. The following barcode symbologies are supported:

**EAN and UPC**

- EAN-8, EAN-8 + 2-digit supplement,
- EAN-8 + 5-digit supplement, EAN-13, EAN-13 + 2-digit supplement,
- EAN-13 + 5-digit supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 2-digit supplement,
- UPC-A + 5-digit supplement, UPC-E, UPC-E + 2-digit supplement, UPC-E + 5-digit supplement, UPC E(1),
- EAN.UCC 128, SSCC, Bookland, Addon 2, Addon 5

**Linear**

- Interleaved 2 of 5, ITF 14, ITF 16,
128 (A, B and C subsets), MSI, Codabar, Postnet-32, Postnet-37, Postnet-52, Postnet-62, Kix, Pharmacode, Plessy, Anker

**RSS**

**Linear RSS symbologies**
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded

**Composite RSS symbologies**
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, EAN-8, EAN-13, EAN.UCC 128 & CC-A/B, EAN.UCC 128 & CC-C

**two-dimensional**
2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, MicroQR, QR, Codablock F, MicroPDF, InfoGlyph

Two-dimensional barcode can usually be defined with any contents, they are not limited to digits and letters. There is also enhanced security issues, you can set your own security factor and thus redundancy in the 2D barcode. It is readable even if larger part of the code is missing due to transport damage, weather conditions etc.

**Symbol height**
The height dimension of a barcode can be specified either by entering a value here or by resizing the barcode symbol directly on the label.

**X-Expansion factor**
The expansion factor defines the width of the barcode symbol.

Because the dimension of the narrowest bar and the narrowest space in a barcode symbol is fixed in most barcode symbology standards, it is only possible to change it by pre-determined fixed-number steps. This can changed either from the pull-down list, or by resizing the barcode element directly on the label.
When you are dragging border of the barcode on the label, its size will change in steps, dimensions will jump from one setting to another. This is normal due to the previously mentioned width of the narrowest bar. This may cause that the symbol will not fit into the space you have allocated for it. You must then reduce it to the next suitable, smaller expansion step.

Note, that the possible barcode sizes greatly depend on the printer used on the label, more specifically its resolution. Thermal printer with 300 dpi can print the same barcode in more different sizes than the printer with 200 dpi.

**Narrow to wide bar ratio**

This ratio is a set according to standards. For most barcodes you can not change it, but for same you can. Then simply select the appropriate ratio from the combo box.

**Base element width**

Shows the width of a base element of a barcode (the narrowest) according to the above settings in mils (1/1000 of an inch).

**Print barcode as graphics**

On thermo transfer printers barcodes are printed using internal printer commands and not by printing graphics representations of barcode symbols. This can drastically increase printing speed, because less data needs to be transferred to the printer. Compare a 30 bytes internal printer command for barcode printing with typically 8000 bytes for a picture of the barcode. However, internal barcode printing can lead to some limitations. NiceLabel is able to print mirrored barcodes, but majority of thermo transfer printers are not. If you want to print mirrored barcode on such a printer, you must select *Print barcode as graphics*. The same goes if you want to use custom Contents mask when they are not internally supported in the printers.

If you are using other Windows printers, barcodes are printed as graphics anyway, so this option is always checked and cannot be disabled.
**Check digit tab**

This tab is used to specify if you want to use the check digit in the bar code or not. This option can only be modified for the bar codes that allow you to enable and disable the check digit. Not all bar code symbologies allow you to do it.

Some barcode standards include the check-digit by the definition and it cannot be omitted. An example of such barcodes are EAN and UPC barcodes, where check digit cannot be disabled at all. But some codes allow you to freely enable/disable check-digit. You can use *Include check-digit* for such barcodes.

![Edit Barcode dialog box – Check digit tab](image)

You can choose whether you want to input the check digit value, or let the program calculate it for you:

*Auto CD generation*: program calculates the check digit. You must only enter the first digits. For example: when using EAN-13 barcode input the first 12 digits, check digit will be calculated and added automatically.

*Verify*: use this command when you want to enter the value for the check-digit. You must enter it as the last number (character). At print time it will be verified for correctness and if it is not valid, you will be informed about it.

*Custom check-digit algorithm* option lets you set some other algorithm you want to use for your barcode value.
With the button **Select** you can define and select some other algorithm for verifying the check digit.

**Human readable tab**

On this tab you can set the options regarding position and outlook of the barcode data interpretation. When **Below the barcode** is selected, all data encoded in the barcode is presented beneath the barcode symbol as human readable characters. **Above barcode** will put the interpretation to the top of the barcode. **None** will disable interpretation entirely.

This custom interpretation is printed using a selected font, only if the barcode is printed as graphics. Using the **Font** button, you can choose the suitable font for auto-translation text. The option **Auto font scaling** will adjust the font of the auto translation text to the size of the barcode.

If the barcode is not printed as graphics, custom font settings are not possible as printer itself takes control over barcode's and interpretation's outlook. Internal printer fonts are used in this case.

All operations of the barcode (rotation, expansion, and position) affect both the barcode and its auto translation text.

**Contents mask** sets the custom format of the human interpretation. For more information please refer to the Barcode tab in Barcode dialog box, where its functionality is explained.
Details tab

On this tab you can define advanced settings for the barcode. Note that not all of these options are available for all barcodes and printers.

Include quiet zones: By checking this field you set, that the barcode will have some white space in the front and in the end for increased readability.

Descender bars: Some bars of a barcode will be longer than others. This is typically used with EAN and UPC barcodes that have longer bars in the begging, in the middle and in the end of the barcode.

Mirror: The barcode can be mirrored vertically and horizontally. Barcode will usually have to be printed as graphics for this option to be accessible.

Intercharacter gap: some barcodes allow you to change the gap between characters in the barcode (e.g. Code-39). Barcode will have to be printed as graphic not as internal printer element.

Include EAN white space: Before and/or after the barcode a special character is inserted, < or >. It indicates the width of the barcode. If you put any other object in the extent of the barcode, it will reduce the readability of the barcode. This option is only valid for EAN barcodes.
3.7.7 EAN.UCC 128 Wizard

This wizard allows you to easily define new EAN.UCC 128 data structure. This kind of barcode has different areas of application that include trade items, logistic units, assets and locations. The EAN.UCC 128 Symbology is a variant of Code 128 Symbology. Its use is exclusively licensed to EAN International and UCC. This is the only EAN.UCC endorsed symbology that allows the encoding of information in addition to identification.

The EAN.UCC 128 Symbol is an extremely flexible symbology. It allows representation of data of variable length, and makes it possible to encode several pieces of information in one bar code symbol. This is called concatenation. An Application Identifier is the field of two or more characters at the beginning of an Element String. AIs are prefixes that uniquely identify the meaning and the format of the data field following the AI.

The data following the AI may comprise alphabetic and/or numeric characters, of any length up to thirty characters. The data fields are either of fixed or variable length, depending on the AI.

The EAN.UCC 128 Wizard will guide you step-by-step to easily create your required barcode.

The general information for using the Wizard are: click Next button to advance to next screen, when the selection you made on current screen is appropriate. Back button will return you one step back.
Step 1: Choosing the application identifier

**EAN.UCC 128 Wizard: Choosing application identifier**

The dialog in the first step of Wizard allows you to select the EAN.UCC 128 barcode data structure. Each barcode is composed out of one or more Application Identifiers (AI) and their data.

Choose one of the Application Identifiers in this list. You can add, edit or delete Application Identifiers from the barcode later in the process.
If you have selected the Application Identifier which data includes a check digit (for example, AI (01) - GTIN, Global Trade Item Number), then first you will have to select how the check digit will be applied. The possible options are:

- **Automatic calculation**: Choose this option and check digit will be calculated by the labeling application.

- **Check digit to be entered with data**: Choose this option to manually enter the check digit with data. You will have to make sure that entered check digit is really correctly calculated or the error will occur.
Step 2: Application Identifier Input Type

When the Application Identifier is selected, you will have to define where is the data for its value obtained from. There are three possible options:

- **Fixed**: Choose this option to define a fixed value for this Application Identifier, the value will be the same at all times.

- **New variable**: Choose this option to define a variable value for this Application Identifier. A new variable will be defined that will be a source of AI’s data.

- **Use existing variable**: Choose this option to use an existing variable with the selected AI. Its format should correspond to AI’s requirements (field type, length etc.)

Step 3: Entering the value for the Application Identifier

**Fixed value for the Application Identifier**
Chapter 3: Reference

NiceLabel Pro User's Manual 3-85

EAN.UCC 128 Wizard: Fixed value for the Application Identifier

If you have selected fixed value in the previous dialog box, you should enter value for the Application Identifier here. The Wizard will let you know about the required data format for this AI and how long the AI value should be. For some AIs the field length is fixed to a certain number of digits, for others only the maximum number of possible digits is stated. You will also be reminded of the AI’s proper field format (numeric, alphanumeric) if you enter incorrect data.

Variable value for the Application Identifier
If you have selected a new variable value in the previous dialog box, a new variable field will be created. You will have to provide some information about the variable being used.

**Step 4: List of selected application identifiers**

In this step, you can select the application identifiers that will be encoded in the barcode. You can add, edit, or delete identifiers as needed. The selected application identifiers are displayed in the list box.

Input Application Identifier separator:

**Left:** [ ]  **Right:** [ ]

Preview: 010302030405060708091011121314151617181920

**EAN.UCC 128 Wizard: List of selected application identifiers**
This is the last step of the EAN.UCC 128 Wizard. Here you can add, edit or delete Application Identifiers and define separator among them.

- **Application Identifiers selected**: In this field all selected Application Identifier for the barcode are listed in the order of creation. You can change the order of Application Identifiers by selecting some and then clicking up and down arrows.

- **Add, Edit or Delete** buttons: Use these buttons to add additional Application Identifiers and edit or delete existing ones.

- **Input Application identifier separator**: Here you can define left and right separator among different Application Identifiers. The default setting is to use round parenthesis.

- **Preview**: A sample barcode content based on your AIs is shown here.

Click **Finish** button to exit the Wizard.

### 3.7.8 Graphics

You can place graphics on the label with command **Graphics** on the **Object** menu. This command opens the dialog box **Open** to select the file name of the graphic. The following graphical formats are supported:

- BMP, DIB, RLE: Windows Bitmap
- GIF: CompuServe Bitmap
- JPG, JPEG, JPE: JPEG Bitmap
- TIFF, TIF, FAX, G3N, G3F: TIFF Bitmap
- PNG: Portable Network Graphics
- WMF: Windows Metafile
- EMF: Enhanced Windows Metafile
- ICO: Windows Icon
- CUR: Windows Cursor
- TGA, TARGA, VDA, ICB, VST, Targa Bitmap
PIX
PXM, PPM, Portable Pixmap, GreyMap, BitMap
PGM, PBM
JP2 JPEG2000
J2K, JPC JPEG2000 Code Stream
PCX Paintbrush

The *Open Clipart Gallery* button under the picture preview will open Clipart Gallery browser. The labeling software incorporates a large library of clipart images for usage in retail, logistics, chemical, automotive and other industries. The clipart images are black and white bitmap and vector images that you can use directly on the label.

More information about these images is available in the topic Clipart Galleries on page 4-206.

Images can be various sizes. If the original size of the graphics is not valid for your label, you can freely resize the image by dragging the handles surrounding it. The image can be resized proportionally or stretched in both directions.

The graphics objects can also be placed on the label from the clipboard or imported from another applications (i.e. Corel Draw, scanning programs...), using either the *Insert Object* or *Paste* command from the *Edit* menu. In this case, the graphics is embedded in the label file. What
this means is that it is entirely stored in the label file and is not stored separately on the hard disk. However, the graphics imported this way can be saved to the file at any time.

The details about graphic objects can be reviewed or edited in the Graphics dialog box. Double-click the graphic object to display this dialog box.

**Graphics** dialog box has several pages – tabs:

**Contents tab**

Under **Contents** the information about the source of the graphics is stored. Image field can be acquired from several different sources. For more information about possible data sources please refer to the chapter explaining Contents Providers. Each Content Providers should supply a valid image name that exists on the system (typically a file path should be supplied as well) or on the memory card.

Each graphics can be kept in a label file (embedded), in the file on the hard disk (and thus linked to the label file) or accessible on the memory card. If the graphics is stored in the label, then the file name shows **Embedded**, and you can use the **Save to file** button to store the graphics from the label to the file on the disk. Otherwise, the **Save to file** button is replaced with **Embed** button.
This way the link to the file on the disk is broken and the whole graphics is embedded into the label.

Using the **Browse** button (...), you can search for the new graphics file and place it on a label.

**On memory card** lets you select graphics, which is stored on printer's memory card. In this case **Browse** button will open Memory card graphics dialog box. First the graphics will have to be transferred to the card and then information about this memory card contents will have to be imported to the application. For how to store graphics to memory card please refer to NiceMemMaster help.

If you have special memory card installed in your printer with graphics objects on it, you can select **On memory card**. This way the button **Browse** (...) will show the contents of memory card and not the contents of the hard disk drive. Choose appropriate graphic from memory card. The overall label production time can be greatly reduced using this option. There is no need to download the graphics file to printer as it is already there (on the memory card).

**Detailed tab**

![Graphics dialog box – Detailed tab](image)
On the **Detailed** tab you can select mirroring - horizontal, vertical or both, resize options and look at the graphics original size.

**Mirror** option lets you mirror the image either vertically or horizontally.

**Resize options** control the size of the picture and how will it positioned in relation to this picture bounding box. These options are only accessible when graphics' name is a result of a variable Contents Provider output. If the graphics is a fixed image, you can resize and position it directly on the label.

**Original Size** will resize the graphics back to original size and proportions. **Proportional** will resize the picture in such a way that the relations between image dimensions will be preserved. **Full (designed size)** will resize the graphics horizontally and vertically exactly to fit the picture bounding box you have defined. Graphics will probably be distorted, if using this option.

When you define graphics as an variable element, the application can not know the size of the picture in advance, because this information will be provided at print or preview time. That is why, there will be a picture-box on the screen, containing a large question mark. The graphics value is not known at this time.

**Original size** section shows the original size of the graphics. If you have changed the size of the graphics on the screen, you can always use button **1:1** to set it back to its original size. This original size is calculated based on image pixel dimensions and resolution of the target printer. Original size values might vary from one type of printer to another because of the different printer resolutions. For example, typical thermal transfer printer has resolution of 200 or 300 dpi, while laser printers begin with 600 dpi.

**Appearance and Status tab**

Appearance and Status tabs are both similar to those used with text dialog box. Please refer to the **Text** command for further information about Appearance and Status tabs.
**Set default**

The **Set default** button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

**Memory card graphics dialog box**

This dialog box displays all graphics that are saved on printer's memory card. To be able to use graphics elements stored on the memory card, they will first have to be transferred to the card. Use NiceMemMaster for this task. It will create a .MMF (NiceMemMaster File) description file, containing the index of memory card contents. This index file is used for information what is in the memory card.

For connecting .MMF index file to the label you will have to open printer properties dialog box (Printer Settings in File menu), open Printer Memory tab, change Slot type to **Memory Card** and select appropriate index MMF file. Now the application is aware of the memory card's contents.

### 3.7.9 Rectangle

By selecting the **Rectangle** icon in the **Toolbox**, or by selecting the **Rectangle** command in the **Object** menu you can draw frames on the label. Either way, the result is the same, the rectangle cursor appears.
First click the position on the label, where you want the upper-left position of the rectangle to be set, then drag to bottom-right direction until the rectangle size is as requested. The other method of positioning the rectangle on the label is simply selecting the Rectangle tool and then clicking the label. A default-sized rectangle will appear and you can resize it using handles around the rectangle.

To move a rectangle to a different position simply select it and drag it elsewhere on the label.

If you want to draw a square, grab a handle a on one of the rectangle corners, simultaneously press and hold Shift key, then resize the rectangle. A square will be drawn. For more useful shortcuts available in the software refer to the chapter on page 3-2.

Should you later want to edit the rectangle element, first select it then double-click it. The **Rectangle** dialog box appear.

This dialog box has several tabs:

**General tab**

In the General tab you can set line and fill style, rectangle line thickness, rounded corner settings and line and fill colors.
**Print as Graphics** option will let you print the element as internal printer element, or as generated graphics element. Printing will be faster if you do not tick this option. However if you have selected some line or fill style and rounded rectangle option that your printer does not natively support, the printing will be auto-set to "print as graphics" and you will not be able to disable it.

**Line Style** of the rectangle border can be either None, Solid or Clear. **None** will disable rectangle's border. **Solid** will color the border in the selected Line Color. **Clear** style will cause the border to erase underlying elements. Line with White color might be the same as Clear style but it is really up to your label printer how it interprets such elements. If you want to erase underlying elements, always select Clear style.

**Fill Style** defines how the rectangle area is handled. The default setting is **None**, meaning rectangle will be without any fill. The elements in the back of this rectangle are visible thru it. You can fill the rectangle with different patterns in selected color. Apart from classic patterns (solid, diagonal, vertical and horizontal lines, cross and percentage of the color) there is a special one. **Clear** style will erase all underlying elements. Clear style might look like a Solid style in white color, but there is a difference with thermal/transfer printers. Not all such printers apply the white color as an erase color. Some might but other will treat it as the element does not have any fill. That is why you should use Clear style with such label printers to erase underlying elements.

**Thickness** defines the width of the rectangle borders. It can be set separately for horizontal and vertical lines. The valid values for thickness depend greatly on the printer being used on the label. Not all values are acceptable for all printers.

**Rounded Rectangle** is the option that lets you define rounded corners of the rectangle. In this case the Thickness option will be replaced with **Dimensions** and you will be able to select thickness and radius for the selected element. Rounded rectangle can only have one thickness setting that will be applied to the vertical and horizontal borders.
If you would like to change the line color of the current element, click **Line Color** button. If you would like to change the fill color of the current element, click **Fill Color** button. The selected color will be previewed in the square next to the buttons.

Note: Text will be printed in color only on printers that support color printing. These are mostly inkjet and color laser printers (i.e. Epson Stylus Color, HP DeskJet...).

**Appearance tab**

In the Appearance tab you can change the position and size of the element, and select its rotation.

**Aspect Ratio** option will lock the ratio of the element. When you change the height, width is automatically adjusted so that the element is not distorted and vice-versa.

**Position and Size** of the element can be simply changed here by entering the new values in the relevant fields. The origin of the coordinate system on the label is upper left corner of the label. This dialog box should be used for fine-tuning the placement and dimensions of the element. Another method of fine-tuning is using Label Inspector functionality.

You can also change the position and size of the element by dragging it or its handles directly on the label.

**Rotation** of the element can be set in steps by 90°.

**Status tab**

This tab is exactly the same as the **Status** tab of the **Text** dialog box. Please see **Text** command on page 3-59 for tab description.

**Set default**

The **Set default** button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

### 3.7.10 Line

Lines can be added to a label by clicking the **Line** icon in the Toolbox or by selecting the **Line** option from Object menu.
You have to define the line starting point by clicking the mouse at the start position, then moving the cursor to the end point, while holding down the mouse button. A line will be drawn from the left to right side of the label. If you need to draw a vertical line, just click for starting point then drag the cursor in the up-down direction.

The rotation of the line element can be changed at any time in the line dialog box, using shortcut Ctrl+T or using Label Inspector.

To set line properties, first select it, then double click it to open Line dialog box.

**General tab**

*Print as Graphics* option will let you print the element as internal printer element, or as generated graphics element. Printing will be faster if you do not tick this option. However if you have selected line style that your printer does not natively support, the printing will be auto-set to "print as graphics" and you will not be able to disable it.

*Line Style* of the can be either set to Solid or Clear. *Solid* will color the border in the selected Line Colour. *Clear* style will cause the line to erase underlying elements. Line with White color might be the same as Clear style but it is really up to your label printer how it interprets such elements. If you want to erase underlying elements, always select Clear style.

*Dimensions* defines the length and thickness of the line.

If you would like to change the line color, click *Line Color* button. The selected color will be previewed in the square next to the buttons.

Note: Line will be printed in color only on printers that support color printing. These are mostly inkjet and color laser printers (i.e. Epson Stylus Color, HP DeskJet...).

**Appearance tab**

This tab is exactly the same as the *Appearance* tab of the *Rectangle* dialog box. Please see *Rectangle* command on page 3-92 for tab description.
Status tab

This tab is exactly the same as the Status tab of the Text dialog box. Please see Text command on page 3-59 for tab description.

Set default

The Set default button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

3.7.11 Ellipse

By selecting the Ellipse icon in the Toolbox, or by selecting the Ellipse command in the Object menu you can draw ellipses and circles on the label. Either way, the result is the same, the ellipse cursor appears.

First click the position on the label, where you want the upper-left position of the ellipse to be set, then drag to bottom-right direction until the ellipse size is as requested. The other method of positioning the ellipse on the label is simply selecting the Ellipse tool and then clicking the label. A default-sized ellipse will appear and you can resize it using handles around the rectangle.

To move a ellipse to a different position simply select it and drag it elsewhere on the label.

If you want to draw a circle, grab a handle a on one of the ellipse corners, simultaneously press and hold Shift key, then resize the ellipse. A circle will be drawn. For more useful shortcuts available in the software refer to the chapter on page 3-2.

Should you later want to edit the ellipse element, first select it then double-click it. The Ellipse dialog box appear.

This dialog box has several tabs:

General tab

In the General tab you can set line and fill style and ellipse line thickness.
Print as Graphics option will let you print the element as internal printer element, or as generated graphics element. Printing will be faster if you do not tick this option. However if you have selected some line or fill style options that your printer does not natively support, the printing will be auto-set to "print as graphics" and you will not be able to disable it.

Line Style of the ellipse border can be either None, Solid or Clear. None will disable ellipse's border. Solid will color the border in the selected Line Colour. Clear style will cause the border to erase underlying elements. Line with White color might be the same as Clear style but it is really up to your label printer how it interprets such elements. If you want to erase underlying elements, always select Clear style.

Fill Style defines how the ellipse area is handled. The default setting is None, meaning ellipse will be without any fill. The elements in the back of this ellipse are visible thru it. You can fill the ellipse with different patterns in selected color. Apart from classic patterns (solid, diagonal, vertical and horizontal lines, cross and percentage of the color) there is a special one. Clear style will erase all underlying elements. Clear style might look like a Solid style in white color, but there is a difference.
with thermal/transfer printers. Not all such printers apply the white color as an erase color. Some might but other will treat it as the element does not have any fill. That is why you should use Clear style with such label printers to erase underlying elements.

**Thickness** defines the width of the ellipse borders. The valid values for thickness depend greatly on the printer being used on the label. Not all values are acceptable for all printers.

If you would like to change the line color of the current element, click **Line Color** button. If you would like to change the fill color of the current element, click **Fill Color** button. The selected color will be previewed in the square next to the buttons.

Note: Text will be printed in color only on printers that support color printing. These are mostly inkjet and color laser printers (i.e. Epson Stylus Color, HP DeskJet...).

**Appearance tab**

This tab is exactly the same as the **Appearance** tab of the **Rectangle** dialog box. Please see **Rectangle** command on page 3-92 for tab description.

**Status tab**

This tab is exactly the same as the **Status** tab of the **Text** dialog box. Please see **Text** command on page 3-59 for tab description.

**Set default**

The **Set default** button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

**3.7.12 Inverse**

**Inverse** command creates a black box that produces the inverse image of all elements that are overlapped by the box.

You can select the **Inverse** command from the **Object** menu or from the **Toolbox**, and point the cursor to the left upper corner of the inverted image.
You can change the size and the position of the inverted box by dragging the inverse box on the screen, by double clicking the inverse box object and entering the relevant data on the General tab or by setting properties in Label Inspector.

**General tab**

*Position and Size:* of the inverse element can be simply changed here by entering the new values in the relevant fields. The origin of the coordinate system on the label is upper left corner of the label. This dialog box should be used for fine-tuning the placement and dimensions of the element. Another method of fine-tuning is using functionality of Label Inspector.

You can also change the position and size of a element by dragging it or its handles directly on the label.

*Rotation* of the element can be set in steps by $90^\circ$.

*Clear Surface* option will erase all underlying elements. It is similar to Clear option for rectangle fill style but is printed as internal printer command and not graphics element.

**Status tab**

This tab is exactly the same as the **Status** tab of the Text dialog box. Please see Text command on page 3-59 for tab description.

**Set default**

The **Set default** button saves the defined properties of the object and uses them in the future as a default parameters for new objects.

### 3.8 Data

#### 3.8.1 Dynamic data overview

You may want to print labels on which data changes for each label, for example, counters, serial numbers, date and time, weight, article pictures... To accommodate the changing data, the labeling application can easily be used
to format labels using variable data, special functions on variables, and databases.

There are several types of variables you can choose, and functions, which you define, to best suit your needs. Data that must be printed as a variable is prepared at the time of printing, and can be entered in the program from different sources i.e. keyboard, databases, system clock, etc. The variable data can be the same for a quantity of labels or/and specific for one label only.

To understand how variable data is handled, a few terms must be explained: variables, functions and database access.

Variables

Variables in this labeling application are much like ordinary variables; they simply don't have constant value. The basic idea of variables was to allow you to type the variable value just before printing the label, but this has expanded a lot. You can now automatically get correct value from a database or perform a calculation on existing variables and take the result as a variable value.

A variable also has several properties: its name, type (text, numeric, date…), maximal length of value in characters and many more. One other important, but fixed property is the input for specific variable (keyboard, database, function, system clock…).

Functions

Functions are very powerful tool, which offers almost unlimited possibilities to the user, when processing data for the label. The function takes some variables as input, make some processing on the data, and return the result in one or more variables that contain new values. Complexity of function varies from simple concatenating of two variables to very complex manipulation of external data.

For example, you can use functions to concatenate two strings of data to one if they are separate in database like FIRST_NAME+LAST_NAME. You can also do numeric
calculations on variables. That way you can for example have the weight on a label displayed in pounds, although the weight in database is in kilograms. Using the built-in Visual Basic scripting you can add any functionality to the labeling software you can possibly need.

**Database access**

If you have existing database on your computer (or network) you can use that database to print labels. Simply create a special database function that gives you variables you can use to access the specific records in your database. That way you can completely automate the process of printing the labels for your product.

For example, as new products are created, you fill a special table with serial numbers of those products. The application then uses this table as source to print appropriate labels.

### 3.8.2 Contents Providers

**Contents Provider** is an expression for any method that can be used as an source of data for elements on the label. It is applicable to all label elements that can have some sort of data associated with them (Text, Paragraph, RTF, Bar Code and Graphics).

The contents provider for elements can be one of the following:

**Fixed** When you select *Fixed*, you can enter a desired value in the edit box. This value will remain the same on each label. To edit the text, all standard Windows editing features (cut, copy, and paste) can be used. If you need to enter some special character, that is not accessible via keyboard, click the button with the arrow to the right of the dialog box. You can also right-click anywhere in the edit box and select "Insert special character" from the menu.

**Variable** When the *Variable* option is selected, you can connect any variable field to the
element, just select the appropriate variable name from the list. This approach will allow you to change the element's value on the labels.

Element is connected to some variable. The variable is defined on the label. Its type can be Keyboard Input, Counter, Date/Time field etc. When variable's value changes, the change will be reflected in the appearance of the selected element.

If no variable is defined on the label, you should first create one. Click Wizard button to start Variable Wizard, that will guide you thru the steps of creating the variable. Variable field will be created very easily, but cannot be used for setting of all the options. For advanced variable setup click New button. Edit button will let you change properties of selected existing variable. You will find more information about variables in the chapter Variables on page 3-107.

Functions When this type of contents provider is selected, you can select the proper function from the list of defined functions and then also the output function-generate variable. This variable will be the source of data for the element.

Click New to create new function. Click Edit to change function's properties.

Database When this type of contents provider is selected, you can select the proper database from the list of defined database connections. Then select the proper field from this database. This field will be the source of data for the element.

Click New to create connection to new
database (click *Wizard* to use the wizard for the connection). Click *Edit* to change function's properties.

**Expression**

Expression is a simplified version of Visual Basic Script. Expression can be used in situations when you want to manipulate existing variables, extract some substring or perform a quick calculation and you do not want to write a dedicated Visual Basic script. For this purpose Expression will do just fine. You can enter one-line expression in the edit field that will be validated at print-time. Of course all Visual Basic scripting commands can be used in here.

**Visual Basic Script**

An entire Microsoft Visual Basic Script functionality can be included on the element. Each element can have assigned its own programming script for advanced functionality.

*Visual Basic Script* option will allow you to use a complete implementation of Visual Basic programming scripting, provided by Microsoft Corporation. This makes it possible to perform advanced data manipulations, comparisons and calculations directly on the label. If you are not familiar with Visual Basic scripting, a comprehensive help system is accompanying the labeling application. To access it, click the VB Script Help file. Once your script is written, it will be checked for consistency and syntax errors and you will be notified of the exact positions of any possible error for easier problem solving. There is one thing you have to pay special attention to: your script has to define an output variable Result. It will be used for actual value setting. For more complex scripts click the *Build script* button to edit your code in...
Expression Builder.

**Link To File**  
The value for the label element is acquired from the specified text file in this case. The contents of the file is used for the element.

You can link the element to some fixed filename on the disk. Or you can use variable filenames. To achieve that connect the element to the variable containing the path and filename of the file.

**Lookup Table**  
Lookup Table is a facility for the user to simplify working with data tables. Although the software can interact to any database, sometimes there is a need only for one quick simple table that stores your data. Lookup Table provides a shortcut to database usage.

Lookup Table is used when you want to use a data from a simple database on your label. You can use some external databases as data source for all variable fields. But Lookup Table greatly simplifies this task. It is in fact a table stored within the label file. Built-in database editor can be used to manage the data records. Every Lookup table can have a **Key (Primary)** and **Secondary Key** that are used for actual data query. Using these keys you can make a query into the table and extract only fields that comply to the condition. Both keys can be either fixed or get a value from some variable. When the record from the table is found based on information from one or both keys, the value of the database field selected in **Output fields** is returned as the element's contents. The element on the label now has its value from the database. The button **Configure tables** will let you manage your Lookup
### Tables.

<table>
<thead>
<tr>
<th>FACT</th>
<th>FACT is used when you want to encode the data using this standard for Data Identifiers (DI). It is much like EAN.UCC 128 standard and its Application Identifiers (AI).</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIBC</td>
<td>There is the ability to encode data in the element using HIBC standard.</td>
</tr>
<tr>
<td>Rich Text Editor</td>
<td>This contents provider is available only for RTF element. It provides you with the RTF editor, where you can define the fixed or variable contents for the element.</td>
</tr>
<tr>
<td>Structured RSS bar code</td>
<td>This contents provider is available only when using RSS type of bar code. It provides you with the functionality to provide linear and composite (if applicable) data to the bar code.</td>
</tr>
<tr>
<td>RFID Unique Tag ID</td>
<td>This contents provider is available for text and bar code elements. It is available when you have RFID-aware printer driver connected to the label and it can acquire the Unique Tag ID from the RFID tag embedded in the label. This provider allows you to use such ID with the element that is printed on the label. The printer will read the Unique Tag ID (that is programmed during the tag manufacturing process in the factory and cannot be changed), remember the value and the assign it to text or bar code element. Since this data is never returned to labeling software, but is handled internally in the printer, the data you enter for this contents provider is used on the screen for preview purposes only. RF Tag selection in this contents provider is available when you haven't</td>
</tr>
</tbody>
</table>
set any property in RF Tag dialog box. Otherwise the selection is dimmed and can be changed in the options accessible in the Advanced button.

### 3.8.3 Variables

With Variables command you manage variables you want to use on the label. You can do this by clicking appropriate buttons on the Variables dialog box.

![Variables dialog box](image)

In the dialog box a list of all defined variables is displayed along with their current values.

Each type of variable has its own icon:

- **System Date/Time variable**
- **Printer Date/Time variable**
- **Counter variable**
- **Counter variable with enabled Dynamic Value**
- **Prompt variable**
- **Prompt variable with enabled Dynamic Value**
- **Global variable**
- **Database variable**
Function-generated variable

Internal variable

Locked variable

All stated variables are user-defined except internal variables. Their values are automatically filled by the software. If you want to display the list of internal variables, tick the option **Show internal variables**. All internal variables will be shown in the list. Note the tick square in front of internal variables names. Whichever variable you want to use on the label, it has to be enabled first, just tick it. By default, the variables are not available on the label, so they do not unnecessarily occupy the space in variable list. Only the selected internal variables can be used on the label. Unselected variables are not available in the software.

Once you have the variables created, they can be edited, deleted and copied. Use the buttons next to the list of variables for these tasks.

Another method of changing and editing variables is right-clicking the text object, to which variable is linked and selecting **Edit variable...** in menu.

When you want to define the first variable, the list of variables is empty. Click **New** button or press <INSERT> key in **Variables** dialog box to define the variable. **Variable** dialog box is shown.

To define a variable, all the parameters must be entered in the **Variable** dialog box, and confirmed by clicking **OK** button.

Dialog box has several pages – tabs. Each tab is described separately in the continuation.

If you click the **Wizard** button, a new variable is created using **Variable wizard** that simplifies the process of variable creation. You can't however set all variable options in wizard.

In **Variables** dialog box you can use button 1,2,3,… to specify the order in which the variable values must be entered before printing. A dialog box is displayed, and you can move variable names up and down in the list.
Values for variables higher in the list will be entered before those lower in the list.

**Internal variables**

Internal variables are filled automatically by the software and you do not have any influence on them. They cannot be edited and modified, but only used in the functions and on the label. Their value is updated for every printed label.

Internal variables are represented with the 📊 icon so they can be easily distinguished from the other types of variables.

The list of available internal variables:

- **ComputerName**: Contains the information about the computer name of a PC computer where labels are processed, as specified from Windows system.

- **CurrentBatchQuantity**: Contains information about the label quantity reached in the current label batch.
  
  The value is reset at beginning at each batch in the printing process.

- **DefaultPrinterName**: Contains the name of the default printer on the system.

- **LabelFileName**: Contains full name of the current label, including the path to the file.

- **LabelPrinterName**: Contains the name of the printer that is used on the label.

- **RequestedQuantity**: Contains the quantity of the labels as specified by the user or external application (NiceForm, NiceWatch...).

- **ShortLabelName**: Contains the name of the label without the path. Only filename with the extension LBL is available.
**SystemUserName**  
Contains the name of the system Windows user that is logged in and is running the application.

**TotalQuantityPrinted**  
Contains the quantity of all unique labels printed. Label copies are not included in this variable, only the number of different labels is.

**UserName**  
Contains the name of the NiceLabel user that is logged in and is using the application. This variable has some value only when you have enabled user management in the software.

### General tab

**Variable** dialog box – General tab

**Name** and **Description**

Here you enter the name of the variable. Minimum length of the name is one character and maximum length is 12 characters. Generally, you should give the variables
meaningful names (like "DATE-VAR" for the date stamp instead of "VAR001"). This will help you find the correct variable later when you design new labels, or edit the old ones.

You can also enter a longer description of the variable. This option is very useful when you have many defined variables, as they can be difficult to distinguish only by a basic name.

**Length**

The length of the variable data must be more than '0'. When all the variable data to be used is of the same length the **Fixed** option should be selected, for example, when a EAN 13 code is specified as a variable.

The variable can be also longer than one line - you can define it as multi-line and set the line length and word wrapping. Word wrapping means that the line wraps only at the end of the word, independent from the parameters of the variable.

The parameter **Multiline** is only allowed for the variables, that have **All** format.

**Input Type**

Input type defines the source of the data for the variable. You can select from the following variables input types:

**Prompt**

Use this input type when you want the operator to enter a starting value of the variable from the keyboard before printing the specified numbers of labels.

**System clock**

Value for the date or time variable will come from the computer's internal clock.

**Printer clock**

Value for the time and date variable taken from the printer's internal clock. This option is printer dependant and only available if the current printer connected on the label has built-in support for printer clock.

If you are sure that your printer model supports printer clock, but the option is
still not available here, try to update NiceDrivers you have currently installed. NiceDrivers are in constant process of enhancement and new release might already have this functionality.

**Global**

Variable is used on more than one label and it always remembers the last value. This is especially useful if you need to have the same variable on several different labels (for example: Serial number).

More of this type of variables can be found in chapter Global variable on page 4-203.

**Format**

The format of a variable is selectable to filter the input data. This helps avoiding mistakes when entering data. You can only enter characters, which are included in the specified format range.

**All**

Select this format when there is no need to limit the variable data. For example: one variable can be used to define changes in the bar code, the text and the graphics. You can enter all characters from the keyboard.

**Numeric**

Use this format you need numeric variables, for example, serial numbers or EAN and UPC barcode. Only numeric characters in the range 0 to 9 can be entered.

**Alphanumeric**

Use this format when numbers and characters are mixed in the same variable - for example, identity codes... Characters from 0 to 9, a to z and A to Z can be entered.

**Letters**

Use this format when you need the character variable.
### 7-bit ASCII format
The variable will contain only characters with ASCII code from 0 to 127.

### Hex
Use this format to allow input of hexadecimal numbers.

### Date
Use this format to print date stamp.

### Time
Use this format to print time stamp.

### Digits and Capitals
Use this format to limit the usage only to digits and capitals of English alphabet.

### CUSTOM
You can define your own data format. The allowable characters can be defined in the Serialization tab.

### &lt;printer family name&gt; FORMAT
Use this formats do enable usage only of characters that are allowed in the internal fonts of the currently selected printer.

Use this formats to enable usage only of characters that are allowed by these bar codes standards.

---

### Treat as variable quantity
The value of the variable can also define the quantity of labels to be printed. The label can contain only one variable of this type.

You can set the quantity of the printing labels between printing with the variable quantity.

Here is an example:

You are printing the labels. The data item is name. Define the variable, which represents the name and has the input type Prompt. On the Prompt page type the appropriate prompt (such as "Enter item name"). Now you have to define the second variable, that represents the quantity. Its format has to be Number. When you start printing you will be prompted for the name of the item and the
quantity. When you enter the data, the entered quantity of the first item will be printed.

**Detailed tab**

Under *Detailed*, more information about the variable can be defined.

![Variable dialog box – Detailed tab](image)

**Justification**

When the maximum length of the variable is set, you can define the character justification. By clicking the drop-down list button, the justification options are shown - *none, right, left, center*. Each of the options justifies the selected variable (text, number, picture or barcode) to the specified position of the field.

**Pad Character**

Pad characters are used to fill the empty space before the variable. When the length of the variable data is less than the place reserved, i.e. the length of the variable, the specified pad characters are printed before the variable. Optional pad characters can be defined, for example, 0 before the number. When you reserve 5 places for the variable and the current value of the variable takes only
two places - 23 for example, '0' characters will be printed before the two numbers - 00023.

When using the **Pad character** option, the variable length must not be fixed and the justification option must be set to any option other than **None**.

**Range Checking**

Minimum and maximum limits are optional. When they are set and one of the limits is overrun, printing stops and an error message appears.

**Prefix and Suffix**

Optional. This option is used when only a part of the complete variable (barcode, text or numbers) changes and the other part is fixed. When the start of the variable is fixed, constant **Prefix** should be set. The same is for the 'constant' end of the variable - in this case **Suffix** is set.

**Serialization tab**

On this tab incrementing and decrementing options of the variable can be set.

![Variable dialog box – Serialization tab](image)

**Data format** allows you to specify the characters that can be used with the variable. All formats except **CUSTOM** are pre-defined and cannot be changed. **CUSTOM format**
is the one that can be modified to your requirements. You can define the characters you want to use in the Sequence edit field.

**Fixed value** means that the variable does not change its value.

**Increment** means that the variable will increment its value in specified step.

**Decrement** means that the variable will decrement its value in specified step.

When **Increment** or **Decrement** is selected, the **Step** has to be defined. For example, you want that a serial number variable to increment its value in steps of 1. If you want to print only one label with each serial number, you must enter "1" for the **Change value every**. If you want 3 labels to have an identical serial number, then this value must be set to "3".

If the variable is **Date** or **Time** you must insert hours, minutes and seconds (day, months and years).

When **Rollover** option is selected and the condition for it is set, the counter will start counting from the start value.

**Using min/max value**

The value is reset to minimum value specified in **Detailed** tab when maximum value is reached.

**On date change**

The value is reset to starting value when the date changes. The label keeps track of the current date in the external .DVV file that is saved in the same folder as the label.

**On variable change**

When the selected variable changes its value, it is a signal for the counter to reset its value to the starting value.

**Format tab**

Here you can define the input format and output format of the variable.
Supported format types are:

**None**
This format is used when you don’t need any special format.

**Date**
This format is used to insert the date. Input and output pictures can be set. Allowed values for input are shown in drop-down list. More on date inputting can be found in section Variable Wizard - Date Field.

**Time**
This format is used to insert the time and is similar to date inserting. More on time inputting can be found in section Variable Wizard - Time Field.

**Floating point**
This format is used to insert large numbers. This type enables you to put comma and points in the right places.

**Money**
This format lets you choose the currency unit, and put it on the correct place.

**Picklist**
This format enables you to define a list of values for the input values. Entered entries in the pick list are available to the user in the combo box that is displayed.
when the label is printed. The user can select one of the pre-defined values.

**Binary**

This format enables the insertion of a binary value on the input. The output is ASCII character.

**Prompt tab**

When the **Prompt** input type variable is selected, the **Prompt** tab appears. Data has to be entered by the operator via keyboard before, or during the printing process. For example, when you want the operator to enter the starting value of an increment, decrement or 'constant' variable, you should define the prompt as 'Enter the starting value'.

![Variable dialog box – Prompt tab](image)

The prompt can appear at the beginning of the print job (select **At start** option) or after a defined number of labels are printed (**Every x labels**). In this case, you must enter the number of labels to be printed before, or after, the prompt.

The number of labels printed before the prompt for the new value can depend also from the variable quantity
(Based on variable quantity). In this case, the value of the variable quantity defines the number of labels printed before the prompt.

The field **Value required** means that the variable must be inserted before printing.

**Default value tab**

When you use **Prompt** variable, program can help you with suggesting predefined value. You have many possibilities:

- **None** The variable will not have any default value.
- **Prompt** The program suggests you to use the default value, so you have the option to accept it or enter a different value.
- **No Prompt** The program doesn't prompt you for variable value before printing. This is useful if you want a variable to have a constant value during printing, which you can always quickly change in this dialog box. This way you don't need to make changes to every object on the label that depends on this value.

In the field **Value** you can insert the value which will be suggested to the user before printing.

If **Dynamic value** option is enabled, you can store the last used value of the current variable for next time. If you have also defined the default value, dynamic value with overwrite the default value. Dynamic values are stored in the external text files in the same folder where the label resides. The external files have the same filename as the label file, but the extension .DVV. If the variable is a counter, the stored value will be increased by the specified counter step so that additional label printing will start properly at next printing time. The label file itself does not have to be saved to store the dynamic values. If you use labels with dynamic values and exchange them with other users, make sure to exchange
not only label files (*.LBL) but also files with last used dynamic values (*.DDV).

**Load button**

Using this command, you can load the existing file (*.NVR) with the definition of one variable. This is useful if you need several variables with the same properties.

![Load variable dialog box](Image)

**Save button**

Once the variable is defined, you can save all its properties to a file for future use and later re-load it when needed.

### 3.8.4 Variable wizard

The variable wizard simplifies and speeds up the creation of the most common types of variables. You cannot however set the advanced options in variables. These can only be set in a *Variable* dialog box.
Variable Wizard - Choosing the type of variable

First you must type in the variable name and select the type of variable. You can chose among:

- **Keyboard input**: The value of the variable will be typed in before printing.
- **Counter**: The variable will automatically increment when the labels are printed.
- **Date field**: The value for the variable will be current date (optionally with offset).
- **Time field**: The value for the variable will be current time.

Generic variable name based on the type of a variable field selected will be auto-generated, but you should change it to a more descriptive name. Use the name that will clearly on first sight determine the contents of this variable.

When all data, that wizard needs are provided (you click the **Finish** button), the text with variable content will be inserted at the specified point of the label. You can later edit the text object and variable itself just as any other text and variable on the label. See **Text** command and **Variable** dialog box above for further information.
Variable Wizard - Keyboard input

Use this variable type when you want the operator to enter a value of the variable from the keyboard before printing the specified numbers of labels.

![Dialog box for Variable Wizard when Keyboard input option is chosen](image)

When you are satisfied with the settings, click the Finish button to return to the label. The variable object will now be presented on the screen as a string of question marks. The length of a string will be equal to the maximum length of the variable. When the label will be printed, the question marks will be turned to the keyboard-entered values.

**Prompt**

Fill in the message that will remind the operator to enter the data before the label will be printed.

The message will appear on the screen each time when you want to print one or a batch of several labels.

**Format**

When you want to use variable text, select All. Numeric format will only allow you to input numbers. This is useful when you want to use only variable numbers and will prevent the operator to make a mistake, when inputting the values.
Set maximum number of characters

You can define the maximum length – maximum number of characters/numbers for your variable.

The operator will not be able to enter longer value, as defined.

Variable Wizard - Counter

On this page of the variable wizard, you define the counter variable.

When all the parameters are set, click the Finish button to return to the label. The variable object will now be presented on the screen as a string of question marks. The length of a string will be equal to the Maximum number of characters of the variable. When the label will be printed, the question marks will be turned to the defined values of the variable.

Starting Value

To use the variable as a counter, the starting counting value must be set. When increment is selected, the program will increase the starting value, while it will be decreased, when decrement is selected.

Enter the starting value in the field. Note that the field will accept only numbers.
**Prompt value before print**

The starting value of the variable can also be input from the keyboard just before the label or the batch is printed. When you want to do so, you can enter the message (prompt) which will instruct the operator what has to be done.

The message will be shown on the screen each time when the label is to be printed.

**Set maximum number of digits**

You can define the maximum length – maximum number of figures for your variable.

If the variable is longer that defined maximum length the program will cut-off first left number(s) and will print only the rest.

For example, when the maximum length of a variable is 2 and you define that the variable value will increment for 1 on each label, the variable value will be set to 00 after it has reached the value 99.

**Increment or decrement**

You can define that the variable value will increase from label to label, or decrease.

**Step**

The optional step of increasing/decreasing can be set. When the step is set to 1 and the option "Increment" is on, the variable will normally count.

**Change value every label**

The value of the variable can change on every label, but it can keep the same value on several labels. When the number 1 is set, the value of the variable will be changed on each label. Should you, for example, want to print 4 labels with the same variable value, enter 4.

**Rollover when reached**

If this option is selected, then the value of variable is reset to starting value, when the number specified here is reached.
Variable Wizard - Date Field

The date variable is a variable, whose value is the current date. On this page you can define the date variable.

![Variable Wizard - Date Field](image)

When you are satisfied with the settings, click the **Finish** button to return to the label. The variable object will now be presented on the screen as a defined date field. The date will remain the same, unless the date field will be edited. Each time you double-click the date field to edit it, it will be changed automatically, of course, if the computer's date will be different from the field's date. The date will of course automatically change before printing.

**Format**

The date can be printed in various formats. In this field you define, how the date will look. You can select some of the predefined date formats or enter you own. When defining your own date formats, the following notation can be used:

- **D** The number of the day in a month. Can occupy one or two characters.
- **DD** The number of the day in a month. Always occupies two characters. (leading zeros will be added as necessary).
M  The number of the month. Can occupy one or two characters.

MM  The number of the month. Always occupies two characters.

YY  or YYYY  Display the year as 2 or 4 digits number

DDD  The abbreviation of the day of week name.

DDDD  The full day of week name.

MMMM  The full name of the month.

MMM  The abbreviation of the name of month.

J  The number of days since 1. January. Can occupy from one to three characters.

JJJ  The number of days since 1. January. Always occupies three characters.

W  The week number in current year. Can occupy one or two characters.

WW  The week number in current year. Always occupies one or two characters.

N  Displays a digit representation of the day of the week.

Any other sequence of characters will be displayed unchanged. This way you can insert dots, commas and other characters needed to properly write the date.

Examples:

<table>
<thead>
<tr>
<th>Format</th>
<th>How the date will look</th>
</tr>
</thead>
<tbody>
<tr>
<td>D/M/YYYY</td>
<td>17/4/2001</td>
</tr>
<tr>
<td>DD/MM/YY</td>
<td>17/04/01</td>
</tr>
<tr>
<td>DDDD, D. MMMM YYYY</td>
<td>Tuesday, 17. April 2001</td>
</tr>
<tr>
<td>JJJWYYYY</td>
<td>107162001</td>
</tr>
</tbody>
</table>
Date offset
You can add a certain numbers of days, months or years to a current date and print that date instead of current one. The printer will print the resultant date as shown on the Preview field. This way you can see how the selected date format will look on the label.

Variable Wizard - Time Field
The time variable is a type of variable, which value is the current time. Variable will get the value of a current computer time. On this page you can define the time variable.

Dialog box for Variable Wizard when Time field option is chosen

When you are satisfied with the settings, click the Finish button to return to the label. The variable object will now be presented on the screen as a defined time field. The time will remain the same, unless the time field will be edited. Each time you double-click the time field to edit it, it will be changed automatically. The time will of course automatically change before printing.

Format
The time can be printed in various formats. In this field you define, how the time will look. You can select some of the predefined time formats or enter you own. When
defining your own formats, the following notation can be used:

**h**  Hours in 12-hour format (AM/PM will be added if they follow the time). Can occupy one or two characters.

**hh**  Hours in 12-hour format (AM/PM will be added if they follow the time). Always occupies two characters. (leading zeros will be added as necessary).

**H**  Hours in 24-hour format. Can occupy one or two characters.

**HH**  Hours in 24-hour format. Always occupies two characters.

**mm**  Stands for minutes.

**ss**  Stands for seconds.

Examples:

<table>
<thead>
<tr>
<th>Format</th>
<th>How the time will look</th>
</tr>
</thead>
<tbody>
<tr>
<td>h:mm {AM/PM}</td>
<td>8:25PM</td>
</tr>
<tr>
<td>H:mm</td>
<td>20:25</td>
</tr>
<tr>
<td>hh:mm:ss</td>
<td>08:25:36</td>
</tr>
</tbody>
</table>

### 3.8.5 Functions

With **Function** command you manage and define functions you use. To define functions, you can choose **Data** menu and command **Functions** or click the button on **Variable tool**.
Once functions exist, you can edit them, delete or add new ones.

When you want to define the first function, the list of functions will be empty and, you must click the **New** button to define the function. The **Function** dialog box is then displayed.
This dialog box is also displayed when you want to change the existing function.

To define (change) the function all required parameters must be entered and confirmed by clicking OK button.

Dialog box has several pages – tabs. Note that only General tab is fixed, all other tabs change according to the function type you select on General tab. Each other tab is described separately for each function.

**General tab**

On this tab you enter general information about function.

*Name* and *Description*

Here you can enter the name of the function. Generally, you should give functions meaningful names. This will help you find the correct function later when you design new labels, or edit the old ones.

After entering the function name you can enter a longer description of the function. This option is very useful when you have many defined functions, as it is difficult to distinguish them only by a simple name.

*Function kind*

This field defines what kind of functions you will define. This field can be changed only, when new function is created. You can select among following functions:

- Concatenate
- Subset
- Linear Function
- EAN/UCC-128 Function
- User defined check digit algorithms
- Date addition
- Currency exchange
- SSCC Function
- Visual Basic Script
- FACT
- Transfer Syntax for High Capacity ADC Media
- HIBC
Lookup table

**Review result before printing**

This option makes it possible to change the result of a function just before using its results on the label. This can be especially useful in combination with database access function.

For example, we want to use data from database. But there is a possibility, that data read from the table, is not quite correct. If **Review result before printing** is set, data will be read from the database and then displayed on the screen. You can edit the data or just accept is, as it is.

**Concatenate function**

The "Concatenate" function joins two or more variables into a new one. On the Detailed tab source variables must be defined. You do that by selecting their names in the **Input variables** list box where all previously defined variables are listed.

The separator can be used between variables to visually divide them in a resultant variable. This can be CR/LF (Carriage Return/Line Feed) or any other character and even text string. Enter your custom separator in **Other** field. Here you can enter any character, even control characters below ASCII code 32. For inputting such characters enter hash symbol (#) followed with hexadecimal ASCII code of the character.

The new variable gets the default name (i.e. [Concatenate]), but you can change it.
The definition of the new output variable is made by clicking the Define button at the lower right corner of the dialog box. The Variable dialog box will appear.
The definition of the resultant variable is practically the same as the definition of local variables, with the exception of *Input type* field, which is predefined to value Generated and can't be changed. Here you can for example change the variable name to something more meaningful than default value.

Click **OK** when everything is as you want.

**Subset function**

*Subset* function defines which part of the input variable should be the value of output variable. When selecting this function, the following dialog box will be displayed under *Detailed* tab.

![Subset function dialog box - Detailed tab](image)

**Input variable** can be any of the previously defined variables.

First you must select, whether this is *Fixed length* of *Delimited* subset function.

**Fixed length**
If you selected *Fixed length* then with *Offset*, the number of characters you want to skip is defined, and *Length* defines the number of used characters.

**Delimited**

If you selected *Delimited* then the input variable is treated as if it contained multiple fields.

This means that the data in input variable is separated by *Separator* character. Characters between two separator characters are treated as one field. If you want to include a separator character in a data, you must enclose the whole field with the *Delimiter* characters.

You can then select which field is the result of the function with a *Field number* option.

Example:

*Separator* is set to , (comma) and *Delimiter* is " (quotation mark). *Field number* is set to 3.

<table>
<thead>
<tr>
<th>Input variable</th>
<th>Function result</th>
</tr>
</thead>
<tbody>
<tr>
<td>a,&quot;b,e&quot;,d</td>
<td>d</td>
</tr>
<tr>
<td>a,b,&quot;c,d&quot;,e</td>
<td>c,d</td>
</tr>
<tr>
<td>a,b</td>
<td>&lt;empty string&gt;</td>
</tr>
</tbody>
</table>

The definition of the new variable is made by selecting *Define* make the definition of the new variable.

**Linear function**

*Linear* function multiplies the input variable and adds a specified *Addition* to the result. In the dialog box under *Details*, the parameters must be entered.
**Multiplier** and **Addition** are numeric fields. They can have constant variable values. If you want to use variable values for these parameters, you must specify a variable for each one. The **Input** variable can be selected from the list of defined local variables. The input variable must be numeric.

**Output** variable is named automatically, but you can rename it. The definition of the output variable is the same as in previously described functions.

For a type of linear function you can choose either **Multiply** or **Divide**.

**EAN.UCC 128 function**

Your own EAN.UCC 128 barcode can be created, where you can include any character from the lower part of the ASCII table and special characters, i.e. FNC1, that can not be entered from the keyboard. To create an input format for the EAN.UCC 128 barcode, the EAN.UCC 128 function has been developed. This function takes one or more input variables, connects them to one of the standard Application Identifiers and produces two output
variables. One of output variables is used as the input for the EAN 128 barcode and the other is the human interpretation of the contents of that barcode.

**Detailed tab**

![EAN 128 function dialog box – Detailed tab](image)

The separator between data and AID - Application Identifier can be defined by entering the required separator for the left and for the right side of the Application Identifier.

You can change the parameters of output variables by clicking **Define** buttons. The procedure is the same as for previously described variables.

**Definition**

The input variables are listed in **Variables** list. Available application identifiers are listed in list **Application identifiers**. Select a variable in the list, application identifier in another list and press the **Add** button. New line will be shown in **Function contents** list. You can add as many application identifiers and variables as you want, the only limitation is the total length of 128 barcode.
User defined check digit algorithms

This function lets you create new variables, which are equipped with check digits.
You must pick an input variable, which must be a numeric value. Then select an algorithm, pressing the (upper) **Define** button. You can define new or edit existing algorithms. For details see chapter 3.8.9.

Output variable is generated. Its value will be the combination of input variable's value and the check digit. You can connect this variable to texts or barcodes.

**Date addition**

Date addition function let's you create date variables, which are calculated from input date. This function is especially convenient for computing expire dates etc.
Chapter 3: Reference

Date function dialog box – Detailed tab

Input variable must be a date variable, which will be used as a base for calculation. Then you can specify how many days, months or years must be added to the date, to compute a new date. All three values can be fixed (defined at label design time) or variable (value from other variables). They must be numeric, of course.

Output variable can be edited by pressing Define button.

Currency exchange

Currency exchange function lets you automatically convert currencies of the European Union countries to EURO and vice versa.
First you must select **Input variable**. Then specify in what currency is input variable – **Input currency**.

You can then select one or more **Output currencies** from the list below. The corresponding variable names are displayed in the right column. You can also select **Variable formatting** if you want to automatically put currency name or symbol as suffix in the output variable.

**Rounding to** option defines the number of decimal places, which the output variable has.

**SSCC**

This function is basically the same as an EAN,UCC 128 function except that number and type of application identifiers is limited to three predefined AI, that are standardized for this type of barcode.

**Visual Basic Script**

This function lets you enter your own programming script using Visual Basic Script. The edit box is used for writing down the script. Make sure that the resulting variable that
will return value from the script is named **Result**. The value from Result will then be saved to a function-generated variable. Its name can be defined in **Output variable name** edit field.

Visual Basic Script function has error checking engine built-in. Should you make an typo error when writing your script, you will be informed of the error and exactly which line of code is problematic.

Built-in text editor is useful for simple VB Scripts. But if you are designing complex scripts and need to refer to the available commands at the same, you should use Expression Builder. It is enhanced text editor with included command reference. To start it click the **Build script** button.

If you want to verify the syntax of your script, click the button **Check script**. You will be notified if there is any syntax error in the script.

For more information how to use Visual Basic script please refer to Microsoft’s VB Script Help. It is included in this distribution of the labeling software. To access it,
click the **VB Script Help** button on Detailed tab of VB Script function.

**FACT**

This function allows you to encode the FACT compliant Data Identifiers to the elements on the label. To add a new identifier to the list first select appropriate identifier, then set its value. Each data identifier can have a fixed value that you type in, or it can be connected to a variable. To connect it to a variable, tick **Variable** then select the variable from the list of variables. First choose the identifier the, Make sure the variable has the same data format as is required by data identifier. Data identifiers have usually a strict format set by the FACT standard.

One or more data identifiers are joined and saved to the variable defined in **Output variable name**. The variable can than be used on the label with label elements. There is a preview of the current data structure in the bottom of the dialog box.
Transfer Data Syntax for High Capacity ADC Media

This function allows you to encode the Transfer Syntax compliant data to the elements on the label. Each data identifier can have a fixed value that you type in, or it can be connected to a variable. Make sure the variable has the same data format as is required by data identifier. Data identifiers have usually a strict format set by the Transfer Syntax standard.

One or more data identifiers are joined and saved to the variable defined in Output variable name. The variable can than be used on the label with label elements.

HIBC

This function allows you to encode the HIBC compliant data to the elements on the label. HIBC encoding is used in medical industry. Each data identifier can have a fixed value that you type in, or it can be connected to a variable. Make sure the variable has the same data format as is required by data identifier. Data identifiers have usually a strict format set by the Transfer Syntax standard.
One or more data identifiers are joined and saved to the variable defined in **Output variable name**. The variable can than be used on the label with label elements.

**Lookup table**

Lookup Table is a facility for the user to simplify working with data tables. Although the software can interact to any database, sometimes there is a need only for one quick simple table that stores your data. Lookup Table provides a shortcut to database usage.
At least one key (index) is used to access each lookup table. It has to be connected to some label-defined variable or fixed value. The query will extract all records (lines in the database) that comply to the request. Only ticked database fields can be used on the label. Every table field must be mapped to the function-generated output variable.

### 3.8.6 Database Access

Use **Database access** command from **Data** menu to manage and define the **Database access functions**. You can do this by clicking the appropriate buttons on the **Database access** dialog box.
Once database access functions exist, you can edit them, delete or add new ones.

Database access functions are special kind of functions used to retrieve data from database. They can be used in different ways. The most common use is to just successively reads record by record from your database and use them on the label with variable fields. The second way is to define filters that will be used to retrieve just a subset of records from your database, that will comply to your conditions.

The result of the Database access function is a set of variables, one for each selected field of database table. Each database variable is named the same as the database field, but has additional prefix of a database name. This allows you to quicker identify from which database table the variable originates from. For example, if you have a field name Product in the database table DBPROD, the resulting label variable will be named DBPROD.Product.

Natively supported database files are dBase III, dBase IV, Paradox, MS Access, FoxPro, ASCII, etc. but you can use any other standard database, that supports ODBC interface. Native drivers for enterprise databases are also provided, such as Oracle, InterBase, MS SQL, Informix etc. They provide much quicker access than standard ODBC drivers. The drivers are named SQL Links and are
available on NiceLabel CD-ROM for a separate installation.

For connectivity to modern Unicode databases the OLE DB provider is available. Using this technology the Unicode values can be used on the label. These are the data values in different codepages. You can use the tables with different language settings on the same label.

When you want to define the first database access function, the list of functions will be empty and, you must click the **New** button to define the function. The **Database access function** dialog box is then displayed.

You can also use the **Wizard** button to define new database function using a special Database wizard. Note that Wizard simplifies a process of creating new database access function a lot, however not all available options can be set. You may want to use Wizard to set the most common options and then click the **Edit** button at a later time to set those advanced database options manually.

### 3.8.7 Database wizard

Process of defining a new Database access function consists of four steps (pages). On those pages you enter the data required by Wizard. You can go to the next step (page) by clicking **Next** button or return to previous with **Previous** button.

When all data needed has been entered, **Finish** button will become available, allowing you to complete the process of defining a new Database access function. Note that some options have predefined values, so you don't really need to go through all the steps of a wizard.

Each step of a wizard will now be described:
Selecting database file

Database wizard – Selecting database file

Enter the full path name of the database file in edit box or use **Browse** button to find the file on your computer.

Note that you can only select databases that are stored in files. If you use ODBC databases, you will have to set that manually in **Database** dialog box.

Selecting desired fields

Database Wizard

**Fields Selection**

Select the fields from the database you want to use on the label.

Select the fields you want to use on the label. For multiple field selection press and hold Ctrl key, then click desired fields.
Database wizard – Selecting fields

On this page you can select the fields you want to use on the label. All fields in a table are selected by default, but you will probably want to deselect some of them, especially if you have large table. Variable will be created for each selected field and can later be attached to objects.

**Selecting which records will be printed**

[Database Wizard interface]

Select the desired option how you want to use the records in the database. By default the option *I want to print all records from the table* is set and all records in a table will be printed one at a time. Each record will be printed only once.

If you do not want to print the entire database, you can select which records should be printed. In this case select the option *I want to select which record to print*. Prior printing you will be shown a dialog box with all records from the database. Then you will be able to select which records should be printed.

By default records are used once for a single label. If you would like to print several copies of a label with database data, you can define it in the second part of this step of the Wizard.
A field in table contains quantity to print option will let you chose some field in the database. This field has the information about the quantity of labels for each record. For example: You have database with records of your products. It contains a field with a numeric value, where the required number of label copies is stored. Select this field and let the application print the quantity of labels specified here.

I will enter print quantity for each record: This option is only accessible if you have defined to select which records should be printed. Prior printing you will be able to select which records will be printed in the selection dialog box. At the same time you will be able to type in the exact label copy for each selected record.

Adding the fields to the label

On this page you specify if you want the wizard to generate text objects on the label that are already linked to the corresponding fields in table. Text objects are created in upper left corner of a label, but you can later move them to another position by using Edit text dialog box.
**Finishing the process with Database Wizard**

The summary of tasks you have completed will be shown in the last step of the Wizard. If you are satisfied with your selection, click **Finish** to complete the process of creating a new database access function.

### 3.8.8 Text File Wizard

When the input database file is a plain ASCII text file or formatted CSV (Comma Separated Values), **Text File Wizard** will be started within Database Wizard and it will guide you thru quick and easy steps of text data acquire. The main difference between real database and text file is in their data structure information. Databases include the whole information about their fields (names, data format, length) and can be automatically used with the application. Text files, on the other hand, do not have stored such information and you will have to instruct the application how the data is encoded.

When Text File Wizard finishes, it will return control back to Database Wizard, that will guide the rest of the way.

**Choosing Data Type**

Before you can use text file, you will have to define its data structure. Fields can be delimited by some sort of a separator (tab, semicolon, comma or some entirely user-defined separator) or can be of a fixed length.
Choose **Delimited**, if you know that data fields are separated with some special character. File preview at the bottom of the dialog box can be helpful, if you do not know exactly how the data is organized.

Choose **Fixed** if you know, that your data fields always occupy the same number of characters.

**Start import at row** option is useful, when you do not want to import some rows at the top of the file. Most usual situation, when you would want to use this option is when text file contains some header on top of actual data fields.
**Setting the fields**

In the second step of the Text File Wizard you have to set the fields in the text file. If you have selected *Delimited* in the previous step, choose the appropriate separator here. The ones that are usually used with text files are already pre-defined. But if you require some other, there is an option to use a custom-defined one.

You can also select the *Delimiter* character that is used when separator character is used in the text field itself. The delimiter should be used to enclose such field. Text between two delimiter characters is treated as one field although it contains the field separator character.

The data preview in the bottom part of the dialog box will let you know if your choice of a separator character is a correct one. Fields will be separated with vertical lines, if a separator is valid.
If you have selected that your data is formatted with fixed widths, the second step of the Wizard will be slightly different. Instead of selecting character for field separation, you will have to define field widths. The Wizard makes it as simple as possible. Use a mouse and draw a vertical line to the start positions of the fields. Lines will indicate where the new field starts.

**Formatting the fields**
In this step of the Wizard you can review the fields' names and lengths and modify them, if necessary. You will probably use more friendly field names, so you can distinguish between them more easily.

When you are finished with Text File Wizard, the structure information of the used text file is stored to a separate file with a extension of .SCH (Scheme File). If you will try to use the same text file some other time on a different label, you will be spared all efforts of structure creating. SCH file will be automatically used and Text File Wizard will be skipped entirely.

Note, that SCH file is created also with add-on database manager NiceData, when you open the text database in NiceData for the first time.

3.8.9 Database access dialog box

Normally you would want to use a Database Wizard for attaching a database to your label to ease the task. The Database Wizard will be sufficient for most ordinary users, but not all options are accessible from the Wizard. Only the most common options are accessible thru Wizard. If you require some advanced database connectivity settings to be applied, you will have to use a direct database connectivity. The recommendation is to use Wizard to set up the common database options, and then use a direct method to set additional advanced options. If you want to use OLE DB to connect to the database, you will have to do it manually.

Dialog box has several pages (tabs).

General tab

Here you define the name and description of a database function. The other options are database related.

Further on you can define the source database driver, select the location of the database, choose a database table and other parameters. Database is a group of tables, which are usually thematically connected. If you have the program for material supply, that is one database and it includes more tables (items, warehouses...). Tables can be
interactively connected among themselves. The application knows how to connect the different tables together using a key that is common to both connected tables. Use Filter functionality to connect one table to others.

**Driver:** In this section the database type can be selected. To define the connection to the database file click the **Define** button. **Database** dialog box is shown allowing you to select the database type. This dialog box is described further in this manual on page 3-165.

**Database:** Click the Browse button to select the location of database files on your disk. This is only required for desktop databases (dBase, Paradox, MS Access, ...) and not for enterprise databases (Oracle, MS SQL, ...). When using enterprise databases, the desired table must be specified at a time when making connection to the database.

**Table:** In the table list you can choose a table, which will be used as a data source. If you are editing existing connectivity to the database, you can only change the table, if no fields from it have been used on the label yet.
If they are used, you will first have to disconnect them from label elements.

**Order:** If you want to have a special order of records, you can choose the order field. Note, if the field you have chosen is not indexed in the table, this operation could be very time consuming, especially with large tables.

**Review result before printing:** This option makes it possible to change the result of a function just before using its results on the label. For example, we want to use data from database. But there is a possibility, that data read from the table, is not quite correct. If *Review result before printing* is set, data from the database table will displayed on the screen. You can edit the value or just accept is, as it is.

**Detailed tab**

On this tab you can define how the label quantity is handled. Each record can be used only for one label or for multiple records. You can even use several different records on the same label at the same time.

**Numbers of labels per record:** This section is used to define how many labels should be printed for a specified record and how the label quantity is acquired. Based on the selection made in this section the availability of options in *Record retrieving* section will change. Not all combinations are always possible.

**Record Retrieving:** You can choose the type of the operator: to retrieve only first or last matching record, to retrieve all matching records in a database or to manually select which record(s) to print. Manual selection is done in the *Record selection* dialog box, which is shown when you chose Print command.

- **First** The first record from the database will be used.
- **Last** The last record from the database will be used.
- **All** All records from the database will be used one after another or combined.
- **Select** You can select which records will be used for label printing.
Number of labels per record options:

**All:** This option will use only one record from the database. All labels in a series will have the same values for database variables. This is useful if you have some number of labels to be printed with some variable fields of the same value, but other variable fields on the label change (for example, a counter).

The record selection can be either First, Last or Select.

**Fixed number**

This is a default selection. By default the data from one record will be used for one label. If you would like to use one record with more labels, change this option to the appropriate value.

The record selection can be either All or Select.

**Defined at print time**

This option is used when you want to specify your own quantity of labels. There are several different possibilities how you can define label quantity. The value for this variable can be a constant value, output of some function, it can be entered at the time of printing or it can be read from the database file. When using this option, you are setting the number of label copies that should be printed. The variable data for these labels will stay the same for all copies.

**stored in database field**

Select the database field that stores the information how many copies of labels with data of the current record will be printed.

The record selection can be either First, Last, All or Select.

**stored in another label**

Select some label variable that stores the information how many copies of label
A **variable** should be printed. This variable can be a prompted variable, a global variable or output of some function.

The record selection can be either **First**, **Last**, **All** or **Select**.

**entered for each record**

This option lets you enter the quantity for records at print time. This type of label printing can only be used if you have Record selection set to **Select**. Prior printing a database selection dialog box is shown allowing you to select which records will be used on the labels. At the same time you can provide label copies for each individual record.

The record selection can only be **Select**.

**Collect**

This option can be used in cases when you want to use several different records on the same label at the same time. **Collect** will acquire data from two or more records and use them jointly.

**Limit** parameter defines how many records should be joined together and used on the same label.

**Separator** section defines the character that will be inserted between individual records in an joined output variable. **None** will leave the values intact, **CR/LF** will cause the records to be positioned every in a new line, **Other** field lets you specify your own separator character. You can enter a hexadecimal character code by inserting a hash character (#) as the first character in the line.

The record selection can be either **All** or **Select**. It is **All**, then records will be acquired from beginning of the database. If it is **Select**, then the records you will select will be joined together.
**Skip N records before printing:** You can define how many records from the database will be skipped, before starting the label production. This option is very useful, when printing from large tables and you do not want to print the entire table all at once. If you have for example a table with 1,000,000 records, you can print them in chunks of 10,000, changing the *Skip* parameter every time before printing.

**Fields**

This tab will show two lists: the available and selected fields. The list of the available fields contains all fields of the table.

The list of the selected fields shows you, which fields are already selected for use in the label. In the list, there is also the name of the variable, which represents the field. The name of the variable is the same as the name of the field by default, but you can change that by clicking the **Define var.** button. In this case **Variable** dialog box is displayed.

- Click this button to add selected field from database to the label. Database variable will be generated and this field connected to it. Database variable will have the same name as field in the database.

- Click this button to remove field from the list. Field can be removed only if its database variable is not connected to any label element.

- Click this button to add all available fields from the database to the label.

- Click this button to remove all fields from the label.

The variable, which is created for each field, can be linked with label elements (barcode, text, graphics...).
The Define fields button is available to specify detailed properties for database fields. If you are using the fields from a text file, you will be able to define or modify text file field structure and field names. If you are using a real database, you will be able to define codepage settings for each field.

If you want to change the name or any other parameter of the variable, which is connected to the field, you can use **Define var.** button, which opens properties for this variable.

**Fields dialog box**

**Fields** dialog box is shown by clicking the Define fields button on the Fields tab of the Database access dialog box. This dialog box has double functionality.

When you are using database connected to the label, this dialog is used to change the codepage setting for each individual field from the database. The default setting is **Default** that instructs the software to apply the systemdefault codepage settings for the field in the table. But you can set every field to its own setting.
example, the first field can contain data in Chinese language, the second in German and the third in Hebrew. The encoding field lets you specify how the data is stored in the fields. *None* is the default setting. *UTF-8* and *UTF-16* are two modes of Unicode encoding. If you have Unicode database, you do not have to change anything, NiceLabel will auto-detect the type. But if you use the database that is not Unicode-aware and you still use Unicode data, you have to encode Unicode data into such database using UTF-8 or UTF-16 encoding. In this case you need to select the used encoding in here.

*Edit* button lets you change the codepage setting for the selected field. If you want to change all the fields at once, use *Apply to all* button and all fields will be formatted as the selected one.

The other functionality of this dialog box is used when you are using text database on the label. You can view and change the text file structure here.

In the *Text file structure information* section you can define whether the fields in the text file are delimited with some separator character or are of fixed length. If the fields are separated, you must define the *delimiter* and the *separator*. The delimiter is used when the text table includes fields, whose contents also include a separator character (for example, if the separator is a comma and the contents of the text field is data, which includes a comma character then the contents must be between the delimiter signs).
Text files should be connected to the label using Text File Wizard. You can re-run this Wizard by clicking the **Redefine** button.

**Filters tab**

In this dialog box you can define conditions, which will be used to retrieve a subset of records from the table. Basically this a way to create a simple query on the database. An often used application of filters is to bind two tables together based on a common ID number that exist in both tables. Only records, which meet the condition set will be selected.

Note that you can only compare database fields with variables or fields from a different database. If no variables are defined or connection to no other database is made, you won't be able to add a new condition.

There could be a problem with the format of the field used for seek. If the field type from the database is **Numeric**, the variable defined on the label must also be **Numeric**. Only then the correct SQL statement will be generated.

Example:

```sql
SELECT...WHERE Field = '1' - wrong
when the Field is numeric
```
SELECT ...WHERE Field = 1 - OK

By clicking the Add button you can add a new condition. Field, relation and variable can be chosen from drop down list.

If you define more than one condition, relation among them is AND, which means everyone of them have to be fulfilled. Each condition has three parameters: Field, Relation and Variable. The condition is true, when the value of the variable is in selected relation to the field.

If you use the LIKE relation, input data, entered at print time, must have the following form: When you want to search for all records, that one field starts with "AB", you should enter the value "AB%" for the specified variable. All records that start with "AB" and continue with any possible value will be retrieved. For example, "ABC", "ABCD", "AB1" are all valid possibilities.

Database function dialog box – Filter tab

SQL button is used to define custom SQL query.
**SQL dialog box**

SQL button in the **Fields** tab of the **Database access dialog** box opens a new dialog box, where you can change the SQL statement which is used for acquiring data from the database. But this is really only for experienced users. If you make a mistake and create an invalid SQL statement, the results of the query can be unpredictable.

![Advanced SQL-Query dialog box](image)

Advanced SQL-Query dialog box

**3.8.10 Database dialog box**

The **Database** dialog box is used when you want to manually set properties for the database used on the label.
For **Database connection type** you select the type of the database that is available on your system. There are three connection modes available in NiceLabel software.

**Text driver**  
There is the driver TEXT. It allows you to connect to the plain text files that contain data you want to use on the label.

The data can be either separated by some common character (comma, semicolon, tab...) or the columns of data must have fixed widths.

**BDE drivers**  
Borland Database Engine drivers can be used for connection to desktop databases (Paradox, dBase...) or enterprise databases (MS SQL, Oracle, Informix, Intrbase...). The desktop drivers are installed with NiceLabel software, the enterprise drivers are available as separate install from the CD-ROM.

The disadvantage of BDE drivers is that they do not support Unicode databases very well.

**OLE DB drivers**  
Use OLE DB drivers to directly...
connect to SQL Server, MS Access, Excel, Oracle and similar databases. You should also use these drivers when connecting to your ODBC data sources.

OLE DB is modern technology to connect to different databases and can work perfectly with Unicode-enabled databases.

It is recommended to use these drivers for connections to your databases.

The **Database Connection definitions** section changes accordingly to the selected Database connection type. For file oriented desktop databases (Paradox, dBase...) you usually have the option to browse to the database file and then open it directly.

For other databases you have to define the database connection string or alias. The alias can be defined in ODBC administrator for ODBC drivers, can be defined in BDE Administrator for BDE drivers, or can be defined in the database properties for the OLE DB provider.

It all depends on the type of the database. For more information refer to the help files of these external third-party applications.

If the connection to the database requires you to enter **User name** or **Password**, you have an option to provide them in the appropriate edit fields. If you do not enter the password here, but it is required, you will be prompted for it later at design or print time, when the data will have to be acquired from the database.

**Show system tables**: if you enable this option system tables will also be shown in the list of tables. When you need to use the data from system tables, tick this option.

**Automatic browse for tables** is checked by default. The application will automatically browse for all the tables in the database and offer them to you. However, this operation can take quite a lot of time on some database types (for example ORACLE database using ODBC driver). If you find out, that it takes too much time, un-
select this option. Then you will have to enter table name manually.

Test connection: Click this button to test the connection to the defined database. You will be notified about possible problems.

### 3.8.11 Check digit algorithms

You can create completely custom check digit algorithms, if built-in are not sufficient. This function is very useful, if you want to add your own security to the barcodes. Check digit algorithms can be used directly in the bar code definition (if the bar code supports the change of algorithm used), or in conjunction with Check digit algorithm function.

The algorithm can be defined based on the Modulo functionality and is a derivative of a EAN-13 algorithm. If you want to create different or more complex check digit algorithms, use the Visual Basic script function to create it.

When selecting this command, **Algorithms** dialog box appears on the screen:

![Algorithms dialog box](image)

You can add new or edit and delete existing algorithms by clicking appropriate buttons. Algorithm's parameters are defined in **Edit algorithm** dialog box, which has following options:
• **Algorithm name**: Name of the algorithm. Each algorithm must have a unique name.

• **Algorithm description**: Short description of the algorithm.

• **Modulus**: See below for explanation.

• **Weight(s)**.

• **Sum determination**

• **Result complemented**

• **One digit only**.

To understand all parameters, you must know, how check digit is calculated. First of all, we must have a numeric value and on top of that the check digit will be calculated. If weights are required, we will need the as well. Let's look at EAN13 check digit calculation:

Value: 123456789012
Weights: 1, 3

When starting calculating, each digit has its weight. When only two weights are specified, the third digit gets the first weight, the forth the second, and so on. If only one weight is specified, all digits have the same weight. According to Sum determination, we can use weights
(sum of the products) or not (sum of the digits). EAN13 algorithm uses products, so we define Sum of the products.
The sum is: 1×1 + 2×3 + 3×1 + 4×3 + 5×1 + ..... + 2×3
When the sum is calculated, we take modulus parameter and divide the sum with that number and remember the remainder of division. This can already be the result.
If Result complemented is specified, we subtract the result from modulus-1 and so we get the new value. When this value is less than 10, we already got check digit. If it is greater value (two digits), we take the whole value or just the least significant digit (One digit only) as the result of check digit algorithm.

3.8.12 RF Tag

The concept of RFID (Radio Frequency IDentification) can be simplified to that of an electronic barcode. First emerging in the 1980s, RFID was primarily used to track objects in industrial environments where barcodes were unable to sustain the harsh surroundings. Today, RFID is being used to authenticate official memorabilia, track proprietary assets, automate access control and has many more additional fields of usage.

Some new thermal-transfer printers have the ability to program a RFID tag at the same time as they are printing the label. Two different technologies and their encoding methods are joined on the same label. Of course a label has to have embedded a RF tag. The tag is paper thin, flexible and small in size which allows it to be placed inconspicuously under the label. It consists of an etched antenna and a tiny chip that can store ID number or your custom data in larger quantities. This contrasts with a barcode label, which does not store any enhanced information, but merely some code number.

RF tag data encoding options can be set in this dialog box.

Use RF Tag in label: Enable this option if you want to program the tag at the same time as the label is printed. If the option is not selected, no RF data is sent to the printer, but the definition is remembered for next time.
**Type:** Select the type of RF tag you want to use with your printer. The list of available tags change with the selected printer. Not all tag types are always available. You must use NiceDrivers to be able to use RF programming. It also depends on each printer model what kind of RF ID tags can be used with it. There are generally two types of tags:

- ISO tags (TagIt, iCode, ISO...): These are block oriented tags. The data can be encoded in multiple blocks.
- UHF tags (ePC): The data is encoded in one block of data.

**Tag Settings:** This section provides the information about the selected tag type.

**Number of blocks:** The number of blocks that are available in the RF tag.

**Reserved blocks:** The number of blocks that cannot be accessed and used.

**Block size:** The size of each block (in bytes).

**Unique RF Tag:** If you have the printer and/or the tag type that can provide you with the Unique Tag ID, this flag will be set to Yes. Each tag has a unique ID encoded already in the production line. If your printer can read this information from the tag, you can use it with the label elements. When the Unique Tag ID is supported, you can connect it with the label elements using RFID Unique Tag ID contents provider.

For example: The printer scans Unique Tag ID, remembers it and prints it on the label encoded in a barcode element.

**Antenna offset:** To achieve better programming accuracy of the tags here is the option to define the offset for the antenna in the printer. This is the distance from the edge of the label to the embedded tag. This option will help you program the tags more accurately.

**Number of retries:** The number of times the printer will try to program the tag if first attempt fails. The parameter is sent to the printer with the rest of the data.
Data Blocks: This section allows you to provide data values for the RF tag. The sections has different options available for different tag types (UHF or ISO).

For UHF tags

Data type: Data type of the selected tag can be specified here.

Data source: Incoming data that is encoded in the tag can be fixed value or acquired from some variable, defined in the label.

Data size: The currently used data is previewed here. You can see the amount of space still available in the tag. The occupancy of the tag is seen graphically with growing bar and numerically with the digit, explaining the number of already used bytes.

Block locked: If you set the block as locked, the data will be permanently encoded into the tag. You will not be able to erase this block to re-program it with some other value. Use this option with caution!

For ISO tags

The blocks that are dimmed and unaccessible are reserved blocks that cannot be used.

Block Number: The successive number of block in the tag.

Data source: Select where the data block will receive the value from. It can be Fixed, where you will manually type in the value or can be Variable, where the value is acquired from some variable defined in the label.

Data: Type in the tag value manually, if the selected data type is Fixed. Select the variable defined in the label, if the selected data type is Variable. If your variable length is greater than the block size, the next block will automatically be reserved for the data.

Size: The currently used data is previewed here. You can see the amount of space still available in the tag. The occupancy of the tag is seen graphically with growing bar
and numerically with the digit, explaining the number of already used bytes.

**Data type:** The data can be encoded as ASCII string or as HEX encoded string.

**Locked:** If you set the block as locked, the data will be permanently encoded into the tag. You will not be able to erase this block to re-program it with some other value. Use this option with caution!

### 3.8.13 Variable Trace Setup

The variables and their values can be traced in the log file. This is important particularly for print control, when in the case of wrong data the great amount of material can be lost. With the help of the **Variables Trace Setup** command in Data menu, you can discover the cause for the mistake.

Here you can define which variables will be traced in the log file.

![Variable trace setup dialog box](image)

It is important to take care of the significant variables! By default all variables are traced.

Note, only the user with supervisor privileges can use this command. Before this command can be applied, you also have to turn on the log file. For more information refer to

3.8.14 Unlock global variables

When using global variables, they are locked while printing or editing one. This prevents users from concurrent use of one variable, which would lead to invalid processing of variable. Two printed labels could have the same value, which is not the proper way of using global variables.

But, sometimes, if the computer crashes or something unpredictable happens, the variables can stay locked. In that case, it is necessary to unlock them using this command.

Only user with supervisor privileges can perform this action. For more information on user levels and privileges please see Configure Users.

3.8.15 Lookup Tables

Lookup Table is a simple easy-to-create database table containing your data. It can be stored in the current label file or shared between many label layouts. The Lookup Table functions in the same way as connection to the external real database files (dBase, Paradox, SQL, Oracle) but is much easier to set up. It satisfies the needs for simpler data storage system with easy retrieval method.

You can Add new table, Edit existing one or Delete unneded one.

When you create a new Lookup Table, several properties are available to be set. Every table has to have a Name to which it can be referred to.

If the table is Local, its data is stored directly in the label file (.LBL). Label file will occupy more disk space because of this functionality, but this is minimal disk space. If the table is Global, the data is stored to an external file. When you migrate the labeling system to some other computer, make sure to include the global Lookup Table as well.
Every table can have one primary key and one secondary key. One of the keys has to be enabled, the other is optimal. At least one data field has to be filled in. The structure of the table is the same as any other database table. Every line in the table holds a data for variable fields and can be used for an individual label. Every field represents one qualifier of the record. Up to five fields can be used for a single record. To set the field name, click the caption of the field, then type in new name. To enable the field tick it in the caption bar.

If the Lookup Table is defined as **Graphics table**, there are only two fields available, the field with a key and a data field with location of the graphics image on the disk. This location can include the full path and filename to the graphics file.

### 3.9 Transformations

In this menu are commands that you can use to transform objects that already exist on the label. First you need to use **Select** tool to select objects on which the transformation will take place. Then choose one of the commands that appear in **Transformations** menu.

#### 3.9.1 Rotate

This command is used to rotate selected elements. Elements are rotated in steps of 90°. Center of rotation is the upper left corner of selected elements.

To use **Rotate**, select the object to be rotated, then click the rotation icon in the **Toolbox**, or use the **Rotate** command in **Transformations** menu.

When more than one element is selected (using the command **Select all** from the pop-up menu for all elements or by the selection of some elements by pressing the `<Shift>` key and clicking the elements), a non-printable rectangular is created around all the selected elements. Rotation is again made in steps of 90°. Center of rotation is the upper left corner of the non-printable rectangular.
3.9.2 Align

After you select the element (or multiple elements) and click the Align command, the dialog box appears.

![Align dialog box]

Both vertical and horizontal options for the alignment must be set. Objects are always aligned to the first selected element, but if Align to label option is used the objects are aligned to borders instead to each other.

Be aware that when more elements are aligned to a specified place on a label they may overlay each other.

This feature is more often used to align multiple elements on each other. For example: you need two elements to be printed one below the other, aligned to the left border. You must select None vertically and Left horizontally alignment.

If you select Space equally, then objects are moved so that the distance between them is constant in the direction specified.

3.9.3 Embed all pictures into label

This command embeds all graphics into the label. All links to the destination graphics files on disk are removed, and separate files for graphics are no longer required, because all graphics elements are stored in the label file. The file size will grow in proportion with the size of the graphics and the label will be more transportable. You will be able to open it normally on all computers as all graphics are included in the label.
However, if graphic is linked to the label, you can simply change it, and label layout will change automatically. If graphics elements are stored with the label, you will have to change them manually.

3.9.4 **One to front**

Moves objects to the front by one position. Toolbar button ![button](image) has the same effect.

3.9.5 **One to back**

Moves objects to the back by one position. Toolbar button ![button](image) has the same effect.

3.9.6 **To front**

Moves objects to the top. Toolbar button ![button](image) has the same effect.

3.9.7 **To back**

Moves objects to the back. Toolbar button ![button](image) has the same effect.

These actions make sense only if several elements overlap each other. For example: one big graphics serves as a background for other elements.

These actions also work only on printers that do not print elements in OR mode - see through. On thermo transfer printers, these actions do not make any sense.

### 3.10 Options

In **Options** menu several global settings regarding behavior labeling application can be set. Note that these options are not specific to the label but to the whole application in general. They will be valid whenever you start the labeling application.

**3.10.1 Snap to grid**

Selecting this option enables the positioning of the elements to be based on the grid settings. The position of
the elements will be placed on a grid position. De-selecting this option allows elements to be freely placed. Upper left corner of the object is used for positioning on the grid.

3.10.2 Grid visible

Selecting this option makes the grid visible. De-selecting the option hides the grid.

3.10.3 Preferences

With Preferences command you can set the default zoom factor, grid settings, default measurement unit, screen colors, the paths for different files, have access to advanced settings and startup behaviour.

Preferences dialog box – Desktop tab

Dialog box has several tabs.

Desktop tab

Under Default Zoom you can define the kind of zoom you want as default to be used on the label. It can be either zoom to label or zoom to page.

Selecting option Grid visible makes the grid visible.

Selecting option Snap to grid means that the position of the elements will be placed on a grid position.
These two options are the same as those in Options menu.

The Default unit button will let you set the default measurement unit used in the application.

Colors tab
Here you can select the colors for the background, media, label and inactive label. Select new color by clicking the Select button and then choosing appropriate color.

Directories tab
Under Directories you can define folders where the files for labels, graphics, stocks, databases, import files and variables will be stored. If you don't know the exact path names, use the Browse button to select one.

The default setting is to set these folders under the %MyDocumentsDir% file structure. The exact location on the hard disk varies greatly upon your Windows operating system, not every version of Windows uses the same absolute paths.

Settings tab
On this tab you can define the following:

- **Easy production if possible:** the values of the variables on the label will be entered directly on the label before printing. The commands for that kind of work are: <Tab> - to pass between the variables, <Ctrl>+<Enter> - OK, <Esc> - Cancel.

- **On Screen edit by default:** during designing of the label you can write text directly on the screen and not in the dialog box Text.

- **Save preview image in label/stock file:** Normally small picture of the whole label/stock will be saved for preview. To save disk space, this feature can be disabled.

- **Print invalid elements:** Invalid elements are the elements placed outside the label border or have invalid value and not complying to the standards They are not printed by default. You can supersede this behaviour by enabling this
option. All elements will be printed, but some of them, which are out of the label, will not be printed entirely. Some parts will probably be missing.

- **Use Wizard for label setup**: When selected, the label setup wizard will appear after creating a new label. This wizard will also be used when changing the label with **Label setup** command from file menu.

- **Barcode dimension checking**: Barcode standards also specify in what sizes can certain barcode be printed. When you select this option, you will be warned, if you are trying to use non-standard barcode size.

- **Show codepages in font toolbar**: Select, if you want to display each available codepage for the fonts as standalone fonts. For example: instead just having Arial font in the list of fonts, you would have Arial (Western), Arial (Baltic), Arial (Central European) etc. If you do not show codepages in the font list, you can change the font script in fonts settings of the selected element.

- **Enable revision history logging**: Select, if you want to log changes made to the label. The list of changes is visible in Revision History tab of Label Setup dialog box. To be able to write the comment for each revision, enable the option **Prompt for revision history comment**.

- **Show phantom elements in preview**: Elements, formatted as phantom, are not printed on the label. Select this option, if you want to see them in the print preview anyway.

**Startup tab**

Select if the software should validate all installed printer drivers on the system at startup. Use this option if some of the installed printer drivers is not Windows-compliant printer driver and causes different problems or lock-up of the labeling application. If such driver is detected it will
be put in the list of invalid printers. The software will refuse to use invalid printers.

If your printer driver is listed as invalid printer but you are sure it does not cause any problems, you can remove it from the list. Select it, then click the *Remove* button. To empty the list of invalid printers click the *Clear list* button.

The *Check Printers on Startup* option is disabled by default.

### 3.10.4 Language

Here you can choose the language that will be used for the application. All major world's languages are supported and many more are added with each new release of the software. After the language has been changed, you will have to restart the application for changes to take effect.

![Language tab](image)

#### 3.11 Tools

In *Tools* menu several maintenance options are available for your labeling application. These are related to log file and user settings. Shortcuts to other applications from the Suite package are available in Tools menu for easier and quicker access to NiceForm, NiceData, NiceWatch and NiceMemMaster.
3.11.1 Configure log file

All label printing-related activities on your computer can be logged. Information about any label that gets printed from any label printing station is logged.

Log file tab

**Log file type** defines the format of the output log file. It can be either a classic (database) format or a plain text file.

If database format is selected, the data is stored to Paradox database NLOG.DB, stored in the Bin\System folder of application's installation. The location of the folder varies depending on the Windows operating system used. On Windows 9X and Me the location is C:\Program Files\EuroPlus\NiceLabel\Bin\System, on Windows NT, 2000, XP the location is C:\Documents and Settings\All Users\Application Data\EuroPlus\NiceLabel\System.

If text file format is selected, you can set some additional settings. **Log file path** defines the folder, where text log file will created. Use Browse button to select the proper folder. Be sure, you have writing permissions set for selected folder.
Log file save type defines the how the labeling activity should be saved. Static file will log all activity to a single log file, Files arranged by label name will create a separate log file for each label that is printed and Files arranged by date will create a separate log file for each day.

Log file name (prefix) is used to specify filename that will be used for label activity logging, if a static file is used. If log files should be arranged by label name or date, than this fields is used for log file prefix. File name or date will be appended to this prefix, when data for log file will be stored.

Log file contains several fields that have to be somehow separated among themselves. Log file delimiters sections lets you set the type of the delimiter that is used to separate fields. Plain text will format log file using fields with fixed widths. Delimiter in this case is one or more spaces. Widths of the fields will be the always the same and are formatted to allow the maximum fields size to be used. Tab separator will delimit fields with tab character. With Custom separator you can define any character as the delimiter and it will be used to separate the fields.

Variable trace mode specifies if variable values set on the label should be logged as well. The default is to log everything. You can set trace mode to None and no variables will be traced, All variables can be traced, or Selected Only. The variables set to be traced are selected in the Variable Trace Setup. This setting is specific to each label you define.

3.11.2 View Log file

This dialog box lets you review the contents of log file. All past printing actions and variable settings for each action can be viewed here.

The preview of the log file depends on which type of logging have you got enabled.
Database (classic) Log Viewer

If you have a classic (database) log file format, you can view the following information about printed labels:

- printing date and time
- the name of the user who printed the labels
- the name of the label file and its location on the disk/network
- the quantity of the printed labels
- the printer name used for label printing
- information about set variables on the label (variable name, variable type, value, increment, step, count, quantity and format)

The labels can be sorted by date, user name, label name or quantity by clicking desired sort option in *Sort by* or clicking the table captions.

If *Short label name* option is selected, folder part is omitted from the label name and only the file name is displayed.

You can sort the fields in the table by dragging the desired field to the new location. If you click with the right mouse button anywhere in the table fields, a pop-up menu is displayed, allowing you to select (deselect) fields of log file that are displayed. The log file itself will still contain all original fields, only the view of the log file will be changed.
You can click the **Empty log** button, to clear the log file. Your previous log entries will be lost.

Click the **Report** button to export the Paradox log file into the plain ASCII text file. This is useful if you need to work on the log file in some other application (database programs, text editors, backup purposes…).

Only the displayed fields of the log file are exported.

First you must specify the file name and location of the exported log file in the text box and directory list. Then you must specify the format of the exported log file. There are two options for selecting appropriate format:

- **Include variables**: If selected, variable names and values will be included in the exported log file.

- **TAB delimited**: If selected, fields will be separated by tab character instead of spaces.

Click **OK** to create the file with the specified settings.

If you are using plain text file as format of your log file, then the text log file will be displayed in a window. The same data fields are included as with Paradox log format, but the layout is based on the delimiter you have chosen. You can use Windows standard Copy and Paste commands to extract parts or whole log file for the external use.

### 3.11.3 Configure Users

Here you can define user restriction options, logon settings, define users and assign each of them his own security level.
**User settings**

**Settings tab**

The user login option is disabled by default and **None** login is required to use Nice applications. If you want to limit user logins because of demands of your working environment or security issues, you can set login requirements to **All**. All Nice applications will prompt users for their username and passwords. Only a valid combination of both will grant user the entrance. If you only want to limit the access to configuration options, you should select **Configuration (Users, Log file)** selection.

The **Default mode** is used only when user login is not required or only access to Configuration options is limited. It will set the default mode of Nice applications.

In this dialog box you can also change the current **Supervisor password**. Supervisor is the power user with access to all program and user settings. Only supervisor can modify add and remove users and set their privileges. The default supervisor password is "NICE" (without the quotation marks).
**Users tab**

If you require strict access to label designing and printing and want to log all labeling activities, you should use a user login functionality. Each individual user can be set username and its own security level. Only the user with Supervisor level can add, remove and edit user accounts. For more information about user security levels please refer to Add user properties.

**New users and user levels**

![Add user properties dialog box]

Nice users can be defined in this dialog box. If login is required to access Nice applications, only users already defined here will be granted access. Each user must have defined his username, security level and password.

Possible **Levels** are:

- **Supervisor**: supervisor is the most powerful user. Apart from being able to access all functionality it can also add new users or remove and edit existing users in the system.
- **Full**: this user level grants full access to label design and printing. All program options are accessible, but user with this security level cannot change program advanced properties as log file settings and user management.
- **Print Only**: this user level allows only printing of existing labels, using existing forms and already defined NiceWatch triggers, advanced database commands are disabled as well and data on memory cards can only be used, but not
downloaded. The Nice application are limited to usage of existing layouts only. Nothing new can be designed. This way users cannot change or modify anything. This user level is suitable for environments where it is vital that label operators do not have ability to change anything by accident.

- **Design Only:** this user level limits user to design functionality only. Label layouts can be created, as well as forms in NiceForm and trigger options in NiceWatch. But labels cannot be printed, forms cannot be started and actions cannot be triggered. There is no limitation to NiceMemMaster and NiceData.

- **View Only:** this user level allows only previewing of existing label layouts, forms, triggers, databases and memory card options. No changes can be made and no printing can be achieved.

### 3.11.4 Design form

This command starts NiceForm program in which you can edit a form that is used to enter variable data before printing. Using this command you can bind label with a form. The purpose of using forms is to simplify data-entry and label printing process for the end-user.

Before printing, the form you created in NiceForm application is displayed. You can enter values for variable fields that are used on the label in this form instead of using classic Windows dialog box.

If the form name is not set in Label Setup properties, Advanced tab yet, the name of the label will be used also for the form file and new form file will be created. If the form file does not exist yet, the New Form Wizard is started. If you want to print labels using form every time, you should enable *Use form when printing* in the same location. This way label and form applications are seamlessly linked together.

NiceForm is part of the Suite package.
3.11.5 Edit Memory Card

This command is only available if the currently connected printer has a support for memory cards within NiceDriver and if NiceMemMaster application is installed on the system. NiceMemMaster is part of the Suite package.

The command will automatically open NiceMemMaster with current label printer already pre-selected. You can then define the memory card contents, add/remove fonts and graphics to the memory card.

If you confirm the changes in NiceMemMaster, the memory card functionality can be used on the label. Memory card is automatically connected with the label. Fonts and graphics stored on the memory card can be directly used on the label.

This command is a great shortcut to memory card functionality if you frequently use it with your labels. The other way how you can connect memory card to the label manually is to use Printer Properties in Label Setup dialog box, Printer tab. More information how to use Memory Cards can be found in the How to section. Refer to the topic How to use printer memory card on page 6-12.

3.11.6 Nice Applications

These shortcuts will help you quickly and easily start other application from the Suite package.

NiceForm
Starts NiceForm - custom user entry form designer.

NiceData
Starts NiceData - database manager and editor.

NiceWatch
Starts NiceWatch - a program that can automatically trigger label production when certain events occur.

NiceMemMaster
Starts NiceMemMaster - printer memory card manager.
3.12 Window

3.12.1 Cascade

This command sorts the open label designed documents in a cascade.

3.12.2 Title

This command sorts the open label designed documents by titles, so that all documents will be present on the screen in the maximum size available.

3.12.3 Arrange Icons

This command arranges the icons.

3.12.4 Close All

The command closes all open label designed windows - documents.

3.13 Help

3.13.1 Contents

This command displays the Help window.

3.13.2 Using help

This command displays help on How to use the Help windows.

3.13.3 Internet support

This option allows you to quickly access the technical support for your labeling software. First select your area then describe the problem that you are having and click the Send button. Email will be send to the geographically closest technical support available.

Please be as detailed as possible when sending the email and describe how the problem occurs step-by-step. Also mention the version of software being involved in the
label printing (Windows, labeling software, printer drivers, database drivers etc.). If you do not have a general question, but are experiencing troubles with your current label design it would be helpful, if you could send all files along with the label file itself.

This option of contacting Technical Support is valuable, if you need to send all files connected to the label, because of the ease of how it can be done. Just select which files should be attached to the e-mail message in the bottom of the dialog box.

The option Embed system data will collect useful information about your system and attach it to the email. This information includes your access permission on the computer, location of labeling software installation, free memory available, printer drivers on the system etc). If you consider such information too confident, un-tick this option and not system-related information will be included in the report.

An e-mail message will be automatically created and sent to the Technical Support. You will receive an answer with possible solutions in your e-mail shortly. If the final answer would not be possible to write based on your data, technician will contact you for additional information about your system or label layout.

![Internet support dialog box](image)
3.13.4 NiceLabel on the web

Opens the official NiceLabel website (http://www.nicelabel.com) in your current web browser. You will find the latest information about NiceLabel line of products, latest versions of evaluation software, printer drivers and additional technical information and white papers.

3.13.5 Register

Using Register command from Help menu, you can register your labeling application. After registering the program will have full functionality and will not run in DEMO mode anymore. There will be no limits in label printing quantity and programs functionality. More about DEMO mode can be found in the chapter DEMO Limitations on page 4-196.

If you purchased Standard version of NiceLabel software (NiceLabel Pro Standard, NiceLabel Suite Standard), the required serial number is enclosed in the package.

If you purchased NiceLabel Pro or NiceLabel Suite dongle-less (the versions that are not equipped with hardware key), you will have to register your software on the internet. The Serial Number has been provided in NiceLabel package. The Registration Number is auto-generated by the program. The Registration Code is acquired on the Internet. Type in all the data and click Register button.

If a hardware key (dongle) has been provided along the software, you do not need to enter any serial number to register the software. Just make sure to properly install the key and install the valid program variant.

3.13.6 About

This command displays the application version information and name of the user that has installed and registered the application.
4. Miscellaneous

4.1 Label Inspector

Label Inspector is a tool for advanced element and data manipulation on the label. It is used for overview of label's structure and modifying label components, all element's properties can be simply modified from Label Inspector. You can of course still double click the element and change its properties from dialog box, but for smaller changes it is much quicker to change them in Label Inspector. Besides functionality you were used to earlier, Label Inspector brings some entirely new features, not available in previously.

Now you can change properties of several selected elements at the same time. If elements are of the same type, for example, all texts, you will be able to change their every property. If elements are of different types, for example, one text, one barcode symbol and one rectangle, only the properties common to all elements could be changed.

With Label Inspector you change some element's properties that are not accessible otherwise. Each element can have its own name, so you can distinguish between them. Whenever you select the element on the label, it will be highlighted in the list of elements within Label Inspector and its properties will be displayed in the bottom part of the Inspector (Properties section).

Label Inspector can be used to change the current view of the label elements, variables, functions and databases. The following views are available, the first on being the default one.
• **View by Objects:** All label elements are listed alphabetically by their type. First listed are text elements, then paragraph, barcode, graphics, rectangle and line elements. You have probably noted this is the same order of elements as they appear in the Toolbox. When you select one or more elements in the upper part of the Inspector, its (their) properties are displayed in the bottom part of Inspector. You can interactively change them and changes will be reflected automatically on the label. You can right-click any element and quickly access frequently used commands from the drop-down menu. You can find out to which variable some element is connected to by clicking the plus sign in front of the element's name. If it is not fixed, the view will be expanded and variable name displayed.

• **View by Variables:** All variables used on the label are listed here. They can be either prompt (their value is typed-in by the user at print time), database (acquired from database fields) or function-generated variables. If you click the plus sign in front of variable's name, the view will be expanded. You will be able to review from where the variable gets its data (database, function) and to which element(s) it is connected to. At the top of the upper section you can define a new variable. You can right-click any variable name and quickly access frequently used commands from the drop-down menu.

• **View by Functions:** All functions used on the label are listed here. If you click the plus sign in front of function's name, the view will be expanded. You will be able to review which are input and output variables for the function. At the top of the upper section you can define a new function. You can right-click any function and variable name to quickly access frequently used commands from the drop-down menu.
• **View by Databases:** All databases used on the label are listed here. If you click the plus sign in front of database's name, the view will be expanded. You will be able to review which are output variables from the database. At the top of the upper section you can define a new function. You can right-click any function and variable name to quickly access frequently used commands from the drop-down menu.

• **View as List:** This view is similar to View by objects with one difference. Not only objects are listed here, but also all variables, functions and databases. You can right-click any name to quickly access frequently used commands from the drop-down menu.

The rightmost button **Inspector properties** is used to define the default behavior: should the view to Inspector's elements be expanded by default or not. If the elements are expanded then all the properties for all of them are visible. If they are not expanded, you will have to manually expand the view of the element, you are interested in.

### 4.2 Command line options

The following command line options can be used when starting the main labeling application.

`NICE3.EXE [file_name] [options]`

*[file_name]* Represents the full path name of the file. If the label file is given, then this label is opened. If JOB file is given, then this JOB file is executed. For more information about JOB files, refer to chapter NiceCommands.

*[options]* can be on or more of the following:

/s  Silent mode, no toolbar, menu or banner is displayed and window is minimized. This is useful when using NiceLabel as label printing
engine for label production from other application.

/r  Registers NiceLabel as an OLE server.
/u  Unregisters NiceLabel as an OLE server.
/i  After JOB file is finished, NiceLabel exits.
/typelib  This option will generate NICE3.OLB file with type library description of NiceLabel ActiveX interface. The file contains COM interface description to NiceLabel, if you would like to integrate NiceLabel functionality to your application.

### 4.3 Demo limitations

You can install NiceLabel software to your computer even if you do not have purchased it and do not have licenses to run it. The software can be installed from CD-ROM or using installation packages available at internet website.

Using both ways you will install unlicensed software to your computer. The software will run in DEMO evaluation mode. We encourage this behavior as we believe it is important that you have a chance to try out the software before you make a decision to purchase it.

The software in DEMO mode offers you access to all major functionality of the applications. Some limitations still apply, but they should not prevent you test out the applications.

**NiceLabel Pro**

- Maximum of 5 consecutive labels can be printed.
- After one month, there is an increasing time delay in print dialog.
- Export functionality is limited (only 1 variable elements per label).
- Copying of label elements (bar codes...) does not work to other
Windows applications via Windows Clipboard.

**NiceForm**
- Three actions are executed on the button.

**NiceWatch**
- Three actions are executed for the trigger.

**NiceMemMaster**
- Download to the printer is not enabled.

**NiceData**
- Database tables with maximum 20 records can be used.

### 4.4 Expression Builder

The labeling software has a simple text editor built-in. You can use it to design your own simple VB Scripts or .JOB batch files with NiceCommands. But for more complex scripts it is not powerful enough.

Advanced users can use an Expression builder. It is an enhanced programming text editor with constant access to command reference of the script language you are currently using. Expression Builder can be used with Visual Basic Script and with NiceCommands.

Expression Builder lets you edit your scripts and expressions with ease. The *Load* and *Save* buttons allow you to import / export VB scripts from / to external text files. The builder uses standard shortcuts for positioning of the cursor and working with textfiles. Available are also standard Search and Replace shortcuts (Ctrl + F, Ctrl + R).

The working window is divided into four parts.

**Category**
This section contains the groups of available commands, functions and operators. Similar objects have been grouped together for easier identification and faster search.
Chapter 4: Miscellaneous

The groups are displayed as tree-view. Select the main group name to display all its contents into the Name section. Or you can click the plus sign in front of the group name (if available) to display all defined sub-groups. Then select the sub-group name to display only its contents.

**Name**

This section will display the contents of the selected group in the Category section. All available commands, functions, operators etc. will be listed here. If you select one of them its properties will be displayed in the Description section. If you want to insert the selected operands into the Expression field double click its name or click the Insert button.

**Expression**

This section is the main workplace of the Expression Builder. Use it to write and modify the script your are working on.

**Description**

This section displays the name, sample use and description of the currently selected operand in Name section.

You will get an idea how the current operand should be used.

**Script Help** button will open the help file with the detailed reference of the currently used script (VB Script or NiceCommands). Click it to find out more about the command you are working with.

### 4.5 Multicolor printing

Some thermal printers support multicolor printing. They use multiple heads, each head for a ribbon of a different color. The colors for each printer head are customizable and can be defined in the printer driver. Each print head is assigned a color that matches the used ribbon. The same colors become available in the labeling software.
For multicolor printing to work you need to use the appropriate NiceDriver.

Color palette synchronizes the available colors with settings in the printer driver. All colors you have defined in the printer driver are retrieved in the labeling software and made available for color selection. Color palette, color selection dialog box and label setup dialog box all display only the available colors from the printer. Each label element can then easily be assigned some of the available colors. The element is then printed using that color. More than one color cannot be used with a single label element.

When you use color images on the label, their appearance on the label changes. They cannot be printed in more colors than supported by the printer. The images are not displayed in full color. Each image is converted to monochrome graphics and previewed on the label as such. Conversion from color to monochrome graphics is done using dithering setting in the driver. You can assign the image one color and thus the print head where the image will be printed.

The colors on the label identify which printer head will be used for printing the elements.

### 4.6 Double-side Printing

NiceLabel software supports double side printing for office printers (inkjet, laser...) and for thermal printers. The option is enabled in the Label Setup dialog box, Printer tab. When you use office printer on the label, the available option is Duplex print. When you use thermal printer with appropriate NiceDriver, the available option is Double side print.

As soon as you enable this option, the Switch Pages icon in the toolbar becomes available. Use it to switch between top and bottom pages of the label. The identification of the current page is also visible in the status line at the bottom of the window.

When printing to office printer, these two pages are always printed one after another. They are sent to the
printer one after another so make sure you enable duplex functionality in the printer driver.

When printing to thermal printer, printer driver NiceDriver will take care of proper label processing and printing. You need to use the appropriate NiceDriver to enable this functionality. The option is not available if you are using the printer driver not supporting it.

4.7 Special Characters

Special characters are the kind of characters you usually cannot find directly on your keyboard. In spite of that, some of them can be typed in using combinations of Alternate and Control keys.

The problem usually does not appear with your language-specific characters (ä, í, ň, š, č, Å etc), you can enter them directly on the keyboard or using Alt+<key_code> combination. Alternatively, Windows utility Character Map can be used to find appropriate character and paste it to the label.

You might have problems using other kind of special characters. Sometimes there is a need to include a character with ASCII code below 32. These are so-called control characters. They cannot be normally entered to labeling or any other application. There is an alternative method of entering such characters, explained later in this topic.

There are several methods how special characters can be typed in to the labeling software.

4.7.1 Pre-defined character shortcuts

NiceLabel has several control characters pre-defined and they can be selected from a drop-down menu in any dialog box, where a text input is enabled. Just look at the right side of the edit field and find a button with arrow. Click it for a list of all available shortcuts to pre-defined characters. The same list can be accessed with right-click on the edit field, where you select Insert special character. For example: FNC1 character can simply be encoded as <FNC1>.
If special characters you want to use on the label is not available in this list of shortcuts, consult additional input methods.

<table>
<thead>
<tr>
<th>ASCII code</th>
<th>Abbreviation used in the application</th>
<th>Description of the character</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SOH</td>
<td>Start of Heading</td>
</tr>
<tr>
<td>2</td>
<td>STX</td>
<td>Start of Text</td>
</tr>
<tr>
<td>3</td>
<td>ETX</td>
<td>End of Text</td>
</tr>
<tr>
<td>4</td>
<td>EOT</td>
<td>End of Transmission</td>
</tr>
<tr>
<td>23</td>
<td>ETB</td>
<td>End Transmission Block</td>
</tr>
<tr>
<td>25</td>
<td>EM</td>
<td>End of Medium</td>
</tr>
<tr>
<td>5</td>
<td>ENQ</td>
<td>Enquiry</td>
</tr>
<tr>
<td>6</td>
<td>ACK</td>
<td>Acknowledgement</td>
</tr>
<tr>
<td>7</td>
<td>BEL</td>
<td>Bell</td>
</tr>
<tr>
<td>8</td>
<td>BS</td>
<td>Back Spac</td>
</tr>
<tr>
<td>9</td>
<td>HT</td>
<td>Horizontal Tab</td>
</tr>
<tr>
<td>11</td>
<td>VT</td>
<td>Vertical Tab</td>
</tr>
<tr>
<td>13</td>
<td>CR</td>
<td>Carriage Return</td>
</tr>
<tr>
<td>10</td>
<td>LF</td>
<td>Line Feed</td>
</tr>
<tr>
<td>12</td>
<td>FF</td>
<td>Form Feed</td>
</tr>
<tr>
<td>14</td>
<td>SO</td>
<td>Shift Out</td>
</tr>
<tr>
<td>15</td>
<td>SI</td>
<td>Shift In</td>
</tr>
<tr>
<td>16</td>
<td>DLE</td>
<td>Data Link Escape</td>
</tr>
<tr>
<td>17</td>
<td>DC1</td>
<td>XON - Device Control 1</td>
</tr>
<tr>
<td>18</td>
<td>DC2</td>
<td>Device Control 2</td>
</tr>
<tr>
<td>19</td>
<td>DC3</td>
<td>XOFF - Device Control 3</td>
</tr>
<tr>
<td>20</td>
<td>DC4</td>
<td>Device Control 4</td>
</tr>
<tr>
<td>28</td>
<td>FS</td>
<td>File Separator</td>
</tr>
<tr>
<td>29</td>
<td>GS</td>
<td>Group Separator</td>
</tr>
<tr>
<td>30</td>
<td>RS</td>
<td>Record Separator</td>
</tr>
<tr>
<td>31</td>
<td>US</td>
<td>Unit Separator</td>
</tr>
<tr>
<td>21</td>
<td>NAK</td>
<td>Negative Acknowledgement</td>
</tr>
<tr>
<td>22</td>
<td>SYN</td>
<td>Synchronous Idle</td>
</tr>
<tr>
<td>ASCII Code</td>
<td>Character</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
<td>----------------------</td>
</tr>
<tr>
<td>24</td>
<td>CAN</td>
<td>Cancel</td>
</tr>
<tr>
<td>26</td>
<td>SUB</td>
<td>Substitute</td>
</tr>
<tr>
<td>27</td>
<td>ESC</td>
<td>Escape</td>
</tr>
<tr>
<td>188</td>
<td>FNC</td>
<td>Function Code 1</td>
</tr>
<tr>
<td>189</td>
<td>FNC</td>
<td>Function Code 2</td>
</tr>
<tr>
<td>190</td>
<td>FNC</td>
<td>Function Code 3</td>
</tr>
<tr>
<td>191</td>
<td>FNC</td>
<td>Function Code 4</td>
</tr>
</tbody>
</table>

### 4.7.2 Entering characters with Alt+<ASCII_code>

This method is valid only for characters that are above ASCII code 32. A typical example would be FNC codes that are used to encode EAN.UCC 128 barcode data. The labeling software will encode this type of barcode according to standards and normally you would not have to change anything about it. However, sometimes it is necessary to manually add such character to label data. To include Function Codes just type in the appropriate character for Function Code. ASCII codes of Function Codes are as follows:

- FNC1: 0188
- FNC2: 0189
- FNC3: 0190
- FNC4: 0191

To type in character for FNC1, press and hold down left Alt key, then type in digits 0188 on the numeric keyboard. Note the leading zero, it is mandatory. Release the Alt key and FNC1 character should appear. These characters can be typed in directly using the keyboard.

### 4.7.3 Entering characters with <#hex_code> syntax

Another method of entering special characters is using the syntax `<#hex_code>`. The `hex_code` stands for a two-character mark in hexadecimal numerical system. The appropriate values go from 0 (decimal 0) to FF (decimal 255).
For example, `<#BC>` (decimal 188) would be the same as `<FNC1>`, as they both would encode the character with ASCII code 0188.

### 4.8 System Folder

The labeling application uses its system folder for storing files needed to run the program. The location of the folder varies depending on the Windows operating system used. On Windows 9X and Me the location is `C:Program Files\EuroPlus\NiceLabel\Bin\System`, on Windows NT, 2000, XP the location is `C:Documents and Settings\All Users\Application Data\EuroPlus\NiceLabel\System`.

It is vitally important to own the write access to this folder on your computer system and the right to write to and modify files in this folder.

In these files user data and user rights are stored, as well as custom settings, variable trace logs, label usage logs, variable definition files (*.NVR), bar code standards, and file names `globals.tdb`. It stores the values of global variables.

You should design the appropriate folder layout on disk for your label projects. With that in mind you can increase your work efficiency significantly and always know where certain types of files are stored. The application also finds required elements faster this way. This is important with more demanding labels, which intensively use databases, pictures and forms. Make a separate folder for each project, you are building, e.g. `Project1`. Beneath this folder make subfolders `Database` (for databases), `Forms` (for forms) in `Labels` (for labels). Store appropriate files in each of these subfolders.

### 4.9 Global variable

Global variable is a type of variable that can be used on many different labels. Once it is defined, it is stored
outside the current label so it is available for any other label as well.

Its last value is stored even after closing the label file and exiting the application. It is useful when continuing of numbering from previous printing is required. Values of global variables are stored in a separate file on disk globals.tdb.

The location of the folder varies depending on the Windows operating system used. On Windows 9X and Me the location is C:\Program Files\EuroPlus\NiceLabel\Bin\System, on Windows NT, 2000, XP the location is C:\Documents and Settings\All Users\Application Data\EuroPlus\NiceLabel\System.

It is an advanced option for power users, that is why it cannot be created using Variable Wizard. Global variable can only be created directly in Variable dialog box. Make sure to select "Global" as Input type for the variable in the General tab.

If you copy your label file, which uses global variable(s) to another computer, you have to copy this file as well. If you miss this step, then the labeling application won't find appropriate global variable and will notify you of this situation. At the same time a substitute global variable will be created, but last value of old variable will not be known, nor will the correct variable properties be restored. Check the settings of substitute global variable and change them appropriately to suit you needs.

The same global variable is not limited for use on only one label. You can use it on as many labels as you like. Please note, that only one label, using the same global variable, can be printed at a time. When using global variables, they are locked for one label and this prevents more labels to use the same global variable at the same time.

4.10 Font files

Along with the labeling application you have also got two fonts with graphical symbols. You can use them on your labels. They contain frequently used care symbols (used
in textile industry), symbols for handling dangerous materials (used in chemical industry) and many other useful industry symbols. The fonts are not automatically installed on your system, but should you require them, they are stored on your CD-ROM. They are accessible from the folder X:\AddOns\Fonts, where X represents the letter of CD-ROM drive in your system.

The fonts are in standard TrueType format and can be installed using Fonts utility in Control Panel. They are accompanied with two document files that include all symbols from the fonts in a easily scanned formatted table.

Character map of Care Symbols Font - caresym.ttf

Character map of EP Symbols Font - epsym.ttf
4.11 ClipArt Galleries

The distribution of labeling software includes a library of frequently used clipart images that you can use on your labels. Images are stored in .GIF and .WMF file formats. They are black&white images.

Clipart Galleries incorporate useful images from retail, logistics, chemical, automotive and other industries. Subset of these galleries is included within the two Font files, but for the whole collection of available symbols you should browse the galleries.

4.12 NiceAdministrator

NiceAdministrator is application for administration installations of NiceLabel products. Administrator is designed for updates of existing NiceLabel installation. With this application you can add or update NiceLabel components and system files that are Libraries, Contents providers, Check digit algorithms, NiceWatch Filters, MemMaster Plug Ins, Shared components, Application files or Help files.

When NiceLabel components get updated to fix a program error, add some new functionality or entirely new components are available NiceAdministrator helps you install these updated files. In previous versions of NiceLabel software you had to download the new distribution of NiceLabel software to update your installation. With NiceAdministrator only a single component can be updated at a time and there is no more need to download the whole package, but only the required component.

Current release of NiceAdministrator can automatically install new components from the folder, where you have extracted them. You will have to obtain compressed with updated components yourself. They are accessible from NiceLabel website. Future versions of NiceAdministrator will update NiceLabel installation without user intervention directly over the internet.

NiceAdministrator has a two-pane working window. The left side has a tree-view of NiceLabel groups. These groups contain system components (executable files,
DLL libraries, Help files, plug-ins, etc). Browse the tree-view to select the required component, then click the component to select it. Its properties are displayed in the right pane.

The updated components will be available in compressed file format. When you obtain this file with updates, extract the contents to some temporary folder on your computer. Two or more files will be created. One .NAC (NiceAdministrator Configuration) with instructions for automatic update and one or more new components that will replace the original.

Before NiceAdministrator is run make sure that none of NiceLabel applications is running at this time.

Components can be updated in two ways, manually or automatic.

**Manual update/addition**

First you should select the component that needs replacement in the left pane, then **Update** command from Configuration menu. Existing component will be replaced with the new one. System configuration will be updated at this time to ensure proper removal of NiceLabel software and proper behavior in the case of full upgrade to new version.

**Add** command from Configuration menu can be used to add an entirely new NiceLabel component that is not present in your current installation. First you will have to select appropriate group then select Add command and browse to the new component.

**Automatic update/addition**

This is recommended update procedure. All you have to do is select **Automatic Update** from File menu and then browse to the .NAC file in the temporary folder where you have extracted update files. Double click this file to start the updating process.

Updating/addition can be performed
directly from Windows Explorer as well. Just double click the .NAC file and NiceAdministrator will take care of the whole process.

Report: This command from File menu will write a text REPORT.TXT file with the list of NiceLabel components and their properties, that are installed on your computer.

Open log file: Every time NiceAdministrator is started, it will write its actions to text log file NADMIN.LOG. It is stored in Bin\System folder. You can use it to review past actions.

Expand tree and Collapse tree: These two commands control how the tree-view in the left pane is displayed. Expand tree will display groups with their contents, Collapse tree will display only the names of major groups.
5. Integration and Connectivity

5.1 Overview

The most common method is to print labels directly from NiceLabel. But sometimes there might be other requirements of label production. NiceLabel has a wide connectivity and integration options so you do not have to use NiceLabel interactively but thru ActiveX interface or DDE connectivity. NiceLabel can be used as a "print-engine" totally integrated to your custom application and invisible to end-user's eyes.

If you do not require such tight integration to your application, you can use NiceWatch, add-on utility for non-programming integration to existing systems and fully automated printing. A set of actions is defined that are trigger if pre-defined event occurs. These actions can open the label, connect it to database, fill variable's values, connect to proper printer and print the required number of labels. You can even build your custom data-entry and printing applications with NiceForm in a totally user friendly way without any programming skills required.

5.2 DDE Communication

You can use DDE connection to print the labels from your Windows applications, that you develop in standard programming environments such as Microsoft Visual Basic, Borland Delphi, C, Microsoft Access...

To create the DDE communication the client application must use the following DDE parameters:
Service = NiceLabel  
Topic=LINE or JOB  

When you are using topic JOB the content is the name of the command file, which must be run. When you are using topic LINE the content is one of the NiceLabel commands.

When you want to use DDE communication to manage NiceLabel, it is probably the best, when the user doesn't know for the background running of this application. For this purpose you can use this command parameter:

NICE3.EXE <label_name> /s  

The parameter s (silent) prevents that the NiceLabel will show on the screen. It is run in the minimized form.

### 5.3 NiceCommands

The printing with the NiceLabel can be automatic. There are two ways for automation. The first one is with the use of the command files (JOB file) which is used with **Automatic print** command from **File** menu. The second way is with the help of any other Windows application, which enables DDE communication between the programs.

In the both ways you can use the same commands. When you are using the automatic print, the commands must be written one per line in the command file (JOB file). With the DDE communication the commands are send through the DDE channel.

#### 5.3.1 LABEL

LABEL <name_of_the_file>  

The command opens the working label. If the label is already opened, the program will use this one. It is recommended to write full path name along with the file name.

Note, if variable value contains space characters or commas, you will have to enclose the whole path in quotation marks (e.g. LABEL "C:\Program
If you use LABEL command with NiceWatch running in service mode, use UNC quotation instead of the mapped drives (e.g. LABEL "\\SERVER\SHARE\MY LABELS\LABEL.LBL" instead of "G:\MY LABELS\LABEL.LBL").

5.3.2 LABELCLOSE

LABELCLOSE

The command closes the currently active label. The label application will stay opened. FILECLOSE command does the same thing, but is depreciated. To speed up label printing do not use this command frequently. NiceLabel can have opened more label files simultaneously. If the label is already opened, it does not have to be loaded and thus the label processing can be performed quickly.

5.3.3 SET

SET name=value_of_the_variable,
[,step[, quantity_of_repetition]]

Name is the name of the variable defined on the label. If the variable isn't on the label, an error will occur. Step and Quantity_of_repetition are option parameter. These parameters tell the increment of the variable and the number of the labels before change.

If variable value contains space characters or commas, you have to enclose the text in quotation marks.

5.3.4 SETPRINTPARAM

SETPRINTPARAM paramname=value

This command allows you to set advanced print parameters before printing.

Currently supported PARAMNAMES are:

PAPERBIN Use it to specify from which tray the paper should be used. If the printer is equipped with more than just one paper / label tray, you can
control which is used for printing. The name of the tray should be acquired from the printer driver.

**PRINTSPEED** Use this parameter so specify printing speed. The value for parameter varies from one printer to the other. Consult printer's manuals for numbers.

**PRINTDARKNESS** Use this parameter so specify printing darkness / contrast. The value for parameter varies from one printer to the other. Consult printer's manuals for numbers.

### 5.3.5 COMMENT

```
;
```

When developing program code or scripts it is very wise to well document your commands. This will help you decode what the script really performs, when you will look at the code after some time.

Use semicolon (;) on the beginning of the line. Everything following it will be treated as script comment and will not be processed by application.

### 5.3.6 PRINT

PRINT quantity [, skip [, identical label copies [, number of label sets]]]}

Command PRINT starts printing. The first parameter is the quantity of the labels that should be printed.

<number> This many labels will be printed.

**VARIABLE** Some variable contains the information how many labels should be printed. It can be label-defined prompted variable or a field from the database.

**UNLIMITED** If you use a database to acquire values
for variable fields, unlimited printing will print as many labels as there are record in the database. If you do not use a database, there is not much sense to use this option. In this case the maximum number of labels that thermal printer internally supports will be printed.

The parameter skip in the command represents the number of the labels you want to omit before first printed label on the page. The parameter is used for label printing on sheets of paper. When the part of the page is already printed, you can re-use the same sheet by shifting the start location of the first label. The rest of the unused labels on the page can be printed with the help of this parameter.

The parameter identical label copies specifies how many copies of the same label should be printed.

The parameter number of label sets specifies how many times the whole printing process should be repeated.

If you do not need to set some of the supplementary parameters, use their default values.

Skip 0
Identical label copies 1
Number of label sets 1

5.3.7 PORT

PORT <file_name>

This command overrides the printer's port name. This command is used to redirect print output to a file. In this case specify the name of the file in the parameter file_name. If the file path or filename contain space characters, enclose the whole string in double quotes.

5.3.8 PRINTER

PRINTER <printer_name>
Normally, the PRINT command prints the label to the printer specified in the label file. Using this command you can override this defined printer and print the label to some other printer.

If the printer name contains space characters, you have to enclose it in quotation marks.

For printer_name always use the system printer name as is displayed in the status line in the NiceLabel Pro application. System printer names are usually the same as the printer names in Printers folder from Control Panel, but not always, so pay attention. They differ only when you are using network-connected printers, when you should use \\server\share syntax and not a printer friendly name.

5.3.9 PRINTJOBNAME

PRINTJOBNAME <job_name>

Specifies the print job name that will be used in print manager when using PRINT command. After printing the name is returned in normal state. Use this option to easier distinguish between different printing jobs in the Windows spooler.

If variable value contains space characters or commas, you have to enclose the text in quotation marks (e.g. PRINTJOBNAME "Label for printing").

5.3.10 LOGIN

LOGIN <username>

Performs login procedure into NiceLabel program. This is necessary when login into NiceLabel is required.

NOTE. This is a DDE command and should not be used in batch command .JOB files.

5.3.11 RETURN

This command returns focus to the main labeling program after the printing completes.
5.3.12 QUIT

This command stops the labeling program after printing. The application is closed.

5.3.13 MESSAGEBOX

MESSAGEBOX message [, caption]

Displays the message in the message box. The second parameter is used to define the title of the message dialog box.

If the variable value contains space characters or commas, you have to enclose the text in quotation marks (e.g. MESSAGEBOX "Insert labels in printer", Warning).

5.3.14 CREATEFILE

CREATEFILE <name_of_the_file>

This command will create a plain ASCII text file. The file will contain only one line of text "NiceLabel" (without the quotes).

The purpose of creating such file is to signal some external application that the label processing or printing has began or has ended.

The example of the CREATEFILE usage is printing labels with data from some file. First the external application prepares variable data for the labels and store it into particular file. Then NiceLabel is activated and printing starts. To inform the application when the printing process is finished, a file can be created on the disk. It could can be a signal to the application, that the printing application has an empty printing queue and new label printing can be started.

5.3.15 DELETEFILE

DELETEFILE <name_of_the_file>

This command deletes the specified file. You can use it in combination with CREATEFILE command.
5.3.16 SESSIONSTART

All three commands (SessionStart, SessionPrint, SessionEnd) are used together. If ordinary command SessionPrint is used, every time a complete data stream for printer is sent. If you want to join multiple Print commands into one data stream, you can use the command SessionStart followed with any number of SessionPrint commands and in the end use the command SessionEnd. The stream is not closed until the command SessionEnd occurs.

These commands offer a way of optimal label printing. It is not necessary to generate a complete data stream for each print session, you can join more sessions in one stream.

5.3.17 SESSIONPRINT

SESSIONPRINT quantity [, skip]

You send the data stream to printer using this function. You can use multiple SessionPrint commands one after another and join them in single data stream. The stream is not closed until the command SessionEnd occurs. The meaning of quantity and skip parameters is the same as with Nice Command PRINT.

5.3.18 SESSIONEND

The function closes data stream.

5.3.19 OEMTOANSI

OEMTOANSI ON|OFF

This command works in conjunction with command SET. It puts the text that follows the command SET in proper codepage, so that variable is assigned the proper value.
Use it to put the values following SET command to the proper codepage, so correct values will be transferred to NiceLabel at print time.

5.3.20 SETDATABASE

SETDATABASE <database_name> = <value>

database_name  the name of the currently used database as defined in the program

value  name of the new table that should be used as data source

This command allows you to use some other database with the label file and not the one, that was connected to the label file at design time.

This other database will only be used when printing labels, the label file will remain intact with connection to the original database.

5.3.21 SETTABLE

SETTABLE <table_name> = <value>

table_name  the name of the currently used table as defined in the program

value  name of the new table that should be used as data source

This command allows you to use some other table with the label file and not the one, that was connected to the label file at design time.

This other database table will only be used when printing labels, the label file will remain intact with connection to the original table.

The new database table should be of the same type as original table. For example, you cannot change the table from dBase to Paradox. The structure of new table has to be identical to the original one.

You can use table from the database that is already connected to the label or from some entirely different database.
5.4 Automatic Print

Use this facility for automatic un-attending printing from the NiceLabel software. The commands to drive label printing from the NiceLabel application are stored in the batch command .JOB file.

The Automatic Print can be used interactive in the NiceLabel with the command Automatic Print. The other possibility is to run NiceLabel with the parameter:

NICE3.EXE SAMPLE2.JOB

NiceLabel will start with execution of the commands, which are stored in the command file SAMPLE2.JOB. If the last command in this file is QUIT, the program will exit after printing.

5.5 Programming interface: Automation (ActiveX)

The information in this chapter is for advanced users and application developers only. If you don't plan to write applications that use NiceLabel to print labels, you can skip this chapter entirely.

NiceLabel can act as an OLE Automation server. Its class name is NICELabel.Application.

NiceLabel Pro version 3.0 introduced a new programming interface. But all previous programming methods are still available and are compatible with newer versions of the software.

What has been added is entirely new interface with new commands and new automation possibilities. Updated commands actually allow you to have more control over NiceLabel from your own application. And it does not stand just for printing process, but also for design part that can now be part of your application.

Previous version of Automation allowed a limited insight to label's structure. You could only set the variable values, then initiate printing and that was it. With DDE communication no information is returned to the application if the variable assignment was successful or
not. Automation (Active X) allows also the status of variable managing procedure to be returned to your application so you can control printing process more accurately.

Programming interface version 2 brings improvement over the previous implementation. Besides variable setting a lot more programming functionality is allowed. New ActiveX interface makes is possible to query every label element for its properties. The same goes for variables and functions defined on the label. The properties of all label elements can be modified prior printing if for some reason you do not want to use label-defined settings. You can even create a label preview in your own application.

For more information about programming interface version 2 please refer to the White Paper: *NiceLabel Programming Manual* in PDF format available on the NiceLabel CD-ROM and on NiceLabel website. You can also auto-generate the description of the interface using `/typelib` command-line parameter on page 4-195. It will create NICE3.OLB with description of methods, properties and events NiceLabel Pro supports.

Appropriate application for viewing .OLB files is required to be able to see the file contents. Please refer to the Programming samples chapter for more information.

### 5.6 Programming samples

Programming examples of how to use NiceLabel as a print-engine from your applications are included with your copy of NiceLabel. By default they are installed to `Samples\Integration` folder. This is typically in `C:\Program Files\EuroPlus\NiceLabel\Samples\Integration`. The samples are available for MS Word, MS Excel, MS Access, MS Visual Basic and Borland Delphi. Please refer to the file `INTEGRATION.TXT` in the same folder. It contains more technical information and description of enclosed programming sample files. It will help you start using the NiceLabel power from your custom application.
5.7 Label Export

Label Export functionality is used heavily from stand-alone and some print-only variants of this labeling software. Its functionality is tightly connected to the ability of printer that is used on the label. Export is only available when using native thermal-transfer printer drivers. The printer driver also has to have the support for the required export built-in.

Windows version of labeling software on PC computer is used to design the label layout compliant to the labeling request. All label elements can be used on the label (text, paragraph, RTF, bar code, image, line, rectangle, ellipse, ...). When printing fixed labels, there is no issue you should pay attention to. The label elements are printed as graphics.

But if you use variable fields on the label, you have to pay special attention to their format. All variable elements must follow some designing rules.

- **All variables on the label have to be prompted**
  - User must be able to set their values before printing. Date/Time variables have to acquire the data from the printer clock not from PC system clock.

- **Support for functions is limited**
  - As PC labeling software is not available at print time, the functions cannot be processed.

- **All counters have to be incremented by printer**
  - Because PC labeling software is not available at print-time, the printer has to be able to increment the counters internally. Just make sure to properly set up the counter.

- **Variable**
  - Because PC labeling software is not
graphics are not available at print-time, it cannot handle the variable graphics. Any image on the label has to be static.

For more information about export functionality and how to use exported file on your own refer to the appropriate White Paper on the website or contact technical support.

Label Export is one method of label printing from outside of labeling application. It requires some other application to be able to open exported label format, parse it and then print it.

There are numerous other possibilities to integrate label printing to existing systems. Refer to the appropriate White Paper at NiceLabel web site.

5.8 Integration to SAP/R3

NiceLabel can be used to design labels that should be printed to thermal transfer printers from SAP system. Two possible methods can be implemented.

<table>
<thead>
<tr>
<th>Printing from NiceLabel software using NiceWatch integration module</th>
</tr>
</thead>
<tbody>
<tr>
<td>NiceWatch data-detection module is used to integrate label printer to your existing SAP/R3 system.</td>
</tr>
<tr>
<td>Labels are normally designed on Windows PC, where NiceLabel is installed. NiceWatch runs on the same system.</td>
</tr>
<tr>
<td>User on SAP/R3 system would export the data that should be used on the label to some ASCII file or true database file format. NiceWatch will detect the appearance of the file and trigger label production.</td>
</tr>
<tr>
<td>The advantage of this approach is that NiceLabel will process the labels on-the-fly. Labels will be imaged directly with data from exported database. There is full support for variable graphics elements, truetype fonts for variable fields and for advanced design options (usage of</td>
</tr>
</tbody>
</table>
functions, VB Script etc.) All label printers with Windows driver can be used.

The only disadvantage is that a PC computer with installed Windows operating system is required for label printing.

For more information how NiceWatch can be used for your specific demand, refer to NiceWatch Operating Manuals.

**Printing directly from SAP/R3**

Using this option the labels are designed with NiceLabel software on a PC computer and are then exported to SAP format.

Export procedure will generate .ITF native file with description of the label. This .ITF file is then uploaded to SAP system and users can print labels directly from SAP/R3.

The advantage with this approach is that no PC is required for label printing. Once the label is created, you do not need NiceLabel application any more.

However, there are several disadvantages. First of all, every label printer is not suitable for label printing directly from SAP/R3 system. SAP has certain limitations that the printer has comply to. There is also limited support for graphics elements. Variable graphics cannot be used at all. And only some printer models support printing of fixed images/truetype fonts. Variable text fields on the label has to be set in internal printer fonts that usually do not look as nice as truetype fonts. Only prompted variables can be used. Since NiceLabel Pro application is not present at print-time, functions and advanced label elements cannot be used.

For more information about connecting labeling software to SAP R/3 system please refer to the appropriate White Paper on the website of contact technical support.
6. How to…

6.1 Optimize the printing speed

There are many factors that affect the printing speed. By following the guidelines below you can dramatically increase the speed of printing:

- If your printer supports parallel and serial port, use the parallel port. Computer can send data to printer over parallel port much faster than over serial port.

- Use printer's internal fonts instead of Windows' true-type fonts. True-type fonts must be sent to printer as graphics and therefore the size of data sent to printer is much bigger (couple of kilobytes). When using internal fonts, only the text is sent to printer (couple of bytes). If you must use true-type fonts, use the NiceMemMaster program, to download these fonts to printer's memory and later access these fonts as internal printer fonts (only if your printer supports this).

- Avoid use of graphics on labels. If you must print graphics on labels, use the NiceMemMaster program to download these graphics to printer's internal memory (only if your printer supports this).

- When using barcodes, make sure that you don't print barcodes as graphics, if your printer supports printing barcodes.
• When using counters, the printer will internally increment the numbers if the internal fonts are used. (if supported by the printer) This means, that the printer will only receive the first number of object, and will later increment this number to print other labels. Using this option also reduces the amount of data transferred between computer and printer, but the difference is noticeable only with high quantity of labels.

• Set the printing speed to a higher value (if your printer supports it). Note that setting the printing speed usually affects the quality of printing. The higher the speed, the lower the quality. You will have to find an acceptable compromise for this.

• Don't print too much data on labels. If the speed of printing is an important factor, you should consider using preprinted labels, and only print the data, that is different on each label.

### 6.2 Use the keyboard and mouse effectively

When selecting objects you can use <CTRL> key to adjust object's anchoring point by clicking the object placeholders.

If you have a Wheel Mouse, you can use the wheel to scroll label up and down. Holding <CTRL> when rotating the wheel adjusts zoom factor, <SHIFT> scrolls label left or right.

Double click the form name in status bar starts NiceForm and opens form that is attached to label.

Double click on printer's name in status bar opens printer properties dialog box in which you can set various options regarding currently selected printer. If you hold <CTRL> while double clicking, printer setup dialog box is opened, in which you can select different printer.

You can quickly move objects from one open label to another by simply dragging desired object to another window while holding <ALT>. If you want to copy
Chapter 6: How to…

6.3 Create a serial number, counter

The easiest way of creating new variable is using Variable Wizard.

- Click the arrow button in the button on variable toolbar to start Variable Wizard
- From drop-down menu select Counter as the type of the variable, set the name of the counter and click Next
- Type in Starting value and you are finished with setting up this simple counter.
However, using Variable Wizard you are also capable of changing other properties of the counter: prompt for value before printing, maximum number of digits, step of incrementing/decrementing and much more.

The other method of creating counter is by creating a new variable directly (not using the Wizard) and then setting its parameters appropriately:

- Click on the button New variable on variable toolbar or
- Click command Variables in menu Data and press New button or

Name the variable e.g. "Counter". Set the length of the variable. Go to the Serialization tab of the dialog and set the parameters:

- Increment/decrement
- Step - value of the variable will be increased in steps
- Change value every N labels - variable will be increased every N labels

If you want to make counter filled in with leading zeroes, go to the Detailed tab. Set justification to Right and set pad character to "0".

If you want the variable to have a default value, go to the Default value tab. If you do not want to be prompted for value at print time, change the mode to No prompt. The variable will behave like a constant.

Press the OK button and connect the variable to text or bar code.

### 6.4 Use printer internal increment counter

Almost all transfer printers offer internal increment counter. This is a special printer counter that counts labels internally. The printer only receives the first value of the counter and then automatically increments the counter in steps of 1 on the subsequent labels. Using this option reduces the amount of data transferred between
computer and printer as only start value is sent to printer. This can significantly speed up label production.

1. Create a new variable "Counter". Instructions for this step can be found in paragraph Create a serial number, counter on page 6-3 Create a serial number, counter.

2. To use counter as internal printer element please pay attention to the following settings:
   - The variable's maximum length is limited by you printer. You should find this value in your printer's Owner Manuals. If you can not find this value, experiment.
   - The variable length has to be set to Fixed. Details for setting the variable length can be found in chapter Variables on page 3-107 in the Variable's dialog box General Tab.
   - Set the variable font to internal printer font.
   - Tick the option "Use printer internal counter" in Contents tab of the Text element's dialog box. This option is available only if the counter variable has been set up properly.

3. There should be two symbols in the lower right corner of text box. The first one tells that this text will be printed in internal printer font. The second one tells that this counters is internal printer increment counter.

6.5 Create a prompted variable

1. Create a new variable. Instructions for this step can be found in paragraph Create a serial number, counter on page 6-3.

2. Name the variable "Prompted". Set the length of the variable.

3. Go to the Prompt tab and type in the Prompt field: "Please enter a value".

4. If you want to be prompted for every label that is printed, change setting to "Every 1 labels".
5. If you want the variable to have a default value, go to the **Default value** tab. If you do not want to be prompted for value at print time, change the mode to *No prompt*. The variable will behave like a constant.

6. Press the **OK** button and connect the variable with text or bar code.

### 6.6 Read data from database

You must use Database access function to read data from database.

Create a new database access function:

- Clicking the "New database wizard" button on **Database toolbar**
- Selecting **Database access** from **Data** menu and pressing **Wizard** button.

Follow the onscreen instructions until the wizard finishes.

For every field in the table, you now have a text object on the label and variables you can use to add other objects such as text fields, bar codes or pictures.

If your database type is not available in the Wizard or you want to use OLE DB provider for connection to the database, you will have to use direct database set-up option and not the Database Wizard.

### 6.7 Use ODBC databases

To be able to use ODBC databases, you first have to setup your ODBC drivers properly. You can do this in advanced by starting ODBC setup program in Control Panel and modifying Data Source Names (DSNs) to suit your database file locations. Or you can do the same thing from NiceLabel software.

Connection to already defined ODBC data sources can be done using Database Wizard.

If data source is not defined in the system yet, you will have to use direct connection method and by pass the Wizard.
• Open Database Access dialog box, then click the Define button in General tab.
• In the list of database connection types first find the OLE DB drivers, then ODBC Data sources.
• In the right side of the dialog box select already prepared data connection or create a new one.
• Once you have the ODBC data connection prepared, select it and close the dialog.
• The fields from the selected database can now be used on the label.

6.8 Use Variable Quantity

Variable Quantity is a special variable in the label. You use this variable, when you do not know exact number of labels for printing. Using this variable, you can enter the number of labels to print during printing itself.

Example:

We have a label of a product. Already defined variables are "Name" and "Price". We want to print labels as follows:

• Enter Name and Price values
• Enter quantity for this product
• Print
• Start with new product.

This can be achieved without Variable quantity (starting printing for each product from scratch and specifying quantity), but think about reading all three values from database, and not from keyboard.

Create new variable, called "Quantity". Mark it as "Treat as variable quantity" on the General tab. Edit variables "Name" and "Price", go to the Prompt tab (assuming, the variables are already defined as prompted variables) and change setting to "Based on var. quantity".

When you start printing, the quantity parameter in print dialog is already set to "Variable quantity (defined from label variable)".
6.9 Make a counter which preserves last-used value

Counter which preserves last-used value is applicable in cases when continuing of numbering from last label production is required (e.g. serial number). The last value of the counter that was used on the label is stored and the numbering is continued from this point at next use.

1. Create a new variable. Instructions for this step can be found in paragraph Create a serial number, counter on page 6-3.

2. Name the variable e.g. "Counter". Set the length of the variable and Format to Numeric. Go to the "Increment" page of the dialog and set the parameters:
   - Increment/decrement
   - Step - value of the variable will be increased in steps
   - Change value every N labels - variable will be increased every N labels

3. Go to Default Value tab, select the option Prompt and enter the Value you want to use as the starting value for the counter.

4. Then tick the Dynamic value option. This will enable the counter to remember the last used value.

NOTE: Counter which preserves last-used value cannot be made with Variable wizard, but only using dialog for adding new variables.

This type of a counter will remember the last value that was used for it on this label. If you want to share the same counter on many labels and it should progress no matter which label is printed, look at the global variable. It too can remember last-used value and can be used on different labels.

6.10 Use Text toolbar

You can set text parameters (font, size, and style) in the dialog box, but it is easier to use Text toolbar. If it is
disabled you can enable it by clicking shortcut button or selecting Text tool in the View menu.

- **No text elements are selected.** When no elements are selected, text toolbar shows current settings for the default font. If you change font name, size or style (bold, italic) attributes, next time you add a new text to the label, it will have these parameters. The default settings are stored for the next time you start the application.

- **Text elements are selected.** When there is one or more elements selected, text toolbar show settings for that element(s). If more then one element is selected and they do not have the same attribute (font name is the same, but size is not), only common attributes for all of the elements are displayed. If you change some attribute, change will affect all elements, even if they did not have the same attributes set before.

### 6.11 Use Variable toolbar

You can attach variables to elements by double-clicking the element and then connect it to the proper variable in the element's dialog box. But it is much easier and quicker to use the Variable toolbar. If it is disabled you can enable it by clicking shortcut button or selecting Variable tool in View menu.

There are several methods to connect a variable to some label element that should contain variable values.

- If you have the element already positioned on the label, select it, then choose the appropriate variable in the list.

- If the element is not already on the label, you can first select the variable in the list and then click the label where you want the element positioned. Text element will appear there and will be connected to the chosen variable.
• If you want any other element (and not text) connected to the variable, you can first select the variable in the list, then click the desired element in the Toolbox and then click the label. Variable toolbar always shows the name of the variable, which is attached to the current selected element. If there are two or more elements selected, and do not have the same variable attached to it, then the variable combo box is empty.

If there is no element selected, you can still change the selection in the combo box. Doing so, you can later perform following actions:

• Edit current selected variable by clicking Edit button
• Delete current selected variable (only if it is not used with any elements or in functions)
• Create a new text object, which will be attached to the variable by default. For example, if you choose a variable, and the immediately add new text to the label, it will be automatically attached to selected variable.

Button Make element fixed will detach variable from selected element(s). The element will get some default value.

Button Functions will open Function list dialog box, where you can edit existing functions or define new ones.

### 6.12 Quickly align objects to each other

First you have to select objects that you want to align. Note, that all the objects are aligned relatively to the first selected object.

Then click appropriate buttons in Align toolbar to align selected objects to each other. If Align toolbar is not visible (by default it is located on the very right side of the window), select Align tool in View menu or click in the toolbar to make it visible.

You can align objects to left, right, center, top, bottom or middle. You can also distribute objects
evenly, so that spacing between them is equal, vertically 🗒️ or horizontally 🖼️.

If you hold <CTRL> while clicking the buttons, objects are aligned relative to label and not to the first selected object.

If you are a fan of the keyboard shortcuts, try out the combination <CTRL>-A. This one opens the Align dialog box with same functionality as the Align toolbar, but icons are replaced with shortcuts.

### 6.13 Use variable graphics

At first you have to create a variable that will contain the name of the graphics file. You can use Variable wizard to create new prompted variable or use database function to retrieve names from database. It is not important where the variable gets the value.

**Hint!** When defining variable that will contain the name of the graphics, you can use Prefix option to specify the drive and folder where file is located (like C:\GRAPHICS\). Similarly you can use Suffix to define file extension (like .BMP). This way the whole path and extension of the graphics file will be added automatically, you just have to provide the image name.

The next step is to connect this variable to the graphics element on the label by selecting option Variable in Contents tab of the Graphics dialog box and select appropriate variable from the list below.

### 6.14 Quickly edit database

Click the 📊 icon in the database toolbar. NiceData will be opened with the currently selected database. Of course you must have NiceData program installed on your computer.

### 6.15 Use custom edit forms

If you have a lot of prompted variables on a label, you can use custom forms that allow user-friendly data entry.
You must select *Use form when printing* option on the *Advanced* tab of the *Label setup* dialog.

Please see NiceForm documentation or help file for further information.

### 6.16 Automate label production

You can automatically start label production when certain events occur on the computer with NiceLabel software installed or in your network. These events include modification or creation of some file, receipt of an e-mail message, communication on the serial (COM) port or receiveal of a data via TCP/IP sockets.

A special application NiceWatch (component of NiceLabel Suite edition) provides this functionality. It monitors these events, and automatically starts label production when they occur. You can use VB scripting to further manipulate the received data. You can even use filters to extract data from unstructured data sources like reports and order forms.

### 6.17 Use printer memory card

Usage of printer memory card is recommended whenever faster label printing is required. A memory card boosts performance because there is no need to transfer large bitmap images or custom font files to printer over and over again. Every element that is needed on the label is already stored on the memory card.

Let's take a look at how you can prepare and use your memory card.

1. First of all, go through the user manual of your memory card. Memory cards are sensitive devices and misuse could damage the card as well as your printer.

2. Insert memory card into Slot 1. The slots are usually located at the back of the printer. Switch on the printer.

3. Start the application NiceMemMaster, memory card manager. It is part of the NiceLabel Suite. If the icon for NiceMemMaster is not shown in
the folder **NiceLabel** in the Start menu check your installation. Reinstall NiceLabel Suite if necessary.

4. We'll assume that memory card is empty or safe to delete. First step is, to let NiceMemMaster know what type of card is inserted in printer. 

   Click **Print Setup** in **Card** menu. Select your thermo transfer printer from the list. If your printer is not listed, you will have to install the appropriate Nice driver. Click button **Properties** then click button **Memory** to open dialog box **Printer memory**. Here we have to activate the memory card in Slot 1. Look at section Slot 1. In field **Type** select **Memory Card**, leave field **Connected file** intact. Keep clicking OK until you return to NiceMemMaster.  

   **NOTE.** NiceMemMaster works only in conjunction with Nice Drivers.

5. We will format the memory card and prepare it for downloading our data. Be careful, if the card contains any previously downloaded elements, they will be deleted. Click **Format** from **Card** menu or click ![Format](image). Formatting will take a few seconds.

6. Next step is to build a list of fonts and graphics that we want to store on memory card. The information about these fonts and graphics is stored in memory card file (.MMF). Let's make a sample memory card file. Select **New** from **Card** menu, or click ![New](image). Name the file **Sample** and click OK. In dialog **Card setup** type in description and select proper card size in kilobytes. You can always return to this dialog by selecting **Memory card information** in **Card** menu or clicking ![Memory card information](image).  

   On the left side of the NiceMemMaster windows is place for inserting fonts; on the right side is a place for graphics files. To add a font select **Add** from **Font** menu or right-click Fonts side of the window. Select font to be
downloaded and its style and size. Next dialog allows you to select only the required characters in this font. Only selected characters will be downloaded to memory card. Use this option if you are running low on kilobytes on memory card. Let's add the whole font in our sample. Next we will add some graphics to our list. Select **Add** from **Graphics** menu or right-click Graphics side of the window. Select some pictures (e.g. SAMPLE.PCX or PRINTER.BMP, these are installed with NiceLabel Suite package). In the lower part of the window you can see information about selected font or graphics: preview, used memory, width and height. Every element can be printed to label, just to see if everything is all right. Use command **Test print**. Add some more fonts and graphics to get a grip. Undesired elements can be removed from the list. Use **Delete** from **Font/Graphics** menu or right click the element and select **Delete**.

7. When layout is complete and every font and graphics is in the list, we are ready for download. You can download the whole list to the printer at once. Right-click left or right side of the window and select **Download All** from the list. Or you can download one element at a time by selecting it and clicking **Download** from **Fonts/Graphics** menu or right clicking it and selecting **Download** from the list. If for some reason you want to remove a downloaded element from memory card, but keep it in the list for later, use command **Remove**.

Now let's do a status print. Printer will report some useful information of memory card usage. Click **Status Print** from **Card** menu.

Memory card is now filled with elements (fonts and graphics) and is ready to be used from NiceLabel.

1. Start the application NiceLabel
2. Create new label. Click **New** from **File** menu or click 🔄. Choose your printer from the list. Select predefined label stock or design your own label.

3. We have to tell the NiceLabel that our printer is equipped with memory card and what kind of data is stored on the memory card. Double-click the printer name in the status line in the bottom of the window. Click button **Memory**, and in section Slot 1 for **Type** select **Memory Card** and for **Connected file** select **SAMPLE**. This is the name of the memory card file (.MMF) we created before. Click OK to return to NiceLabel.

   Click Text icon 📝 or Paragraph icon 📝 and type in some text. From text toolbar select the font, you downloaded to memory card before. If text toolbar is not shown on your screen, switch it on using command **Text tool** in **View** menu.
   You will recognize downloaded font by special printer symbol in front of its name 📝. To make sure, you have selected the proper font, the same symbol is shown in the lower right corner of the element on the label. If the symbol is not there, you didn't select the right font or you do not have switched on displaying of printer element. In this case select **Object properties** in **View** menu and click **Printer elements**.

5. Using downloaded graphics.
   Click Graphics icon 📸 and select the picture you downloaded to memory card before. Click OK. Inserted picture is used from disk and not from memory card yet. To change this double click the picture and select **On memory card** in **General tab**. Click **Browse** and select the picture from memory card. To make sure you are using picture from memory card look at the picture on the label. It should be framed in blue box. Regular picture doesn't have any frame.
If you need further explanation on how NiceMemMaster works please refer to NiceMemMaster documentation.

6.18 Change the order of entering prompted variables

When you are using variables, value has to be assigned to them before printing. And one way of doing this is by using prompted variables (other are counters, functions, databases, ...). You are asked for the value of every prompted variable before every printing. Then you fill in the values. The order in which you are entering the values may or may not be the order you want. If it is not it's probably the best solution, to change it.

The order can be changed in Variables dialog box.

1. Click Variables in Data menu to display a dialog box. All variables you are using are listed here alphabetically.

2. Click the button 1, 2, 3, ... in the lower right part of the dialog box.

3. Prompt order dialog box pops up. This is where you can change the order in which you are entering values to variables. Select the variable from the list on the left and roll it to appropriate position using buttons Up and Down. Repeat the procedure for every variable, that needs its position changed.
8. NiceLabel Product Range

8.1 NiceLabel Overview

NiceLabel is a family of professional labeling software products bringing a complete barcode printing solution to desktop and enterprise users.

**Easy-To-Use**

Thoughtfully designed user interface, contemporary tools and unique data-entry application design possibilities provide the quickest and most productive label design and printing possibilities without additional learning time.

**Extremely Powerful**

Being carefully designed and paying full attention to all industry standards, NiceLabel always provides its users with efficient and open label printing solutions for the present and time to come.

**Modular to Suit Any Environment**

With range of modules and versions available, NiceLabel can be a perfect solution for basic label design, enterprise label printing or specific environments, where an integration, connectivity and non-Windows printing features are highly valued.

**Reliable Through Technical Excellence**

Enriched with experiences of a decade of continuous development, translated into all major world languages, and certified by Microsoft for its Windows compliance, NiceLabel presents an unmatched choice of technically excellent and reliable labeling software.

**Excellent Technical Assistance and Support**
Choosing a solution best suited to your needs is much easier when you know you have a team of expert engineers to back you up with support and consulting whenever you come across a difficulty.

## 8.2 NiceLabel Suite

Complete software solution for any kind of label design and print requirements. The possibility of creating data-entry and printing applications makes label production easier and faultless. Rich connectivity options allow the user to integrate labeling into any environment or use a stand-alone printing capabilities.

NiceLabel Suite comprises out of the following modules:

- **NiceLabel Pro**: The main application for label design and printing.
- **NiceForm**: Create your own custom designed data-entry applications without any programming skills required.
- **NiceWatch**: Integrate label printing to any existing information system and automate the label production.
- **NiceMemMaster**: Download fonts and graphics to memory card for optimized label printing.
- **NiceData**: Manage your databases.

## 8.3 NiceLabel Pro

Full-featured software designed for professional label design and printing, including complete database support and integration possibilities. A wide range of options makes it a perfect and easy-to-use tool for any labeling requirement.

## 8.4 NiceLabel Express

Wizard-based software fulfilling basic barcode labeling needs. The entry-level software includes many design
elements of professional versions with the emphasis on simplified user interaction.

8.5 NiceLabel Print Only

NiceLabel Print Only is a software package belonging to the family of professional designing and printing labels software - NiceLabel. It is standard MS Windows application, which fully supports WYSIWYG (What You See Is What You Get).

NiceLabel Print Only is a version of program NiceLabel and offers printing of pre-designed labels. It can't be used to design and alter existent labels. Advanced settings for changing labels are not available. You can use print preview before the label production starts and then actually print the label(s).

Naturally you can use and print any label that was made with program NiceLabel. All elements of the label, including internal variables, functions, barcodes and other advanced elements will be properly used and correctly printed. Just before printing there will be a chance to enter values to variable elements on the label. NiceLabel Print Only can also use data from existent databases (text as well as pictures) and thus completely automate label production.

Program supports all printers that are supported in NiceLabel.

8.6 NiceLabel Engine

NiceLabel Engine is an ActiveX integrator edition of NiceLabel software. Its purpose is to be embedded in existing information systems or existing applications and provide them with support for label printing. It gives the application all labels printing functionality of NiceLabel software.

NiceLabel Engine is not used for label design, but purely for processing and printing labels. It provides the same reliability, speed and robust print engine as the stand-alone versions of NiceLabel software.
8.7 NiceLabel Pocket PC Designer

NiceLabel Pocket PC Designer is a software package for desktop Windows computers, which brings the power of label and form design for portable Windows CE terminals. It is an affordable solution when printing to portable Windows CE and Pocket PC powered terminals is required.

NiceLabel Pocket PC Designer is a set of applications running on desktop Windows computer that is used to design a complete solution for the end-user, including all labels and forms needed. NiceLabel Pocket PC Designer is a design-only tool. When the necessary documents are designed on the PC, they are synchronized with the Pocket PC terminal and prepared to be printed from the mobile Pocket PC devices.

8.8 Pocket NiceLabel

Pocket NiceLabel is program package for Windows CE, which brings the power of label printing to portable Windows CE computers. Pocket NiceLabel should be used together with NiceLabel Suite, the powerful labeling software package.

Pocket NiceLabel can be used in two different ways. The first one is, you design the label on your PC computer and then download it to the Windows CE terminal. When you tap command Print, Pocket NiceLabel will prompt you to enter all variable data on that label and print the label.

The other, more advanced way of printing is by using the program NiceForm. In NiceForm you can design Form files, which are in fact custom user interfaces for entering and selecting data. Many different elements are available and you can build your own button, menus, custom data entry forms, etc. Form file must be downloaded to Pocket NiceLabel along with the Label files. When using forms, Pocket NiceLabel will not prompt you for each variable data. It reads the values from the form, and then connects form to label. The variables on the label are filled with the necessary data.
Forms can be used in various ways. Please refer to NiceForm documentation for more information.

### 8.8.1 Synchronization Manager

Synchronization Manager is a PC program, which helps to prepare labels, forms and graphics, which are used with Pocket NiceLabel. It sends files to selected folder in Windows CE terminal, without having to use Windows CE Explorer manually. Synchronization Manager doesn't bring any new functionality to Pocket NiceLabel, it just makes preparation of all necessary tasks easier.

### 8.9 NiceLabel for Linux

NiceLabel Suite for Linux expands label printing to Linux platform. Combination of data-entry forms and data-detection module (supporting file, serial port and TCP/IP port monitoring) presents a complete Linux-based printing solution.

This version of NiceLabel is a supplement to NiceLabel Suite package. The label design is still performed on a computer with Windows operating system. When they are designed and completed, they are exported in an intermediate data format and then transferred to the Linux computer. Label printing is entirely done on the Linux-based computer without any intervention to Windows computer.

NiceLabel for Linux comprises out of three applications:

- **nlabel**: main program used for editing and printing labels, it can be run as a X Window or console application
- **nform**: program for simplified data-entry and easier label printing, pre-defined screens are used for user interaction
- **nwatchd**: runs as daemon and provides a fully automated label printing, it monitors incoming data from several sources (files, serial communication, e-mail, TCP/IP connections) and triggers pre-defined actions upon these events